
  Certificate in Computer Course 

 CCC-1.1 
Office Tools and Internet 

BLOCK-1  MS-WORD & ITS ADVANCED 
FEATURES      03-68        

Unit I MS- Word
Unit II  MS-Word Advance Features 

BLOCK-2 MS-EXCEL 
Unit I Worksheet- MS-Excel
Unit II  MS- Excel Advanced Features 
Unit III Introduction to Power point 
Unit IV MS-Power point Advanced Features & DTP 

Software 

BLOCK-3  COMMUNICATION 163-198 
Unit I Fundamentals of Data Communication           
Unit II Computer Networks        
Unit III   Advanced Concepts in Networking            

BLOCK-4 INTERNET AWARENESS 199-264
Unit I Internet : An Overview 
Unit II Internet Tools
Unit III Browsers
Unit IV Visiting Websites 

CCC-1.1/1

 69-162        



CCC-1.1/2



  Certificate in Computer Course 

 CCC-1.1 
Office Tools and Internet 

Block 

1 
MS-WORD & ITS ADVANCED FEATURES 

Unit I  MS- Word 05-34 

Unit II  MS-Word Advance Features 35-68 

CCC-1.1/3



Course Design Committee 
Chairman 

Member 

Prof. (Dr.) Ashutosh Gupta (Director-Incharge) 
School of Computer and Information Science, 
UPRTOU, Prayagraj 
Prof. R. S. Yadav 
Department of Computer Science and Engineering 
MNNIT-Allahabad, Prayagraj  

Ms. Marisha Member 
Asstt. Professor, School of Science, UPRTOU, Prayagraj 

Mr. Manoj Kumar Balwant Member 
Asstt. Professor, School of Science, UPRTOU, Prayagraj 

Course Preparation Committee 
Dr. Ravi Shankar Shukla Author (Block 1, 2) 
Associate Professor,
Department of CSE, Invertis University Bareilly-243006, 
Uttar Pradesh 

Ms. Marisha Author (Block 3: Unit: 1, 2, 3 ) 

Asstt. Professor, School of Science, UPRTOU, Prayagraj 

Mr. Manoj Kumar Balwant Author (Block 4, Unit: 1, 2, 3, 4) 
Asstt. Professor, School of Science, 
UPRTOU, Prayagraj 

Dr. Sudhkar Pandey Editor (Block 1, 2) 
Head, Department of IT, NIT, Raipur, Chattisgrah 

Prof. (Dr.) Ashutosh Gupta  Editor (Block 3, Block 4) 
(Director-Incharge)
School of Computer and Information Science,
UPRTOU, Prayagraj 
Mr. Manoj Kumar Balwant Coordinator 
Asstt. Professor, School of Science, UPRTOU, Prayagraj 

© UPRTOU, Prayagraj. 2019 
ISBN : 978-93-83328-19-2 
All Rights are reserved. No part of this work may be reproduced in any 
form, by mimeograph or any other means, without permission in writing 
from the Uttar Pradesh Rajarshi Tondon Open University, Prayagraj. 
Printed and Published by Dr. Arun Kumar Gupta Registrar, Uttar Pradesh 
Rajarshi Tandon Open University, 2019.  

Printed By : Chandrakala Universal Pvt. Ltd. 42/7 Jawahar Lal Neharu 
Road, Prayagraj. CCC-1.1/4



UNIT-I 

MS-WORD

Structure 

1.0  Introduction 

1.1  MS-Word  

1.2  Features  

1.3  Creating  

1.4  Saving and Opening Documents in Word 

1.5  Interface 

1.6  Toolbars 

1.7  Ruler, Menus 

1.8  Keyboard Shortcut 

1.9  Editing 

1.10  Previewing 

1.11  Printing & Formatting a Document 

1.12  Summary 

1.13  Review Questions 

1.0  INTRODUCTION 

This is the third unit of this block, named Word Processing. In this 
unit there are thirteen sections. Each section has detailed description about 
word processing.  In Sec. 1.1 you will learn about MS-Word, in the second 
section i.e. Sec. 1.2 you will know about words features. In next section 
i.e. Sec 1.3 and 1.4 you will learn about creating, opening and saving word 
document. Sec. 1.5 will tell you about word Interface. Sec 1.6 to 1.7 you 
will know about toolbars, ruler and menus. Next section Sec. 1.8 will 
describe about keyboard shortcut. Sec. 1.9 define how to edit a word 
document. In the next section i.e. Sec. 1.10 we define previewing a word 
document. In the next section we describe printing & formatting a 
document. In Sec. 1.12 and 1.13 you will find summary and review 
questions respectively. 
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Objectives 

After studying this unit you should be able to: 

 Define MS-Word, Create, save and open a document.

 Define interface, toolbars, ruler, menu, keyword shortcuts, editing,
previewing and formatting a document.

1.1  MS-WORD 

Microsoft Word is a word processing software package. You can 
use it to type letters, reports, and other documents. It gives you the ability 
to use your computer for desktop publishing. This tutorial 
teaches Microsoft Word 2007 basics. Although this tutorial was created 
for the computer novice, because Microsoft Word 2007 is so different 
from previous versions of Microsoft Word, even experienced users may 
find it useful. This lesson will introduce you to the Word window. You 
use this window to interact with Word. 

Starting Word 

1. Click the Start button - the Start menu appears

2. Point to the entry for All Programs

3. Click on the entry for Microsoft Office – Word 2007

Figure 1-1 MS-Word Screen 
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1.2 FEATURES OF MS WORD 

1. Push Pins

As you work on documents, they appear in the Recent Documents
list under the Office button in the top left corner. A single click on one re-
opens it for editing, until it's pushed off the bottom of the list by new 
arrivals. Clicking the push pin sticks the document to the list for as long as 
you need to work on it. 

Figure 1-2 Push Pin 

2. Table Styles

Tables are a great way to present information, and now, it's easy to
make them pretty with the built-in table styles. 

3. Smart Art

Attractive, easy to use, pre-created charts and diagrams come in
handy and save time when we want to add some visual interest to a 
document, as an alternative to a table. 

Figure 1-3 Smart Art 

4. Cropping Images

We are often pasting screenshots of websites into documents, and we
think they are tidier without the browser window around them. We want 
the viewer to focus just on the web page content. The image cropping tool 
is invaluable for quickly trimming an image down, without need for 
external image software. 

5. Track Changes

When collaborating on a document, it's critical to see the changes
others make. Enabling this feature makes that such a breeze. 
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6. Compare Documents

However, if your collaborators forget to track their changes, this
feature will find them, by comparing two different versions of the same 
document. You can easily accept, reject and merge changes into a final 
version. 

7. Inspect Document

After a series of revisions, changes tracked and accepted or rejected,
and comments added and removed, running the Document Inspector is 
wise. It will let you know about any last stray changes and comments, so 
that the version you release is truly the final one. 

8. Save as PDF

Not everyone has Office 2007, but most people have or can
install Adobe Reader or one of several other PDF readers. You can save 
your document as a PDF directly from Word with no additional software 
required. 

Figure 1-4 PDF Plug-Ins 

9. The Ribbon Bar

Last but not least, we've found that the grouping of features on the
Ribbon Bar really does make sense. A skeptic at heart, we've come to 
enjoy using this interface over the options buried many levels deep in 
menus. 

Figure 1-5 Ribbon Bar 

1.3  CREATE A NEW DOCUMENT 

There are several ways to create new documents, open existing 
documents, and save documents in Word:  

 Click the Microsoft Office Button and Click New or 

 Press CTRL+N (Depress the CTRL key while pressing the “N”) on
the keyboardCCC-1.1/8



You will notice that when you click on the Microsoft Office 
Button and Click New, you have many choices about the types of 
documents you can create. If you wish to start from a blank document, 
click Blank. If you wish to start from a template, you can browse through 
your choices on the left, see the choices on center screen, and preview the 
selection on the right screen. 

Figure 1-6- New Document Window 

1.4  SAVING DOCUMENT 

You should save your work regularly - ideally every 10 minutes 
so that you don't lose what you have typed should the computer stop 
working. Word does have an autosave facility which should guard 
against loss of work; however this is not a proper save and should not 
be relied on. 

1. Click on the [Office] button in the top left-hand corner and
then you can choose Save (or use the [Save] buttonon the
Quick Access Toolbar )

For a new document, a Save As dialog box similar to that below will 
appear: 

CCC-1.1/9



Figure 1-7- Save As Dialog Box 

2. Type a name for your work (e.g.my first document) - there's
no need to clear the File name: box first; whatever you type
will replace what's there already

Note: you should mainly use letters and numbers for your file names (spaces,
hyphens and underscores are also permitted); DO NOT use any other punctuation 
marks as they can cause problems. 

Your work will be saved to My Documents, which has been set up 
to be on drive N: on the computers on campus. This is an area on the 
network where you can save your own work, known as your home 
directory. No one else has access to your home directory; you connect to 
it whenever you logon to an IT Services computer. Backup copies of the 
files in your home directory are made hourly, so you should never lose 
any of your work. 

Though the [Save] button shows a picture of a floppy disk, it is 
NOT a good idea to work directly from floppy. They can easily be 
damaged (or lost) and work can be corrupted if they become full. We 
recommend you only use floppy disks to move your files from one 
computer to another (this also applies to more modern media such as 
memory sticks and CDs). 

3. Press<Enter>or click on [Save]

Once you have given your document a name, this will appear
(instead of the original name, e.g. Document1) at the top of the Word 
window. Note that the extension .docx (or .doc for Word 2003 CCC-1.1/10



documents) is added automatically. 

1.4.1  Opening an Existing Document 
You may want to do some further work on an existing document. 

In this next exercise you will be opening the file you have just closed. 

The notes which follow assume that your work was saved to My 
Documents on drive N: (your home directory). If your file is on a USB 
memory stick or a floppy disk, then you should first copy it to My 
Documents  

IMPORTANT: If you open a file direct from a USB memory stick 
or floppy disk then you must not remove the pen or disk until you have 
properly closed the file (or disconnected the memory stick). If you don’t 
do this, it can result in your files being corrupted and you may lose your 
work. Never swap pens or disks or you may corrupt them both. 

1. Click on the [Office] button and choose Open

Note the list of Recent Documents on the right-hand side – from
here you can open up your latest documents and can pin documents 
permanently to the list. The [Open] button on the Quick Access Toolbar 
(or the key combination <Ctrl o>) can be used to open a file but you then 
don’t see the list of Recent Documents. 

You will see a dialog box similar to the following, showing any 
folders and Word files in My Documents: 

2. Click on the name of your file you want to work on, eg my first
document.docx 

Figure 1-8- Open Dialog Box 
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3. Press <Enter> or click on [Open]

Use the <Page Down> key (above the arrow keys) to move down your 
document or <Ctrl End> to go to the end of your document. 

Check your progress 
Q1.  What do you understand by MS Word? Also define the features 

of MS Word. 

Q2.  Explain how to create, open and save a document in MS- Word. 

1.5  INTERFACE OF MS WORD 

When you launch MS Word 2007, its program window appears on screen. 
A screenshot of the window is shown below with the screen elements 
labeled. This tutorial will introduce these elements in brief. You would 
learn about them in detail in the subsequent tutorials. 

Figure 1-9 Interface of MS word 

Title Bar 

The title bar shows the name of the document on screen. When a 
new document is started, Word 2007 gives it a generic name like 
‘Document 1’ and this is displayed on the title bar. When you save the 
document with a name, the generic name on the title bar is replaced by the 
given name. 

Quick Access Toolbar 

Located in the top left corner of the Word 2007 window, the Quick 
Access Toolbar contains some of the most frequently used commands like CCC-1.1/12



Save, Undo, Redo. You can add more commands to the Quick Access 
Toolbar as per your need. This toolbar helps you to perform Word tasks 
speedily by providing one-click access to oft used commands.  

Window Controls 

These are a set of three buttons in the top right corner of the 
program window.  

 The right button, displaying an x, is the Close button. On clicking,
this button closes the current document but not the Word program.

 The left button is the Minimize button which minimizes the
program window to the taskbar.

 The middle button, sporting a rectangle, is the Maximize button,
which, on clicking, maximizes the Word 2007 window and the
button image changes to a pair of rectangles. Another click restores
the program window to its previous size and the button image to a
single rectangle.

Ribbon 

You can think of the Ribbon as a collection of seven horizontal 
tabbed toolbars arranged on top of each other. These toolbars are accessed 
through their tabs. The toolbars have command buttons, menus and input 
boxes arranged in groups. Some groups have dialog launchers (represented 
by a downward pointing arrow) which, when clicked, display a dialog box 
related to that group.  

At any given time, only one tabbed toolbar is visible. When Word 
is launched, the Home tab is current and the toolbar attached to it is at the 
top, enabling you to invoke its commands by clicking them. When any 
other tab is clicked, its toolbar comes to the top and you can use the 
commands stored on it.  

You may minimize the ribbon by clicking the 'Customize Quick 
Access Toolbar' button located to the right of the 'Quick access Toolbar' 
and choosing 'Minimize the Ribbon' from the drop-down menu. The 
Ribbon can also be minimized by double clicking the active tab; clicking 
any tab of the minimized Ribbon will redisplay it once again. 

Office Button 

Clicking 'Office' button reveals a drop-down menu showing 
commands for file operations. These commands are described below in 
brief.  

 New: When you click this button, the 'New Document' window
comes up displaying three panes. The first pane shows a list of
templates types, the second pane shows the templates available for
the template type selected in the first pane and the third pane
shows a preview of the template selected in second pane. You can
start a new document based on a template selected amongst these. CCC-1.1/13



By default, the blank document template is chosen. Clicking the 
Create button starts a new document based on the selected 
template. Notice that Word 2007 offers a wide variety of templates 
from the Microsoft Office Online.  

 Open: Starts the Open dialog where you can navigate to your
documents folder, select an existing (i.e. previously saved)
document and open it in Word window.

 Save: Clicking Save button saves the current document if it has
been given a name and saved earlier, otherwise it launches the
Save As dialog.

 Save As: Opens the Save As dialog. Here you can assign a name to
a new document and save it. You may also rename a document
saved earlier and save it with the new name.

 Print: This command is used for printing the current document.

 Prepare: Clicking this button opens a menu which provides
information regarding the current document and has commands for
preparing it for distribution.

 Send: You may use this command to email a document or to fax it
via internet.

 Publish: This command allows you to create a blog post and
publish it.

 Close: You can close the current document using this button.
However, the Word 2007 program keeps running.

 Word Options: Opens the Word Options Dialog where you can
chose your preferred settings for display, proofing, saving,
language, etc. It also provides facility for customizing the Ribbon
and the Quick access Toolbar.

 Exit Word: Clicking this option closes the Word 2007 package
together with all open documents.

Help Button 

Located below the Window Controls in the top right corner of 
Word window, this button brings up the Word Help window.  

Rulers 

The horizontal ruler is used to set tabs and indent text. You may 
use the vertical ruler to set vertical location of text in the document. If the 
rulers are not visible, click the View Ruler button immediately below the 
Ribbon on the extreme right.  

The rulers show measurements in inches or centimeters, depending 
on the units of measure specified in Word Options. 
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Tab Selector 

Repeated clicking of the Tab Selector shows five tab markers and 
two indent markers. By choosing the desired tab or indent marker and 
clicking on the horizontal ruler, you can set tabs or indent text.  

Status Bar 

On the left hand side, the status bar displays document information 
such as the current page number and total number of pages, word count, 
language, proofing error notification, etc. You can customize the 
information display by right clicking the status bar and making selections 
out of the context menu that pops up. 

View Buttons 

These buttons allow you to use five different document views: 

 Print Layout View: This view shows the document as it will look
when it is printed.

 Full Screen Reading View: This view shows the document on full
screen to make reading your document more comfortable.

 Web Layout View: Web Layout view enables you to see your
document as it would appear in a browser such as Firefox or
Internet Explorer.

 Outline View: Outline view displays the document in outline form
in which headings could be displayed without the text. When you
move a heading, the accompanying text will move with it.

 Draft View: This is the most frequently used view for editing your
document.

Zoom Tools 

The Zoom slider lets you zoom out or zoom in the current 
document. The zoom range is from 10% to 500%. The current zoom level 
is displayed on the taskbar immediately left of the slider. Clicking the 
zoom level opens the Zoom dialog where you can specify the desired 
zoom level. 

Vertical & Horizontal Scroll Bars 

The vertical scroll bar is located at the extreme right of the Word 
2007 window while the horizontal scroll bar is at the bottom of the 
window just above the status bar. Vertical scroll bar is always visible 
while the horizontal scroll bar appears only when the document width 
exceeds the screen width.  

The scroll bars let you scroll the document up-down vertically or 
left-right horizontally. To scroll, you need to click and drag the scroll box 
showing three vertical/horizontal lines. The document moves in a direction 
opposite to the movement of the scroll box. CCC-1.1/15



Text Area 

Framed between the rulers and the scroll bars is a large area 
looking like a blank sheet of paper. This is the text area where you type 
the text of the document. You will see a blinking vertical line in the top 
left corner. This is the Cursor. The typed characters appear at its location. 
As a character appears at its location, the cursor moves to its immediate 
right. 

Mouse Pointer 

In Word, you use the mouse to choose commands, move around in 
the document, select and move text, etc. As you move the mouse pointer 
across the screen, it takes different shapes. It is a right pointing arrow 
within the left margin of the text area and an I-beam in the rest of the text 
area. Outside the text area, it takes the shape of a left pointing arrow.  

The mouse is used to perform following actions: 

 Point: Positioning the mouse pointer on an item.

 Single click: Clicking the left mouse button once.

 Double click: Clicking the left mouse button twice in quick
succession.

 Triple click: Clicking the left mouse button thrice in quick
succession.

 Right click: Clicking the right mouse button once.

 Drag & Drop: Pointing to an item, pressing and holding the left
mouse button while moving the pointer to a new location and
releasing the mouse button.

1.6 QUICK ACCESS TOOLBAR 

Figure 1-10Quick Access 

The quick access toolbar is a customizable toolbar that contains 
commands that you may want to use. You can place the quick access 
toolbar above or below the ribbon. To change the location of the quick CCC-1.1/16



access toolbar, click on the arrow at the end of the toolbar and click on 
Show below the Ribbon. By default, you will have the commands to Save, 
Undo, and Redo. You may also add buttons such as Check Spelling and 
Grammar, Open a document, or create a New Document button. 

Quick Access Toolbar 

A.  Save 

B.  Redo 

C.  Undo 

D.  Add other buttons 

Figure 1-11Quick Access Toolbar 

You can also add items to the quick access toolbar. Right click on any 
item in the Office Button or the Ribbon and click on Add to Quick Access 
Toolbar and a shortcut will be added to the Quick Access Toolbar. 

Figure 1-12Add Quick Access Toolbar 
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Check your progress
Q1.  Define the commands of Office button. 

Q2.  Explain Quick Access Toolbar. 

Q3.  Explain Vertical & Horizontal Scroll Bars. 

1.7 RULER IN WORD 2007 

The Ruler Bar allows you to format the vertical alignment of text 
in a document. It displays and sets tabs and indent markers for paragraphs. 
You can use it to quickly change the format of your document. 

There are four types of indents: Left indent, Right indent, First 
Line indent, and Hanging indent. The Left and Right indents control the 
space between the paragraph and the left or right margin. The First Line 
Indent is used to indent the first line of a paragraph, similar to how you 
might use a tab. The Hanging indent controls how the text of a paragraph 
lines up under the first line. This is usually adjusted when working with 
bullets or numbering when text does not line up properly. 

Indents are displayed on the Ruler. If you your Ruler is not 
showing at the top of the document, click the Ruler checkbox on the View 
tab, in the Show section. You can also take a shortcut and click the View 
Ruler button at the top of your Scroll Bar. To apply your indent, simply 
select the text and drag the indent marker to the desired location. 

About menus and toolbars 

Figure 1-13 Rulers in MS-Word 

A menu displays a list of commands. Some of these commands 
have images next to them so you can quickly associate the command with 
the image. Most menus are located on the menu bar, which is CCC-1.1/18
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the toolbar at the top of the screen. Toolbars can contain buttons, menus, 
or a combination of both. 

Figure 1-14 

Displaying all the command on menu bar 

To look for a command that you don't use often or have never used before, 
click the arrows  at the bottom of the menu to show all the commands. 
You can also double-click the menu to expand it. When you expand one 
menu, all of the menus are expanded until you choose a command or 
perform another action. When you click a command on the expanded 
menu, the command is immediately added to the short version of the 
menu. If you do not use the command often, it is dropped from the short 
version of the menu. 

Customize menu bar 

You can customize menus and toolbars yourself; you can add and remove 
buttons and menus on toolbars, create your own custom toolbars, hide or 
display toolbars, and move toolbars. You can customize the menu bar the 
same way you customize any built-in toolbar — for example, you can 
quickly add and remove buttons and menus on the menu bar — but you 
can't hide the menu bar. 

1.8 Keyboard Shortcuts
Microsoft Office basics 

To do this Press 

Switch to the next window. ALT+TAB 

Switch to the previous window. ALT+SHIFT+TAB 

Close the active window. CTRL+W or CTRL+F4 

Restore the size of the active ALT+F5 
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window after you maximize it. 

Move to a task pane from 
another pane in the program 
window 
(clockwise direction). You may 
need to press F6 more than once.  

F6 

Move to a task pane from 
another pane in the program 
window 
(counterclockwise direction).  

SHIFT+F6 

When more than one window is 
open, switch to the next window. 

CTRL+F6 

Switch to the previous window. CTRL+SHIFT+F6 

Maximize or restore a selected 
window.  

CTRL+F10 

Copy a picture of the screen to the 
Clipboard.  

PRINT SCREEN 

Copy a picture of the selected 
window to the Clipboard.  

ALT+PRINT SCREEN 

Table 1- MS Office Basics 

1.9  EDITING A DOCUMENT 

Typing and inserting Text 

To enter text just starts typing! The text will appear where the blinking 
cursor is located. Move the cursor by using the arrow buttons on the 
keyboard or positioning the mouse and clicking the left button. The 
keyboard shortcuts listed below are also helpful when moving through the 
text of a document: 

Move Action Keystroke 
Beginning of the line HOME 
End of the line END 
Top of the document CTRL+HOME 
End of the document CTRL+END 

Table-2 Short-cut Keys 
CCC-1.1/20



Selecting Text 

To change any attributes of text it must be highlighted first. Select the text 
by dragging the mouse over the desired text while keeping the left mouse 
button depressed, or hold down the SHIFT key on the keyboard while 
using the arrow buttons to highlight the text. The following table contains 
shortcuts for selecting a portion of the text: 

Selection Technique 

Whole word double-click within the word 

Whole paragraph triple-click within the paragraph 

Several words or 
lines  

drag the mouse over the words, or hold down 
SHIFT while using the arrow keys  

Entire document choose Editing | Select | Select All from the 
Ribbon, or press CTRL+A  

Table-3 Short-cut for selecting the text 

Deselect the text by clicking anywhere outside of the selection on the page 
or press an arrow key on the keyboard. 

Inserting Additional Text 

Text can be inserted in a document at any point using any of the following 
methods:  

 Type Text: Put your cursor where you want to add the text and
begin typing

 Copy and Paste Text: Highlight the text you wish to copy and
right click and click Copy, put your cursor where you want the text
in the document and right click and click Paste.

 Cut and Paste Text: Highlight the text you wish to copy, right
click, and click Cut, put your cursor where you want the text in the
document, right click, and click Paste.

 Drag Text: Highlight the text you wish to move, click on it and
drag it to the place where you want the text in the document.

You will notice that you can also use the Clipboard group on the Ribbon. 
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Figure-1-15 Clipboard group on the Ribbon 

Rearranging Blocks of Text To rearrange text within a document, you 
can utilize the Clipboard Group on the Home Tab of the Ribbon. Insert 
picture of clipboard group labeled  

 Move text: Cut and Paste or Drag as shown above

 Copy Text: Copy and Paste as above or use the Clipboard group
on the Ribbon

 Paste Text: Ctrl + V (hold down the CTRL and the “V” key at the
same time) or use the Clipboard group to Paste, Paste Special, or
Paste as Hyperlink

Figure-1-16 Clipboard functions CCC-1.1/22



Deleting Blocks of Text 

Use the BACKSPACE and DELETE keys on the keyboard to delete text. 
Backspace will delete text to the left of the cursor and Delete will erase 
text to the right. To delete a large selection of text, highlight it using any 
of the methods outlined above and press the DELETE key.  

Search and Replace Text 

To find a particular word or phrase in a document: 

 Click Find on the Editing Group on the Ribbon

 To find and replace a word or phrase in the document, click
Replace on the Editing Group of the Ribbon.

Figure-1-17Search text 

Undo Changes To undo changes:  

 Click the Undo Button on the Quick Access Toolbar

Figure-1-18Undo Button 

1.10  PREVIEW DOCUMENTS 

Word 2007 includes a nifty Preview option that lets you see 
the contents of a document without actually having to open it. 
This feature comes in handy when you’re looking for information but not 
sure in which document it’s contained. 

To preview a document: 
1. Start the Office program associated with the document you want to

preview.
2. In the Open window, enable the preview function.

 In office 2003:
A. From the File drop-down list, select Open.
B. Select the document you want to preview. CCC-1.1/23



C. In the upper-right corner of the window, to the right of 
the Views icon, click the arrow icon. 

D. From the drop-down list, select Preview. 
 In  office 2007:

A. Click the Office button.
B. From the drop-down list, select Open.
C. Select the document you want to preview.
D. In the upper-right corner of the window, to the right of

the Views icon, click the arrow icon. 
E. From the drop-down list, select Preview. 

 In  office  2010:
A. Select the File tab.
B. In the left column, select Open.
C. Select the document you want to preview.
D. In the upper-right corner of the window, click the Show

the preview pane icon. 

1.11  PRINTING & FORMATTING THE 
DOCUMENT 

Set Page Setup options 

 Click File menu

 Select and click Page Setup option. You will get the following
screen.

Figure-1-19Page Setup CCC-1.1/24



 Here you can set margins (top, bottom, right and left) paper size,
paper source and layout.

 Click OK button.

Steps for Print a document 

 Click File menu

 Click Print option.

 You will get a screen shown as below.

Figure-1-20Print Dialog box 

 In the above figure you can set default Printer name or you can
select other printers from the drop down menu. You can set which
pages to print, how many copies to print, the page range like ”1-
3,5-7”, whether to print all pages and so on.

 Before printing, make sure your printer is switched on, is loaded
with the appropriate paper [A4], and is on-line.

 If you are satisfied with the layout of your document, click on the
Print icon on the toolbar to obtain a printout. You should see a
message on screen showing that your file is being prepared for
printing.

 Click OK button.

Formatting Text Styles 
A style is a format-enhancing tool that includes font typefaces, font size, 
effects (bold, italics, underline, etc.), colors and more. You will notice that 
on the Home Tab of the Ribbon, that you have several areas that will 
control the style of your document: Font, Paragraph, and Styles. 
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Figure-1-21Formatting Text 

Change Font Typeface and Size  

To change the font typeface:  

 Click the arrow next to the font name and choose a font.

Figure 1-22 Change Font and Size 

 Remember that you can preview how the new font will look by
highlighting the text, and hovering over the new font typeface.

Figure 1-23 Change Font CCC-1.1/26



To change the font size: 

 Click the arrow next to the font size and choose the appropriate
size, or

 Click the increase or decrease font size buttons.

Figure 1-24 Change Size 

Font Styles and Effects  

Font styles are predefined formatting options that are used to emphasize 
text. They include: Bold, Italic, and Underline. To add these to text:  

 Select the text and click the Font Styles included on the Font
Group of the Ribbon, or

 Select the text and right click to display the font tools

Figure 1-25 Font Style 

Change Text Color  

To change the text color: 

 Select the text and click the Colors button included on the Font
Group of the Ribbon, or

 Highlight the text, right click, and choose the colors tool.

 Select the color by clicking the down arrow next to the font color
button.

Figure 1-26 Font Color 
CCC-1.1/27



Highlight Text 

Highlighting text allows you to use emphasize text as you would if you 
had a marker. To highlight text:  

 Select the text

 Click the Highlight Button on the Font Group of the Ribbon, or

 Select the text and right click and select the highlight tool

 To change the color of the highlighter click on down arrow next to
the highlight button.

Figure 1-27 Text Highlight 

Copy Formatting 

If you have already formatted text the way you want it and would like 
another portion of the document to have the same formatting, you can 
copy the formatting. To copy the formatting, do the following:  

 Select the text with the formatting you want to copy.

 Copy the format of the text selected by clicking the Format Painter
button on the Clipboard Group of the Home Tab

 Apply the copied format by selecting the text and clicking on it.

Figure 1-28 Text Format 

Formatting Paragraphs 
Formatting paragraphs allows you to change the look of the overall 
document. You can access many of the tools of paragraph formatting by 
clicking thePage Layout Tab of the Ribbon or the Paragraph Group on 
the Home Tab of the Ribbon. CCC-1.1/28



Figure 1-29 Paragraph Group 

Change Paragraph Alignment  

The paragraph alignment allows you to set how you want text to appear. 
To change the alignment:  

 Click the Home Tab

 Choose the appropriate button for alignment on the Paragraph
Group.

 Align Left: the text is aligned with your left margin

 Center: The text is centered within your margins

 Align Right: Aligns text with the right margin

 Justify: Aligns text to both the left and right margins.

Figure 1-30 Text Alignment 

Indent Paragraphs  

Indenting paragraphs allows you set text within a paragraph at different 
margins. There are several options for indenting:  

 First Line: Controls the left boundary for the first line of a
paragraph

 Hanging: Controls the left boundary of every line in a paragraph
except the first one

 Left: Controls the left boundary for every line in a paragraph

 Right: Controls the right boundary for every line in a paragraph

To indent paragraphs, you can do the following: 

 Click the Indent buttons to control the indent.

 Click the Indent button repeated times to increase the size of the
indent CCC-1.1/29



Figure 1-31 Text Indentation 

Add Borders and Shading  

You can add borders and shading to paragraphs and entire pages. To 
create a border around a paragraph or paragraphs:  

 Select the area of text where you want the border or shading.

 Click the Borders Button on the Paragraph Group on the Home
Tab

 Choose the Border and Shading

 Choose the appropriate options

Figure 1-32 Border & Shadings 
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Create Links  

Creating links in a word document allows you to put in a URL that readers 
can click on to visit a web page. To insert a link:  

 Click the Hyperlink Button on the Links Group of the Insert Tab.

 Type in the text in the “Text to Display” box and the web address
in the “Address” box.

(a) 

(b) 

Figure 1-33 (a) link of hyperlink (b) Hyperlink dialog box 

Change Spacing Between Paragraphs and Lines  

You can change the space between lines and paragraphs by doing the 
following:  

 Select the paragraph or paragraphs you wish to change.

 On the Home Tab, Click the Paragraph Dialog Box

 Click the Indents and Spacing Tab

 In the Spacing section, adjust your spacing accordingly
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Figure 1-34 Adjust Spacing between Paragraphs and Lines 

Check your progress
Q1.  Explain the Ruler in word in detail. 

Q2.  How to customize menu bar in MS-Word 

Q3. How to edit a document in MS-Word? 

Q4.  Explain how to preview a documents? 

Q5. Explain all the steps of printing & formatting the document. 
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1.12 SUMMARY
In this unit you learnt about basics of MS-word, its features, 

controls, menus, interface, toolbar, keyboard shortcuts, printing preview, 
printing and formatting the paragraph. 

 Microsoft Word is a word processing software package.

 You can use it to type letters, reports, and other documents.

 It gives you the ability to use your computer for desktop
publishing.

 Tables are a great way to present information

 The quick access toolbar is a customizable toolbar that contains
commands that you may want to use.

1.13 REVIEW QUESTIONS
Q1.  What is MS-Word? How many version it has? Which version 

currently available in the market? 

Q2.  What do you mean by Ribbon toolbar in MS-Word 2007? 

Q3.  Define the Home tab in MS- Word in detail with example. 

Q4.  Write 20 short-cut keys of MS-word with description. 

Q5.  What do you mean by indentation in MS-Word? 
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UNIT-II 

MS-Word Advance Features 

Structure 

2.0  Introduction 

2.1  Find & Replace 

2.2  Using Thesaurus 

2.3  Using Auto- Multiple Functions 

2.4  Mail Merge 

2.5  Handling Graphics 

2.6  Tables & Charts 

2.7  Document into various formats. 

2.8  Summary 

2.9  Review Questions 

2.0  INTRODUCTION 

This is the last unit of this block. This unit contained complete 
description about MS-Word advanced features. This unit contains nine 
sections. In the Sec. 2.1 you will learn how to find and replace a word. In 
Sec. 2.2 you will learn how to work with Thesaurus. This feature is very 
useful in the field of research. In Sec. 2.3 you will know about auto 
multiple functions. Another important topic we have added in Sec. 2.4 that 
is mail merge. After that we have defined handling graphics in Sec. 2.5. 
Next section Sec. 2.6 explain how to add tables and charts in to your 
documents.  Next section explain you the conversion from MS-Words to 
other format like text, RTF, Word perfect and HTML.In Sec. 2.8 and 2.9 
you will find summary and review questions respectively. 

Objectives 

After studying this unit you should be able to: 

 Express find and replace in MS-Word

 Define how to work with Thesaurus.

 Define auto multiple functions, mail merge, tables and charts &
conversion.

CCC-1.1/35



2.1 FINDING TEXT 

Word allows you to find specific text in a variety of ways. You 
may choose to view each occurrence of the text individually; see 
all occurrences selected at once, or highlight all occurrences even after 
the Find and Replace dialog box is closed. 

Accessing the Find and Replace Dialog Box 

To find text, you must first access the Find and Replace dialog box. 

1. Windows: From the Home command tab, in the Editing group,
click FIND
Macintosh: From the Edit menu, select Find.
OR
Windows: Press [Ctrl] + [F]
Macintosh: Press [command] + [F]
The Find and Replace dialog box appears, with the Find tab
displayed.

Figure 2-1 Find & Replace 

Replacing Text 

Word allows you to choose how to replace text in your document. 
You may choose to replace all occurrences of a particular word or phrase 
or look at each occurrence before deciding which to replace. 

Accessing the Find and Replace Dialog Box 

1. Windows: From the Home command tab, in the Editing group,
click REPLACECCC-1.1/36



Macintosh: From the Edit menu, select Replace. 
OR 
Windows: Press [Ctrl] + [H]  
Macintosh: Press [shift] + [command] + [H] 
The Find and Replace dialog box appears, with the Replace tab 
displayed. 

Figure 2-2 replace the word 

2.2  THESAURUS 

When you are working in Word, a thesaurus is at your fingertips. A 
thesaurus provides a list of synonyms for a selected word and it is very 
handy when you are writing. For example, if you want to find another 
word for “subsequent,” simply select it, open the thesaurus and Word will 
provide you with a list of alternative words to use. 

Using the Thesaurus from the Interface Menu 

Access the thesaurus. 

The location of the thesaurus feature depends on which version of 
Word you're using. Word 2003 uses the older menu and toolbar interface, 
while Word 2007 and 2010 each use the newer menu ribbon interface. 

• In Word 2007 and 2010, select "Thesaurus" from the "Proofing"
group on the "Review" menu ribbon.

Figure 2-3Thesaurus in Review Tab 
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• Select the word you want to find a synonym for. Press the "ALT"
key and click on the word. A list of synonyms will appear in the
"Research" task pane.

Figure 2-4Thesaurus used in documents 

• Replace the selected word with the synonym or antonym of your
choice. Point to the replacement word or phrase, click the down
arrow to its right, and click "Insert" or "Copy" from the popup
menu that appears.

Figure 2-5Thesaurus used in document CCC-1.1/38



• If you don't see the word or phrase you want, you can find
additional synonyms by clicking any word in the results list. To
return to a previous list of words, click the "Back" button above
the results list.

Figure 2-6Thesaurus used in document 

2.3  Auto-Multiple functions 

1. Auto-Correct

2. Auto-Format

3. Auto-Text

Auto-Correct:- Enable auto-correction in Word 2007 to
help prevent spelling and grammar errors that you define or allow. Using 
AutoCorrect in Word 2007 can also be helpful for proofing a document for CCC-1.1/39
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jargon, technical terms, or unique name spellings or when creating 
symbols (such as a copyright or trademark symbol). 

Beyond spelling, use AutoCorrect to fix common errors, such 
as automatically capitalizing the first letter of a sentence or names of days, 
or correcting an iNVERSE cAPS lOCK pROBLEM and other types. 

1. Click the Office button.

Figure 2-7Office Button 

2. Click the Word Options button at the bottom right.

Figure 2-8Word Option 

Open Word Options. 

3. In the Word Options window that opens, click the Proofing
option (left column).CCC-1.1/40



Open Proofing setting. 

4. Click the AutoCorrect Options button (upper right.)

Figure 2-10Auto-Correct Option 

Enable auto-correction here. 

5. On the AutoCorrect tab, mark the check boxes of those items
you want Word to autocorrect for you.
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Figure 2-11Auto-Correct Option 

• Correct TWo INitial CApitals

• Capitalize First Letter of Sentences

• Capitalize First Letter of Table Cells

• Capitalize Names of Days

• Correct Accidental Usage of cAPS LOCK Key

• Replace Text As You Type

Type what you want auto-replaced (for example, theatre) in the 
Replace field and then your replacement choice (theater) in the width 
field. From this list, you can also choose from many preset symbols and 
words. 

6. Click OK to exit AutoCorrect; then click OK to exit Word Options.

7. To add an entry to AutoCorrect without going through Word
Options, right-click any word you want added to AutoCorrect.

8. From the contextual menu that appears, choose AutoCorrect.

9. From the list that opens, click the spelling you want.

The misspelling is corrected in the document and also added to AutoCorrect. CCC-1.1/42

http://www.dummies.com/how-to/content/how-to-use-and-customize-autocorrect-in-word-2007.html#glossary-field


Figure 2-12 Auto-Correct using pop-up menu 

Auto-Format 

 MS Office Word 2007 has automated a lot of small, tedious chores that 
we had to do manually in older word processing programs. Many of these 
are formatting chores, and Word collects them under the term 
AutoFormat. You can control what formatting chores Word 2007 
performs automatically in the AutoFormat panels of 
the AutoCorrect dialog box. The benefit of using AutoFormat is that you 
can concentrate more on the content of your document and less on the 
details of formatting. 

AutoFormat works on two different ways—as you type or on command. 

AutoFormat as You Type - Automatically formats 
bulleted, headings, numbered lists, borders, symbols, numbers, and many 
more while you type.  

AutoFormat on Command - Automatically formats selected text or the 
entire document in one pass. You don't have to do anything to activate 
AutoFormat. By default, AutoFormat as You Type is enabled—you just 
enter text and Word formats it as you go. You can change the default to 
AutoFormat on Command, which allows you to manually run 
AutoFormat. This is similar to the way in which you can spell check a 
document—as you type, or manually, using the menu commands or 
toolbar icons.  

Working with AutoText 

AutoText is useful for saving keystrokes while typing in your document. 
An AutoText entry is composed of an abbreviation and an associated 
phrase. This is an excellent way to reduce the number of keystrokes for CCC-1.1/43



frequently used phrases such as your department name, the University's 
address, and a signature block on a letter. AutoText entries can include 
both text and graphics. AutoText allows you to retain the formatting (e.g., 
font, size, justification) used when you created the entry or match the entry 
to the current document's formatting. Once an entry is created, it can be 
used throughout the current document and other documents associated 
with the same template. 

To make entering text easier, Word offers the AutoText toolbar. In 
addition to the entries you create, Word's AutoText entries include some 
standard entries to be used as they are or reformatted to your 
specifications.  

• Creating an AutoText Entry
• Inserting an AutoText Entry
• Deleting an AutoText Entry

Creating an AutoText Entry 

Word allows you to create an AutoText entry by using the dialog box. The 
dialog box allows you to edit or modify your AutoText option entry. 

1. In your Word document, type the desired phrase and/or insert the
graphic

2. Select the phrase and/or graphic
3. From the OFFICE BUTTON, click WORD OPTIONS »

select Proofing
4. In the AutoCorrect options section, click AUTOCORRECT

OPTIONS...
The AutoCorrect dialog box appears.

Figure 2-13 Auto-Format advance CCC-1.1/44



5. In the Replace text as you type section, in the Replace text box,
type the keyword or phrase you want replaced

6. In the with text box, type the word or phrase you want to replace
the keyword when it is typed in a document

7. Click ADD

8. Click OK

The AutoText entry is created. 

Inserting an AutoText Entry 

You can insert your AutoText by using the Ribbon option or the dialog box 
option. 

Inserting an AutoText Entry: Ribbon Option 

The ALL ENTRIES button on the AutoText toolbar contains all 
available AutoText entries. The entries are organized by category. The 
entries you create are found in the Normal category unless you have 
modified one of Word's preset AutoText entries. 

1. Place the insertion point where you want the entry to appear

2. On the AutoText toolbar, click ALL ENTRIES
» select a category » select the desired AutoText entry

Inserting an AutoText Entry: Dialog Box Option 

1. Place the insertion point where you want the entry to appear

2. From the Insert menu, select AutoText » AutoText...
OR

On the AutoText toolbar, click AUTOTEXT or
The AutoCorrect dialog box appears.

3. Select the AutoText tab

4. In the Enter AutoText entries here section, from the scroll list,
select the desired AutoText entry

5. Click INSERT
OR
Double click the entry

Deleting an AutoText Entry 

If you wish to delete some or all of your AutoText entries, use the 
following steps: 

1. From the File menu, click WORD OPTIONS » select Proofing
» click AUTOCORRECT OPTIONS...
The AutoCorrect dialog box appears.
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Figure 2-14Auto-Format delete entry 

1. In the Replace text box, type the keyword or phrase of
the AutoText you want deleted
The AutoText will appear in the Width textbox.

2. Click DELETE

Click OK 

Figure 2-15 Clip Arts CCC-1.1/46



Check your progress 
Q1.  Explain how we can find and replace Text 

Q2.  Explain Thesaurus. Also explain how we use the Thesaurus from 
the Interface Menu 

Q3.  Explain Auto-Multiple functions in detail. 

2.4 MAIL MERGE 

Mail merge techniques allow you to create a document which 
combines repetitive text elements with data drawn from an external data 
document. To perform a mail merge. You’ll need the following: • A 
template (previously created, or generated during the merge) • A recipient 
list or data source (created during the merge. or an existing file)  

Word will then create a new document by inserting the data from 
your data source into the structure of your template document. 

Creating a Mail Merge document 

Following are steps involved in creating a Mail Merge document. 

 Create a new data source and enter information

 Create the main document

 Insert fields into the main document.

 Merge data source and main document.

2.5  HANDLING GRAPHICS 

In Word you can modify objects, including graphics, in many ways to add 
sparkle to even the most mundane document. You can add drop caps, 
group two or more objects into one object, and change the layering of 
overlapping objects. You can also position graphics anywhere on a page, 
change text wraps around an object, and modify how objects are aligned 
relative to each other and to the page. You can enhance graphic objects 
with gradient color fills, textures, shadows, and 3-D effects and by adding 
a watermark and page border. 

Inserting Clip Art 

Adding Clip Art to your document is a way to illustrate ideas. Clip 
art is a collection of graphic images that can be inserted in documents. 

1. Click the Insert tab, from the Illustrations grouping click on Clip
Art.

2. The Clip Art Task pane will open on the right of the screen. CCC-1.1/47



3. In the three fields that are provided you Search for a particular
topic, in all the collections provided by Microsoft and all media
types.

4. After clicking the Go button the search will return a list of clip art.

5. Use the scroll bar to locate a clip you like. Note: the small world
in the left hand corner of a clip art means this clip comes from
Microsoft’s web collection.  

6. Click once on the clip art to insert it into your document.

Figure 2-16 wrapping text 

Wrapping Text around Graphics 

When you first insert a graphic using either Clip Art or a Picture 
positioning that graphic near text is the next step. You can specify how 
you would like the text to wrap around the graphic. Wrapping means that 
text flows around a graphic object rather than over it. 

1. With the Graphic selected (When selected, squares called sizing
handles will appear at the edges of the object andthe Picture
Tools Ribbon appears).

2. From the Arrange grouping select the Text Wrappingdrop-
down. Click one of the text wrapping options thatappear or

3. Click More Layout Options, to change which sides of the object
to place text or change the distance between the text and object.

4. When the Graphic is selected you can also click-hold and drag the
graphic to a new position, which allows you to control how many
lines of text are above to the right or left of the graphic.

Figure 4-15 Clip Arts 
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Figure 2-17 Layout text with picture 

Inserting Text Boxes 
A text box is a graphic image that contains text that you have typed. 

1. Click the Insert tab, from the Illustrations grouping click on Shapes
to save time select an object that displays text, you will then have
to apply any format changes manually.

2. You can insert Preformatted Text Boxes from the Text grouping
drop down. Scroll through the listing to see if something meets
your needs. If you select a Preformatted Text Box you may not be
able to change all the elements related to the preformatted boxes.

3. If you inserted the text box from the Shapes using the Text Box
Formatting Ribbon you can choose to apply a style, change the fill
color, change the shape, put on shadows or 3D effects.

Drawing Lines 

Lines that you draw are also graphic objects. You can draw straight lines, 
arrows, curved, or free-form lines, and you can insert and format lines 
using the Insert tab, 

Illustrations grouping Shapes then Lines 

1. Click the style of choice from the Shapes Line dropdown. Position CCC-1.1/49



the + pointer and drag the pointer so that the line will appears on 
your screen  

2. To change the line color, weight of line or line style you must use
the Using the Drawing Tools Format Ribbon. Under the Shape
Styles grouping select the Shape Outline dropdown.

Figure 2.18 

Inserting Word Art 

Word Art is another powerful graphics tool that you can use to give your 
documents visual impact. Text in Word Art is formatted in unique shapes, 
orientations, and patterns that you can easily modify and customize. 

1. Click the Insert tab, from the Text grouping click the Word Art
dropdown arrow.

2. Click a style of WordArt from the Gallery

3. Type your text in the Your Text here box, you can change
the font and size before Clicking OK

4. Resize by dragging the white handles and position as desired.

5. Check out the WordArt Tools Format Ribbon for text edit, style
changes, spacing and height

Figure 2-19 Word Art CCC-1.1/50



Modifying Shadow and 3-D Settings 

You can use the shadow and 3-D effects groupings on the Drawing Format 

Ribbon to create a wide variety of exciting effects. For example, you can 
change a 2-D object to a 3-D object or you can add an attractive shadow to 
a clip art image. Once you have added a 3-D or shadow effect to an object, 
you can modify the shadow or 3-D settings in a wide variety of ways. 

Applying a Shadow 

1. Click on the object to select it, if not already selected.

2. Click Shadow Effect dropdown. Select the type of Shadow you
would like to the object to have.

3. If you would like the change the shadow color, click the dropdown
again, the last item will supply you with the color pallet from
which to make your selection.

4. If you would like to change the shadow just select any other
shadow from the listing. If you want to delete the shadow, select
No Shadow Effect.

Note: Do not try to select the shadow as it is theobject that you are 
working with. 

Figure 2-20 Insert Shadow CCC-1.1/51



Moving the Shadow 

You can nudge the shadow in any directions by using the 4 one of the four 
directional arrows located in the Shadow Effects grouping. 

Figure 2-21 Shadow moving 

3-D Settings 

From the 3-D Effects grouping click the drop-down for see the 3-D Effects 
listing. Select the type of Effect you would like placed on the object. You 
can then change the 3-D Color, the Depth, Direction, Lighting and 
Surface. The live preview showing is perfect for this type of effect. 

Figure 2-22 Shadow 3D 
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You can also change the Tilt of the 3-D object with one of the directional 
arrows located in the 3-D Effects grouping. 

Figure 2-23 Shadow 3D Tilt 

You can change the 3-D Effect by selecting another type or remove it the 
effect completely by selecting No 3-D Effect from the listing. 

Figure 2-24 Shadow 3D effect 

Adding a Watermark or a Page Border 

A watermark is a picture or other type of graphic object that appears 
grayed out or lightly tinted behind text in a document. For example, a 
document could include a text box containing the word “DRAFT” 
formatted in very large letters that appear in gray behind the document 
text. Also, a lightly tinted picture of a company logo could appear behind 
the document text. 

A Text Watermark 

Word 2007 has a pre-set list of text watermarks to select from or you can 
customize one. 

1. Click the Page Layout Ribbon.

2. From the Background grouping click the Watermark drop-down
to see the listing.

3. Scroll through this listing and click on the one you want applied to
the document or you can select Custom if nothing meets your
needs from the pre-set list.
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Figure 2-25 Shadow 3D effect 

4. From the custom Watermark dialog box, select the Text
watermark. In the Text field type what you want to appear in the
background. You can now change the font, color, size and place of
the layout before clicking apply.

To delete a Watermark, click on the Watermark drop-down then select 
RemoveWatermark from the list. 

A Picture Watermark 

Start with the custom Watermark, click Picture watermark then Select 
picture button. Locate the picture to be inserted. The scale at Auto and 
Washout are defaults that work very well. Clip Art does not work as a 
Watermark; however, you can resize and make adjustments to the 
contrast and brightness along with placing it behind text to a Clip Art 
look like a watermark. 

Page Border 

A page border will also enhance a Word document. You can choose to 
insert a simple box border then modify the color or thickness. You might 
select to one of the many art borders from fruit, holidays to graphic 
design. CCC-1.1/54



1. Click the Page Layout Ribbon,

2. From the Page Background grouping, click Page Borders.

Figure 2-26 Page Border 

3. From the Page Border tab select the type of border on the left,
Box, Shadow, 3-D or Custom.

4. If you are selecting a line border, scroll through the Styles
given. You can now change the width and color of the border.
OR

5. If you would like to click the drop-down for Art borders.
Select the one that is appropriate to the document.

2.6  TABLES & CHARTS 

Aligning text in a word processing document can be tedious if you try to 
do it using tabs and spaces. Fortunately, Word allows you to insert tables 
in your document. A table will help you align columns and rows of text 
with ease. 

If you’ve never used Word’s tables feature before, it can be intimidating 
knowing where to start. And even if you have used the tables feature, you 
can find new ways to use it more effectively. 

Creating Tables 

Tables are preferred when compared to using spacebar or tab for 
alignment to give a table format, but Word has another excellent feature 
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for alignment called "Tables". This feature is used to create financial 
reports, catalogues, accounts etc. 

Tables consist of rows and columns. The text can be typed in the cells. 
The size, shape and appearance of a cell are controllable features. You can 
also convert a text to a table and a table back to text. It also supports 
importing and exporting data onto a spreadsheet. 

To create a table using Insert Tables Button 

 Move the cursor to the place where you want to insert the table

 Choose tables button from the Standard Toolbar

 Drag the mouse to highlight the desired number of rows and
columns in the tables menu

 Release the button. An empty table is inserted.

To create a table using table menu 

 Choose Insert table from Table Menu. You will find a dialog box
as shown below:

Figure 2-27 Insert Table 

 Now type the Number of Columns and rows as you require and set
column width Auto. So that the Column with will be equal to the
width of the text. Now click OK.

An empty table is inserted in the document. Now inserting rows,
columns, Deleting rows and widening the columns is very easy. CCC-1.1/56



Insert Rows: 

 Place the cursor in the table, where rows are to be inserted

 Choose Table and click Insert Rows option to insert rows in the
table

Delete Rows: 

 Select the Row which is to be deleted

 Click Table and click Delete cells option.

Charts 

Charts are used to display series of numeric data in a graphical format to 
make it easier to understand large quantities of data and the relationship 
between different series of data. 

Creating a graph 

From the Insert tab click the chartsymbol. 

 This will then insert a graph and display a small data table.

Figure 2-28 Insert Graph 

 This data table can be edited or new data can be imported.

What is a datasheet? 

The data sheet is where you type in data to create a graph. It is 
made up of cells, in rows and columns; columns are labeled 
alphabetically across the top of the data sheet; rows are numbered 
down the left side. To move the data sheet: position the pointer in CCC-1.1/57



the datasheet’s blue title bar, hold down the left mouse button and 
drag the datasheet to a new position 

 Also note that the menu changes to give more options. From this
menu you can change graph type, add axis and labels, and change
what data is displayed on the graph.

Figure 2-29 Insert Table through Menu 

Resize 

 The chart can be resized by clicking on any of its corners, then
dragging this to the desired location.

Position 

 It can also be positioned by using the Left, Centre or Right text
options.

Deleting 

 You can delete your graph by clicking on it and then pressing the
delete key or backspace key.

2.6  CONVERT WORD DOCUMENT FILES 
INTO PLAIN-TEXT FILES 

In order to use the contents of a Word Document (“.doc” or 
“.docx” extension) in a concordance it must be converted or saved as a 
plain text file (“.txt” extension). I will outline two different ways you can 
do this below. 
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Method 1 (recommended) 

1. open the document in Word,

2. do a “select all” (ctrl+A),

3. “copy” (ctrl+C),

4. open Notepad (found in Start > All Programs > Accessories),

5. “paste” (ctrl+V) the content into Notepad,

6. save the file

Method 2 

1. open the document in Word,

2. do a “Save as” in Word (goto File > Save as),

3. select “Save as type” (see image) as “plain text”,

4. click “Save”,

5. when the dialogue box appears (for non-English OSs) check
“allow character substitution” and then click “OK”,

      Figure 2-30. Convert a word document Convert Microsoft 

Word Documents to RTF Format Unsure about the file format 
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If you are unsure about what format a file was saved as, an easy 
way to check the format of the file in question is to view properties of the 
document. The file name in question, for this tutorial, is Doc1.  

1. For the file in question; right click the file name and select
Properties.

Figure 2-31 convert a word document through properties 

2. Locate the “Type of file” section. As you can see, this document
was saved as a Microsoft Word Document. If the file in question
displays this information, it will have to be converted before
submittal.

Figure 2-32 convert a word document through properties CCC-1.1/60



If you have received this output of a file, please skip step 3 and continue 
on to step 4. It is now safe to close the properties window using either the 
close window button (the Red X at the top-right hand side of the 
properties window), the “OK” button, or the “Cancel” Button. Please do 
not select or modify any option within the properties window, as it may 
cause adverse effects for the file. 

If this is not the output you have received, please continue to step 4. 

3. If this Document was saved as a Real Text Format, or RTF, the
following output would be displayed.

Figure 2-33 convert a word documentthrough properties 

If you have received this output, the file in question is a RTF file. It is now 
safe to close the properties window using either the close window button 
(the Red X at the top-right hand side of the properties window), the “OK” 
button, or the “Cancel” Button. Please do not select or modify any option 
within the properties window, as it may cause adverse effects for the file. 

4. Open the file, Here the file is in Microsoft Office 2007.
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Figure 2-34 convert an rtf in to word document 

5. In order to save the file as a RTF, or Rich Text Format, first select the
Microsoft Office Logo. This is done by left clicking the Microsoft
Office Logo, located in the top-left hand side of the screen.

Figure 2-35 convert an rtf in to word document using word 
option 

6. Let the mouse hover over the “Save as” button, or click the arrow to
the right of the save as button.
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Figure 2-36 Save As Menu 

7. Select “Other Formats”

Figure 2-37 Save As Menu 
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8. After selecting the “Other Formats” button, the “Save As” dialog
should appear. 

Figure 2-38 Save As Dialog Box 

9. Under the “Save as Type”, located near the bottom of the “Save
As” window, a selection list is available. There are now a
multitude of different formats to save the file as, but in order to
save the file as a RTF, scroll down the list and select “Rich Text
Format.”

Figure 2-39 Save As File Type CCC-1.1/64



10. Now, the document can be saved or renamed and saved using the
“save” button at lower right hand side of the “save as” dialog
screen.

Figure 2-40 Save As dialog 

2.7 CONVERT A WORD DOCUMENT TO 
WORDPERFECT FORMAT 

Microsoft Word and Corel WordPerfect are two very popular word 
processing software programs. Although these two software programs 
function well independently of each other, there will no doubt be times 
when a file may need to be opened and edited in both of these programs. 
Luckily, converting a Microsoft Word document to WordPerfect format is 
a simple and straightforward process that can be done with just a few 
quick and easy steps. 

Instructions 

1. Save the Word document as a WordPerfect-supported file type. To
do this, go to "File" and click "Save as." When the "Save as"
dialogue box appears, locate the drop-down menu for "File Type"
and select a supported WordPerfect file type. Depending upon your
version of Microsoft Word, you may have a WordPerfect file type
(.wpd). If not, select the text file type (.txt) or rich text format type
(.rtf) and click "Save."

2. Open up that file type in WordPerfect. If the file was saved
correctly in Step 1 as a WordPerfect (.wpd) file or a text (.txt) or
rich text format (.rft) file, WordPerfect should automatically open
it with no problems. If the file is still in Word format (.doc), you
may have to click on the drop-down menu at the bottom of the
dialogue box and select "All files" for the file to be able to be
opened. CCC-1.1/65



3. Go to "File" and then "Save as" and resave the document as the
WordPerfect (.wpd) file type. This should be the default option,
but if the "File Type" drop-down menu box does not say this when
the "Save as" dialogue box first appears, simply click it and
manually choose the WordPerfect (.wpd) file type. This will
successfully convert the file to WordPerfect format.

Check your progress
Q1. How to insert clip art in your document? 

Q2.  How to wrap text around graphics? 

Q3.  How to insert a text box in your document? 

Q4.  How to Insert a Word Art in your document? 

Q5.  Explain steps to add a watermark or a page border. 

Q6.  Explain how to insert a table in the document. 

2.8  SUMMARY
In this unit you learnt about advance features of MS-Word like 

insert pictures, creating table, charts, creating thesaurus, word-art and 
converting word documents to other format.   

 A table is made up of rows and column.

 Word 2007 provides more word-processing features than are
offered by the Web page creation tools in Office SharePoint Server
2007 alone.

 Word Document has “.doc” or “.docx” extension.

 In Word® 2007 you can amend any graph by simply double
clicking on it. This will then display the menu above and load the
data for the graph.

 A watermark is a picture or other type of graphic object that
appears grayed out or lightly tinted behind text in a document.

2.9  REVIEW QUESTIONS
Q1.  Define Macros with example in details. 

Q2.  What is a table? How can we create it? Define with example. 

Q3.  Write all the steps to insert word-art in the word document. 

Q4.  Define Thesaurus? Write all the required steps for it. 

Q5.  What do you mean by Shapes? Elaborate your answer.  CCC-1.1/66
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UNIT-I 

WORKSHEET- MS-EXCEL 

Structure 

1.0  Introduction 

1.1  Worksheet basics 

1.2  Creating worksheet  

1.3  Entering into worksheet 

1.4  Heading information 

1.5 Date & Time 

1.7  Alphanumeric values  

1.8  Saving & quitting worksheet  

1.9  Opening and moving around in an existing worksheet 

1.10  Toolbars and Menus 

1.11  Excel shortcut and function keys 

1.12  Summary 

1.13  Review Questions 

1.13  Review Questions 

1.0  Introduction 

This is the first unit of this block. This unit has covered the topic 
Worksheet-Excel. In this unit there are thirteen sections. Each section has 
given detail knowledge about excel. In the Sec. 1.1 you will learn about 
the basics of worksheet. In the Sec. 1.2 we define how to create the 
worksheet. In the next section you will know about entering into 
worksheet.  In Sec. 1.4 you will know about heading information. You can 
learn about data and text & date and time in Sec. 1.5 and Se. 1.6 
respectively. In the Sec. 1.7 you will learn about alphanumeric values. 
Next section told you how to save and quit worksheet. Sec. 1.9 describe 
open and move an existing worksheet. Sec. 1.10 explain toolbars and 
menus. In the next section we describe excel shortcut and function keys.In 
Sec. 1.12 and 1.13 you will find summary and review questions 
respectively. CCC-1.1/71



Objectives 

After studying this unit you should be able to: 

 Express about worksheet basics, creating worksheets, entering into
worksheets.

 Define heading information, data, text, date & time, alphanumeric
values.

 Describe saving and quitting worksheet, Opening and moving
around in an existing worksheet.

 Define Toolbars and Menus and excel shortcuts.

1.1 Worksheet Basics 

Excel is software that lets you create tables, and calculate 
and analyze data. This type of software is called spreadsheet software. 
Excel lets you create tables that automatically calculate the totals 
of numerical values you input, print out tables in neat layouts, and create 
simple graphs. 

Excel is a part of "Office", a suite of products combining several 
types of software for creating documents, spreadsheets, and presentations, 
and for managing e-mail. 

Figure 1-1 Worksheet 

Every Excel workbook contains at least one or more worksheets. If you 
are working with a large amount of related data, you can use worksheets to 
help organize your data and make it easier to work with.  

When you open an Excel workbook, there are three worksheets by default. 
The default names on the worksheet tabs are Sheet1, Sheet2and Sheet3. 
To organize your workbook and make it easier to navigate, you can 
rename and even color-code the worksheet tabs. Additionally, you can 
insert, delete, move, and copy worksheets. 
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To Rename Worksheets 

1. Right-click the worksheet tab you want to rename.
The worksheet menu appears.

2. Select Rename.

Figure 1-2: Selecting the Rename command 

3. The text is now highlighted by a black box. Type the name of your
worksheet.

Figure 1-3 renaming the worksheet 

4. Click anywhere outside of the tab. The worksheet is renamed.

Figure 1-4 Renamed worksheets 

Insert New Worksheets 

Click on the Insert Worksheet icon. A new worksheet will appear. CCC-1.1/73



Figure 1-5: Inserting a new worksheet 

You can change the setting for the default number of worksheets that 
appear in Excel workbooks. To access this setting, go into backstage 
view and click on Options. 

Delete Worksheets 

Worksheets can be deleted from a workbook, including those that contain 
data. 

1. Select the worksheets you want to delete.

2. Right-click one of the selected worksheets. The worksheet menu
appears.

3. Select Delete. The selected worksheets will be deleted from your
workbook.

 Figure 1-6: Deleting a worksheet 

Copy a Worksheet 

1. Right-click the worksheet you want to copy. The worksheet menu
appears.

2. Select Move or Copy.
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Figure 1-7 Selecting the Move or Copy command 

3. The Move or Copy dialog box appears. Check the Create a
copy box.

Figure 1-8 checking the Create a copy box 

4. Click OK. Your worksheet is copied. It will have the same title as
your original worksheet, but the title will include a version
number, such as "January (2)".

Figure 1-9 Copied worksheets 
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Move a Worksheet: 

1. Click on the worksheet you want to move. The mouse will change

to show a small worksheet icon .

2. Drag the worksheet icon until a small black arrow  appears where
you want the worksheet to be moved.

Figure 1-10 moving a worksheet 

3. Release your mouse and the worksheet will be moved.

Figure 1-11 Moved worksheets 

1.2  Creating New Worksheet 

 Click the Microsoft Office Button  at the upper left. 

 Then click New. In the New Workbook window,

 Click Blank workbook.

After the first 26 column headings (A through Z), the next 26 column 
headings are AA through AZ. The column headings continue through 
column XFD, for a total of 16,384 columns. CCC-1.1/76



Figure 1-12Worksheets New 

1. Column headings are indicated by letters.

2. Row headings are indicated by numbers.

Worksheets are divided into columns, rows, and cells. That's the grid you 
see when you open up a workbook. 

Columns go from top to bottom on the worksheet, vertically. Rows go 
from left to right on the worksheet, horizontally. A cell is the space where 
one column and one row meet. 

Each column has an alphabetical heading at the top. The first 26 columns 
have the letters from A through Z. Each worksheet contains 16,384 
columns in all, so after Z the letters begin again in pairs, AA through AZ. 
See Figure 2. 

After AZ, the letter pairs start again with columns BA through BZ, and so 
on, until all 16,384 columns have alphabetical headings, ending at XFD. 

Each row also has a heading. Row headings are numbers, from 1 through 
1,048,576. 

The alphabetical headings on the columns and the numerical headings on 
the rows tell you where you are in a worksheet when you click a cell. The 
headings combine to form the cell address, also called the cell reference.  

1.3  Entering Data into Worksheet 

You can enter two basic kinds of data into worksheet cells: 
numbers and text. You can use Excel to create budgets, to work with 
taxes, or to record student grades. You can use Excel to list the products 
you sell or to record student attendance. 
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You can even use Excel to track how much you exercise every 
day, and your weight loss, or how much your house remodel is costing 
you. The possibilities really are endless. Now let's dive into data entry. 

1.4  Start with Column Title 

Figure 1-13 Worksheets Column Title 

Worksheet with column and row titles 

1. The column titles are the months of the year.

2. The row titles are company names.

When you enter data, it's a good idea to start by entering titles at the top of 
each column so that anyone who shares your worksheet can understand 
what the data means (and so that you can understand it yourself, later on). 

In the picture, the column titles are the months of the year, across the top 
of the worksheet. 

You'll often want to enter row titles too. In the picture, the row titles down 
the left side are the names of companies. 

This worksheet shows whether or not a representative from each 
company attended a monthly business lunch. 

Check your progress
Q1. How to open, save, rename and copy a worksheet? 

Q2. How to creating New Worksheet 

Q3.How to entering data into worksheet. 
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1.5  Data & Text 

Figure 1-14 Worksheets Typing 

Say that you're creating a list of sales people names. The list will also have 
the dates of sales, with their amounts. So you will need these 
column titles: Name, Date, and Amount. 

You don't need row titles down the left side of the worksheet in this case; 
the sales people names will be in the leftmost column. 

You would type "Date" in cell B1 and press TAB. Then you'd type 
"Amount" in cell C1. 
After you typed the column titles, you'd click in cell A2 to begin typing 
the names of the salespeople. 

You would type the first name, and then press ENTER to move the 
selection down one cell to cell A3 (down the column), and then type the 
next name, and so on.

1.6  DATE and TIME 

Figure 1-15 Date Time CCC-1.1/79



To enter a date in column B, the Date column, you should use a 
slash or a hyphen to separate the parts: 7/16/2009 or 16-July-2009. Excel 
will recognize this as a date. 

If you need to enter a time, type the numbers, a space, and then "a" 
or "p" — for example, 9:00 p. If you put in just the number, Excel 
recognizes a time and enters it as AM. 

1.7 Entering Numbers Formatted as Text 
(Alphanumeric) 

When cells are formatted for text, all cell contents—letters, 
numerals, or alpha-numeric combinations—are treated as text. Information 
is displayed exactly as it is entered. There are two ways to enter numbers 
as text. 

Entering Numbers Formatted as Text: Apostrophe Character 

1. Select the cell you want to enter information into

2. Press ['], then type numeric information

3. To accept the information, press [Enter] or an [Arrow]

Entering Numbers Formatted as Text: Dialog Box 

1. From the Ribbon, select the Home command tab

2. In the Number group, click FORMAT CELLS  The Format
Cells dialog box appears.

3. Select the Number tab

From the Category scroll list, s 

4. From the Category scroll list, select Text

5. Click OK

6. Type the desired numbers and/or text in the cell

7. To accept the text, press [Enter] or an [Arrow]
To force text to wrap at a specific point in a cell, press [Alt] +
[Enter]

1.8  Saving & Quitting Worksheet 

The following steps should be used when you are saving a 
worksheet for the first time, when you want to save it to a new location 
(e.g., as a backup), or when you want to save a copy with a different name. 

1. In the top left corner of the Excel window, click FILE
The File menu appears
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2. From the File menu, select Save As...
OR
Press [Ctrl] + [S]
The Save As dialog box appears.

3. From the Save in pull-down list, select the appropriate save
location

4. In the File name text box, type a filename

5. OPTIONAL: To save your workbook in a format other than the
default (.xlsx), from the Save as type pull-down list, select the
desired format
NOTE: This is an important consideration if you want your
document to be able to open in Excel 97-2003.

6. Click SAVE
The file is saved.

Close workbooks or workbook windows 

When your computer is running a single instance of Excel, 
all workbooks that you open are opened in a workbook window inside the 
Excel window. You can also create new workbook windows for 
any worksheet in a workbook by using the New Window command 
(View tab, Window group). 

You can close each of these workbook windows one at a time, or you can 
close the whole workbook (including all of its workbook windows). To 
close all workbooks that are open, you can close the Excel window or exit 
Excel. 

What do you want to do? 

• Close the active workbook window

• Close a workbook

• Close all workbooks and exit Excel

Close the active workbook window 

1. Click the workbook window that you want to close.

2. In the upper-right corner of the workbook window, click Close
Window .

 NOTE   If the window is the only open window of the workbook, 
the whole workbook is closed. If there are more workbook windows of the 
same workbook, only the active workbook window is closed. 

Close a workbook 
1. Activate the workbook that you want to close.
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2. Click the Microsoft Office Button , and then click Close. 

Close all workbooks and exit Excel 

Do one of the following: 

• In the upper-right corner of the Excel window, click Close .

• Click the Microsoft Office Button , and then click Exit Excel.

1.9  Opening and moving around in an existing 
worksheet 

If you’re running Excel 2007 on Windows XP, use these steps to 
open a workbook: 

1. Click the Office button and choose Open.

The Open dialog box appears. This dialog box is divided into two 
sections: a My Places panel on the left and a folder and file list box on the 
right. 

Figure 1-16 Open Dialog box 

The Open dialog box as it appears when running Excel 2007 on 
Windows XP. CCC-1.1/82



2. If you want to open a workbook in another folder, click the
Look In drop-down list button and select the folder that
contains the file.

Use the Up One Level button to move up one level at a time in the
file hierarchy to find the desired folder. You also can use
the buttons on the My Places panel on the left side of the dialog
box to jump to those folders.

3. Click the file you want to open and then click the Open button,
or double-click the file’s icon.

Use the Views button drop-down menu on the Open dialog box to
change the way folder and file icons appear in the dialog box.

Move or copy a worksheet 

Move or copy worksheets to another location in the same workbook 

It's easy to move or copy a whole worksheet (or sheet) to another location 
in a workbook. However, be aware that calculations or charts that are 
based on worksheet data might become inaccurate if you move the 
worksheet. Similarly, if a moved or copied worksheet is inserted between 
sheets that are referred to by a 3-D formula reference, data on that 
worksheet might be unexpectedly included in the calculation. 

1. Select the worksheets that you want to move or copy.

Keyboard shortcut: - To move to the next or previous sheet tab,
you can also press CTRL+PAGE UP or CTRL+PAGE DOWN.

2. On the Home tab, in the Cells group, click Format, and then
under Organize Sheets, click Move or Copy Sheet.

Figure 1-17 Popup Menu 

TIP   You can also right-click a selected sheet tab, and then click Move 
or Copy. 

3. In the Move or Copy dialog box, in the Before sheet list, do one
of the following:

• Click the sheet before that want to insert the moved or copied
sheets directly in front of.

• Click move to end to insert the moved or copied sheets after the
last sheet in the workbook and before the Insert Worksheet tab.
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Figure 1-18 Insert worksheet 

4. To copy the sheets instead of moving them, in the Move or
Copy dialog box, select the Create a copy check box.

Move or copy worksheets to a different workbook 

1. To move or copy worksheets to another workbook, make sure that
the target workbook is open in the same instance of Microsoft
Office Excel.

2. In the workbook that contains the sheets that you want to move or
copy, select the sheets.

Keyboard shortcut      

To move to the next or previous sheet tab, you can also press 
CTRL+PAGE UP or CTRL+PAGE DOWN. 

3. On the Home tab, in the Cells group, click Format, and then
under Organize Sheets, click Move or Copy Sheet.

Figure 1-19 Popup Menu 

4. In the Move or Copy dialog box, in the To book list, do one of the
following:

• Click the workbook to which you want to move or copy the
selected sheets.

• Click new book to move or copy the selected sheets to a new
workbook.

5. In the Before sheet list, do one of the following:

• Click the sheet that you want to insert the moved or copied sheets
directly in front of.

• Click move to end to insert the moved or copied sheets after the
last sheet in the workbook and before the Insert Worksheet tab.CCC-1.1/84



Figure 1-20 Sheets of Workbook 

6. To copy the sheets instead of moving those, in the Move or
Copy dialog box, select the Create a copy check box.

Check your progress 
Q1.  xplain how we can insert DATE and TIME in our document. 
Q2.  xplain Number formatting in document. 

Q3.  ow to save& quit Worksheet 

Q4.  xplain how to open and move around in an existing worksheet. 

1.10 Toolbars and Menus 

The Menu Bar 

Figure 1-21 Menu Bar 

The Menu bar is directly below the Title bar. The menu begins with the 
word File and continues with Edit, View, Insert, Format, Tools, Data, 
Window, and Help. You use a menu to give instructions to the software. 
Point with your mouse to a menu option and click the left mouse button. A 
drop-down menu opens. You can now use the left and right arrow keys on 
your keyboard to move left and right across the Menu bar. You can use the 
up and down arrow keys to move up and down the drop-down menu. To 
choose an option, highlight the item on the drop-down menu and press 
Enter. An ellipse after a menu item signifies additional options; if you 
choose that option, a dialog box opens. 

Do the following exercise, which demonstrates using the Microsoft Excel 
menu bar. 

1. Point to the word File, which is located on the Menu bar.

2. Click your left mouse button.

3. Press the right arrow key until Help is highlighted.

4. Press the left arrow key until Format is highlighted.

5. Press the down arrow key until Style is highlighted. Press the up
arrow key until Cells is highlighted.

6. Press Enter to choose the Cells menu option.

7. Point to Cancel and click the left mouse button to close the dialog
box. CCC-1.1/85



When using Microsoft Excel, you can set an option to tell Microsoft Excel 
to always show full menus or to show only the most frequently and 
recently used options. All the lessons in this tutorial assume you have your 
menus set to Always Show Full Menus. To set your menu to display full 
menus: 

1. Point to the word Tools, which is located on the menu bar.

2. Click your left mouse button.

3. Press the down arrow until customize is highlighted.

4. Press Enter.

5. Choose the Options Tab by clicking on it.

6. If Always Show Full Menus does not have a check mark in it, click
in the Always Show Full Menus box.

7. Click Close to close the dialog box.

The Toolbars 

Figure 1-22the Standard Toolbar 

Figure 1-23.The Formatting Toolbar 
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Toolbars provide shortcuts to menu commands. Toolbars are generally 
located just below the Menu bar. Before proceeding with this lesson, make 
sure the toolbars you will use -- Standard and Formatting -- are available. 
Follow the steps outlined here: 

1. Point to View, which is located on the Menu bar.

2. Click the left mouse button.

3. Press the down arrow key until Toolbars is highlighted.

4. Press the right arrow key.

5. Both Standard and Formatting should have a check mark next to
them. If both have a check mark next to them, press Esc two times
to close the menu. If either does not have a check mark, press the
down arrow key until Customize is highlighted.

6. Press Enter. The Customize dialog box opens.

7. Choose the Toolbars tab.

8. Point to the box or boxes next to the unchecked word or words,
Standard and/or Formatting, and click the left mouse button. A
check mark should appear. Note: You turn the check mark on and
off by clicking the left mouse button.

9. Point to Close and click the left mouse button to close the dialog
box.

1.11 Excel shortcut and function keys 

The following lists contain CTRL combination shortcut keys, 
function keys, and some other common shortcut keys, along with 
descriptions of their functionality. 

CTRL combination shortcut keys 

Table 1-1 

KEY DESCRIPTION 

CTRL+ PgUp Switches between worksheet tabs, from left-to-
right. 

CTRL+ PgDn Switches between worksheet tabs, from right-to-
left. 

CTRL+SHIFT+( Unhides any hidden rows within the selection. 

CTRL+SHIFT+) Unhides any hidden columns within the selection. 

CTRL+SHIFT+& Applies the outline border to the selected cells. 

CTRL+SHIFT_ Removes the outline border from the selected cells. 

CTRL+1 Displays the Format Cells dialog box. CCC-1.1/87



CTRL+2 Applies or removes bold formatting. 

CTRL+3 Applies or removes italic formatting. 

CTRL+4 Applies or removes underlining. 

CTRL+5 Applies or removes strikethrough. 

CTRL+6 Alternates between hiding objects, displaying 
objects, and displaying placeholders for objects. 

CTRL+8 Displays or hides the outline symbols. 

CTRL+9 Hides the selected rows. 

CTRL+0 Hides the selected columns. 

CTRL+A Selects the entire worksheet. 
If the worksheet contains data, CTRL+A selects the 
current region. Pressing CTRL+A a second time 
selects the current region and its summary rows. 
Pressing CTRL+A a third time selects the entire 
worksheet. 
When the insertion point is to the right of a function 
name in a formula, displays the Function 
Arguments dialog box. 
CTRL+SHIFT+A inserts the argument names 
and parentheses when the insertion point is to the 
right of a function name in a formula. 

CTRL+H Displays the Find and Replace dialog box, with 
the Replace tab selected. 

CTRL+I Applies or removes italic formatting. 

CTRL+K Displays the Insert Hyperlink dialog box for new 
hyperlinks or the Edit Hyperlink dialog box for 
selected existing hyperlinks. 

CTRL+N Creates a new, blank workbook. 

CTRL+O Displays the Open dialog box to open or find a file. 
CTRL+SHIFT+O select all cells that 
contain comments. 

CTRL+P Displays the Print dialog box. 
CTRL+SHIFT+P opens the Format Cells dialog 
box with the Font tab selected. 

CTRL+S Saves the active file with its current file name, 
location, and file format. 

CTRL+T Displays the Create Table dialog box. 

CTRL+U Applies or removes underlining. 
CTRL+SHIFT+U switches between expanding and CCC-1.1/88



collapsing of the formula bar. 

CTRL+V Inserts the contents of the Clipboard at the insertion 
point and replaces any selection. Available only 
after you have cut or copied an object, text, or cell 
contents. 
CTRL+ALT+V displays the Paste Special dialog 
box. Available only after you have cut or copied an 
object, text, or cell contents on a worksheet or in 
another program. 

CTRL+W Closes the selected workbook window. 

CTRL+X Cuts the selected cells. 

CTRL+Y Repeats the last command or action, if possible. 

CTRL+Z Uses the Undo command to reverse the last 
command or to delete the last entry that you typed. 
CTRL+SHIFT+Z uses the Undo or Redo command 
to reverse or restore the last automatic correction 
when AutoCorrect Smart Tags are displayed. 

Function keys 

Table 1-2 
KEY DESCRIPTION 

F1 Displays the Microsoft Office Excel Help task pane. 
CTRL+F1 displays or hides the Ribbon, a component of the 
Microsoft Office Fluent user interface. 
ALT+F1 creates a chart of the data in the current range. 
ALT+SHIFT+F1 inserts a new worksheet. 

F2 Edits the active cell and positions the insertion point at the end of 
the cell contents. It also moves the insertion point into the Formula 
Bar when editing in a cell is turned off. 
SHIFT+F2 adds or edits a cell comment. 
CTRL+F2 displays the Print Preview window. 

F3 Displays the Paste Name dialog box. 
SHIFT+F3 displays the Insert Function dialog box. 

F4 Repeats the last command or action, if possible. 
When a cell reference or range is selected in a formula, F4 cycles 
through the various combinations of absolute and relative 
references. 
CTRL+F4 closes the selected workbook window. 

F5 Displays the Go To dialog box. 
CTRL+F5 restores the window size of the selected workbook 
window. CCC-1.1/89



Check your progress
Q1. Explain menu bar in detail. 

Q2. Explain toolbar in detail. 

1.12 Summary
In this unit you learnt about basics of Excel, worksheets, opening and 
creating worksheets, renaming a worksheet, saving and quitting a 
worksheet. You also learnt how to enter text, data, date & time, 
alphanumeric values in a worksheet.  

 Excel is software that lets you create tables, and calculate
and analyze data. This type of software is called spreadsheet
software.

 Excel lets you create tables that automatically calculate the totals
of numerical values you input, print out tables in neat layouts, and
create simple graphs.

 You can enter two basic kinds of data into worksheet cells:
numbers and text.

 You can use Excel to create budgets, to work with taxes, or to
record student grades.

 You can use Excel to list the products you sell or to record student
attendance.

1.13 Review Questions
Q1.  What is excel spread sheet? Explain in details with example. 

Q2.  How can you open create and rename the worksheet? 

Q3.  What is the difference between worksheet and workbook? 

Q4.  Define toolbar and menu bar in Excel? 

Q5.  Write at least 10 keyboard short-cut of Excel. 
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UNIT-II 

MS-EXCEL –ADVANCE FEATURES 

Structure 

2.0 Introduction 

2.1 Working with single and multiple workbook 

2.2 Working with formulae & cell referencing 

2.3 Auto sum, coping formulae 

2.4 Absolute & relative addressing 

2.5 Worksheet with ranges  

2.6 Formatting of worksheet 

2.7 Previewing & Printing worksheet 

2.8 Graphs and charts, Database 

2.9 Creating and using macros 

2.10 Multiple worksheets- concepts, creating and using 

2.11  Summary 

2.12  Review Questions 

2.0  Introduction 

This is the second unit of this block. This unit focused on the MS-
Excel Advanced features. This unit has twelve sections. In the first section 
we defined how to work with single and multiple workbook. In the Sec. 
2.2 you will learn about working of formulae and cell referencing. Next 
section tells about how auto sum works and how we can copying the 
formulae. In the section Sec. 2.4 we described about absolute & relative 
addressing. Sec. 2.5 and 2.6 explains worksheet with ranges and 
formatting of worksheet respectively. Sec. 2.7 define how we can preview 
and print the worksheet. Next section express graphs, charts and database 
creation. Sec. 2.9 define how we create and use macros in worksheet.  In 
the next section we defined how to create multiple worksheet its concept 
and use.In Sec. 2.11 and 2.12 you will find summary and review questions 
respectively. CCC-1.1/91



Objectives 

After studying this unit you should be able to: 

 Define working with single and multiple workbook, working with
formulae & cell referencing.

 Describe Auto sum, coping formulae & Absolute & relative
addressing.

 Express worksheet with ranges & formatting of worksheet.

 Describe previewing & printing worksheet.

 Explain graphs and charts and database.

 Define how to creating and using macros

 Express multiple worksheets, its concepts, its creation and use.

2.1  Working with Workbook single and multiple 
workbook 

Data Excel allows you to move, copy, and paste cells and cell 
content through cutting and pasting and copying and pasting. 

Select Data to select a cell or data to be copied or cut: 

 Click the cell

Figure 2-1: The Cell 

 Click and drag the cursor to select many cells in a range

Figure 2-2: Cell in Range 

The image part with relationship ID rId40 was not found in the file.

The image part with relationship ID rId40 was not found in the file.
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Select a Row or Column 

To select a row or column click on the row or column header. 

Figure 2-3: Row or Column header 

Copy and Paste 

To copy and paste data: 

 Select the cell(s) that you wish to copy

 On the Clipboard group of the Home tab, click Copy

Figure 2-4: Clipboard 

 Select the cell(s) where you would like to copy the data

 On the Clipboard group of the Home tab, click Paste

Figure 2-5: Clipboard Paste 

Cut and Paste 

To cut and paste data: 

The image part with relationship ID rId40 was not found in the file.

The image part with relationship ID rId40 was not found in the file.

The image part with relationship ID rId40 was not found in the file.
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 Select the cell(s) that you wish to copy

 On the Clipboard group of the Home tab, click Cut

Figure 2-6: Clipboard Cut Paste 

 Select the cell(s) where you would like to copy the data

 On the Clipboard group of the Home tab, click Paste

Undo and Redo 

To undo or redo your most recent actions: 

 On the Quick Access Toolbar

 Click Undo or Redo

Figure 2-7: Clipboard Undo 

Modifying a Worksheet 

Insert Cells, Rows, and Columns 

To insert cells, rows, and columns in Excel: 

 Place the cursor in the row below where you want the new row, or
in the column to the left of where you want the new column

 Click the Insert button on the Cells group of the Home tab

 Click the appropriate choice: Cell, Row,  or Column

The image part with relationship ID rId40 was not found in the file.

The image part with relationship ID rId40 was not found in the file.
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Figure 2-8: Insert Options 

Find and Replace  

To find data or find and replace data: 

 Click the Find & Select button on the Editing group of
the Home tab

 Choose Find or Replace

 Complete the Find What text box

 Click on Options for more search options

Figure 2-9: Find and Replace Options 

Working with Multiple workbooks 

As mentioned before, Excel is a workbook that has the capability of 
holding a large number of worksheets. Worksheets can be copied, added 
and erased. In your Excel workbook you can use worksheets to separate 
specific types of data such as assumptions, charts, summaries and more. 
For example, if you were using Excel for capital budgeting purposes you 
may want to separate a sales forecast in a separate worksheet than a 
forecast of operating cash flow. A worksheet is what most people think of 
when they think spreadsheet. The workbook is the file or Excel project as 
a whole.  

Once you have the Excel application open, you can open as many 
workbooks at a time as you want. Once you have multiple workbooks 
open you can resize, minimize and maximize each workbook as you 

The image part with relationship ID rId40 was not found in the file.

The image part with relationship ID rId40 was not found in the file.
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prefer. This could be useful when comparing a revised workbook with the 
old workbook.   

Figure 2-10: Multiple Workbooks 

Each workbook has three buttons on the top right which can be used to 
minimize, maximize and close the workbook. You can also re-size a 
workbook by holding your cursor over the edge or the corner of the 
workbook. You can re-size your workbooks manually or you can let Excel 
do the work for you. If you prefer this option simply click Arrange All 
which is located on the ribbon under the View tab. 

When you have multiple workbooks open, only one workbook will be 
active. You can tell which workbook is active because it will be a different 
color than the other open workbooks. You are only able to work in the 
active workbook. There are several different ways to activate different 
workbooks. 

Click on another workbook 

 Press Ctrl + Tab: This will cycle through all the open workbooks.CCC-1.1/96



 Ctrl+F6: This has the same effect as the previous method.

 Click View > Switch Windows > and the select the workbook you
want from the drop down menu.

2.2 Working with Formula 

A formula is a set of mathematical instructions that can be used in Excel 
to perform calculations.  Formals are started in the formula box with an = 
sign. 

Figure 2-11: Formula Box 

There are many elements to and excel formula. 

To create a basic formula in Excel: 

 Select the cell for the formula

 Type = (the equal sign) and the formula

 Click Enter

Figure 2-12: Formula in cell 

Calculate with Functions 

A function is a built in formula in Excel.  A function has a name 
and arguments (the mathematical function) in parentheses.  Common 
functions in Excel: 

Sum:  Adds all cells in the argument 

Average:  Calculates the average of the cells in the argument 

The image part with relationship ID rId40 was not found in the file.
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Min:  Finds the minimum value 

Max:  Finds the maximum value 

Count:  Finds the number of cells that contain a numerical value within a 
range of the argument 

To calculate a function: 

 Click the cell where you want the function applied

 Click the Insert Function button

 Choose the function

 Click OK

Figure 2-13: Formula Tab 

 Complete the Number 1 box with the first cell in the range that you
want calculated

 Complete the Number 2 box with the last cell in the range that you
want calculated

Figure 2-14: Function Arguments 

The image part with relationship ID rId40 was not found in the file.
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Function Library 

The function library is a large group of functions on the Formula Tab of 
the Ribbon.  These functions include: 

AutoSum:  Easily calculates the sum of a range 

Recently Used:  All recently used functions 

Financial: Accrued interest, cash flow return rates and additional financial 
functions 

Logical: And, If, True, False, etc. 

Text: Text based functions 

Date & Time: Functions calculated on date and time 

Math & Trig:  Mathematical Functions 

Figure 2-15: Function Ribbon 

Cell References 

Figure 2-16: Cell Reference 

Cell references are the basic building blocks of the formulas and functions 
you will use in Excel. Notice that each column of a spreadsheet is assigned 
a letter and each row of a spreadsheet is assigned a number. Each cell in a 
spreadsheet can be uniquely identified by referring to the column letter 
and row number that the cell is in. 

In this example, the number 42 is entered in column B and in row 3. The 
cell reference for this cell is B3. 

The value stored in cell A1 is 4. The value stored in cell A2 is 8. 

The image part with relationship ID rId40 was not found in the file.
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An Excel cell reference always names the column letter first, followed by 
the row number. 

Cell references can get a little more involved that this, but this is the basic 
idea: You can refer to a cell by its column letter and row number. 

You can use cell references as variables in the formulas and functions that 
you set up in your spreadsheet, and the values stored in the referenced 
cells will be used in the calculation. The example in Figure 2 of Figure 2-
21 shows some formulas and functions that use cell references. Figure 2-
21 shows the results of those formulas and functions. 

Figure 2-17: results of those formulas and functions 

Taking a closer look at some of what is going on here: 

 The formula in cell C1 says, “Take the contents of cell B1 and
divide it by the contents of cell A1, and display the results.” The
value 16 in cell B1 is divided by the value 4 from cell A1, and the
result, 4, is displayed in cell C1.

 The function in cell B4 says, “Take the average of all the values
stored within the range of cells that starts at cell B1 and ends at cell
B3, and display the results.” The values in cell B1, B2, and B3 (16,
23, and 42) are averaged, and the result, 27, is displayed in cell B4.

The Different Types of Cell References 

There are a few different types of cell references that you can use in Excel: 
relative cell references, absolute cell references, and mixed cell references. 
The differences between these different types of cell references only come 
into play when you are copying a formula or function to a new cell. If are 
entering a formula that is not going to be copied, it would not make any 
difference which cell reference type you chose. 

Relative Cell References 

The most commonly used of the cell reference types is the relative cell 
reference. When you type a cell reference using just the column letter and 
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row number, you are using a relative reference. When a formula with a 
relative reference in it is copied to a new cell, the reference “moves” the 
same distance that the copied formula moves, Look at the example if  

Figure 2-18: Relative Cell Reference 

In Figure 4, The formula =A1+B1 is typed into cell C1. Figure 5 shows 
the result of that formula, 20. That formula is copied, using the fill handle, 
to cells C2 and C3. Figure 6 of Figure 2-22 shows the results, after the 
formula has been copied. 

Figure 2-19: Copy Cell 

In Figure 7 of Figure 2-23, Notice that what ends up in the new cells isn’t 
exactly what was originally typed. The formula =A1+B1 was typed in cell 
C1, but what ends up in cell C3 is the formula =A3+B3. The formula was 
copied down two cells, from cell C1 to cell C3. The cell references used in 
the formula moved down two cells also. A1 became A3, and B1 became 
B3. 

When it comes to copying formulas, Excel understands a relative cell 
references like this: “Take the value stored two cells to the left of the 
current cell and add it to the value stored one cell to the left of the current 
cell, and display the results.” The “current cell” in the example is cell C1, 
the cell two to the left of that is cell A1, and the cell one to the left of that 
is cell B1. When the formula is copied to a new location, Excel references 
whatever cells are two to the left and one to the left of location the formula 
is copied to. 

If you copy a formula three cells to the right and two cells down, the 
relative cell references in the formula move three cells to the right, and 
two cells down. Everything stays the same relative distance from the cell 
with the formula in it. CCC-1.1/101



Absolute Cell References 

There are times when you are copying a formula that you do not want 
Excel to change certain cell references when the formula is pasted in the 
new location. Absolute Cell References don’t change when a formula is 
copied and pasted; the location they refer to always stay the same even 
though the formula moves to a new cell. A dollar sign is typed before the 
column letter and before the row number to indicate that the cell reference 
is an absolute reference (for example: $B$2). 

Figure 2-20: Absolute Cell Reference 

The example shown in Figures 8 – 11 of Figure 2-24 to Figure 2-25 on the 
next page gives a scenario where an absolute reference comes in handy. A 
company wants to give each employee a bonus this month. The bonus for 
each employee is calculated by multiplying their salary for the month 
times the 

Figure 2-21: Absolute Cell Reference 

In Figure 8 of Figure 2-24, the formula =B3*$B$1 is and one absolute 
reference ($B$1). Cell C3 was copied to cells C4 and C5 has been copied 
.entered into cell C3. This formula uses one relative reference (B3), Figure 
9 shows the result of the formula, 150. That formula from using the fill 
handle, Figure 10 of Figure 2-24 shows the results, after the formula 

Figure 11 of Figure 2-25 shows the formula that ended up in cell C5. The 
cell reference B3 that was originally typed has changed to B5 when the 
formula was copied and pasted. The formula moved down two cells, so the 
relative cell reference moved down two cells. Because an absolute cell 
reference was used for cell B1, that cell reference stayed fixed in place 
when the formula moved. 
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Figure 2-22: Error in Cell 

Figure 12 of Figure 2-26 shows what would have happened if an absolute 
reference had not been used in the original formula entered in cell C3. If 
the formula had just been entered as =B3*B1, the result in cell C3 would 
have still been correct. But when the formula was copied to cells C4 and 
C5, you get incorrect results. The formula that ends up in cell C4 is = 
B4*B2 (that’s 3500 times the word Salary, which results in an error 
message). The formula that ends up in cell C5 is =B5*B3 (that’s Jones’s 
salary times Smith’s salary, giving Smith a bonus of 9900000). 

2.3  AutoSum Formula 

AutoSum is a simple mathematical formula to display the total sum of the 
neighboring cells. Excel chooses these cells automatically based on the 
ideal usage of the position of the result. AutoSum first checks if there is 
any continuous group of cells which has numbers above the result cell for 
its range, then it checks to the left side of the result cell. But the range of 
cells that are included for the calculation can be reselected manually by 
dragging if it’s wrong. 

Copying Formulas with the Fill Handle 

To complete the worksheet, we need to add the three formulas created 
above to rows 9, 10, and 11.  Since our data is laid out in rows we can 
copy the formulas in row 8 to rows 9 to 11.  A quick way of copying 
formulas is to use the fill handle. The fill handle is the small black square 
in the bottom right corner of the active cell. 

Steps for Copying Formula 

1. Drag select cells D8 to F8 to highlight them.

2. Place the mouse pointer over the black square in the bottom right
corner of cell F8. The pointer will change to a plus sign " + ".
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3. Click the left mouse button and drag the fill handle down to cell
F11.

4. Release the mouse button. Cells D9 to E11 should contain the
results of the Total Income, Deductions, and Net Salary formulas.

5. Save your worksheet.

2.4  Relative and Absolute Addressing 

You already know that one of the powerful features of 
spreadsheets is that you can refer to the contents of other cells within a 
formula. In Excel, cells are referred to by a combination of their column 
letter and row number. Thus, the cell at the intersection of column D and 
row 15 is known as cell D15. 

When you copy a formula that contains a cell reference, Excel 
automatically assumes that you want to cell reference modified to reflect 
the cell into which you are pasting the formula. For example, suppose that 
the cell at B1 contains the simplest of formulas, as follows: 

=A1 

This simply means that B1 will contain the same value as in A1. 
Now suppose you copy cell B1 and paste it into B2 through B5. As Excel 
pastes each cell, it modifies the formula so the cell reference is the same, 
relative to the new location, as it was to the old. In the original formula, 
Excel knows that the cell being referenced was one cell to the left of the 
cell containing the formula. Thus, every cell into which the formula is 
pasted will contain a formula that has a cell reference one cell to the left of 
the target cell. For example, cell B2 will contain the formula =A2 and cell 
B5 will contain the formula =A5. 

If you don't want Excel to modify the row or column designator in 
your cell references, then you must use absolute cell references. You 
designate a reference as absolute (unchangeable) by preceding it with a 
dollar sign ($). You can precede either the column letter or row number 
with the dollar sign. When you later copy and paste the formula containing 
the absolute reference, Excel will not modify that portion of the reference, 
but will paste it unchanged in the target. 

Normally you use absolute referencing when you want to refer to a 
non-changing position in a formula. For instance, if the cell at A7 contains 
an interest rate, and you want that interest rate referred to specifically, 
without it being modified by Excel, then you would use the following cell 
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=$A$7 

Another way to ensure that Excel does not modify your cell 
reference is to name the references and use the names in your formulas. 

Check your progress 
Q1.  Explain the working of single and multiple workbook. 

Q2.  How we Calculate with Functions in excel? 

Q3.  Explain AutoSum Formula. 

Q4.  Explain Relative and Absolute Addressing 

2.5 Worksheet with ranges 

A range is a group or block of cells in a worksheet that have been 
selected or highlighted. When cells have been selected they are 
surrounded by an outline or border. 

Normally there is only one cell in the worksheet with a black 
outline. This is the active cell. Whatever command is executed by Excel 
affects the active cell. 

Figure 2-23: Range in Worksheet 

Using the mouse, keyboard or Name Box, more than one cell can 
be selected to create a range, and commands executed by Excel will affect 
the entire range. 

Ranges can be made up of adjacent or non-adjacent cells. Adjacent 
cells are all together. There are no gaps in the range. Non-adjacent cell 
ranges consist of two or more separate blocks of cells. These blocks can be 
separated by rows or columns. For non-adjacent ranges, a block of cells 
can be of any size – from one to several hundred or even a thousand or 
more. 

A range consisting of adjacent cells can be created by dragging 
with the mouse. 

Ranges consisting of non-adjacent cells can be created by using the 
mouse and keyboard, or the keyboard on its own. CCC-1.1/105



Ranges are identified by the cell references or addresses of the 
cells in the upper left and lower right corners of the range. These two 
references are separated by a colon ( : ) which tells Excel to include all the 
cells between these start and end points. 

An example of a range of adjacent cells as seen in the image above 
would be D1:D6. 

Non adjacent cell ranges are identified by separating the range of 
each cell block with commas. 

An example would be A2:B4, D6:E8. 

The two cell blocks in the range are A2 to B4 and D6 to E8. 

2.6 Format Worksheet 

Convert Text to Columns 

Sometimes you will want to split data in one cell into two or 
more cells.  You can do this easily by utilizing the Convert Text to 
Columns Wizard. 

 Highlight the column in which you wish to split the data

 Click the Text to Columns button on the Data tab

 Click Delimited if you have a comma or tab separating the data, or
click fixed widths to set the data separation at a specific size.

Format Cells Dialog Box 

In Excel, you can also apply specific formatting to a cell. To apply 
formatting to a cell or group of cells: 

 Select the cell or cells that will have the formatting

Figure 2-24: Format Cells CCC-1.1/106



 Click the Dialog Box arrow on the Alignment group of
the Home tab

There are several tabs on this dialog box that allow you to 
modify properties of the cell or cells.  

Number:  Allows for the display of different number types and decimal 
places 
Alignment:  Allows for the horizontal and vertical alignment of text, wrap 
text, shrink text, merge cells and the direction of the text. 
Font:  Allows for control of font, font style, size, color, and additional 
features 
Border:  Border styles and colors 
Fill:  Cell fills colors and styles 

Hide or Unhide Rows or Columns 
To hide or unhide rows or columns: 

 Select the row or column you wish to hide or unhide

 Click the Format button on the Cells group of the Home tab

 Click Hide & Unhide

Figure 2-25: Cell Hide/Unhide 

The image part with relationship ID rId40 was not found in the file.
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Merge Cells 

To merge cells select the cells you want to merge and click the Merge & 
Center button on the Alignment group of the Home tab.  The four choices 
for merging cells are: 

Merge & Center: Combines the cells and centers the contents in the new, 
larger cell 

Merge Across: Combines the cells across columns without centering data 

Merge Cells: Combines the cells in a range without centering 

Unmerge Cells: Splits the cell that has been merged 

Figure 2-26: Cell Merge/Unmerge 

2.7  Previewing & Printing worksheet 
Your worksheet looks fine on the screen, so you are now ready to print — 
right? Not necessarily. You could save time and paper by adjusting the 
format and page layout of your worksheet, or by taking measures to avoid 
common printing problems before you print your worksheet. 

Fine-tuning the layout of printed pages 

Before you print a worksheet that contains large quantities of data or 
charts, you can quickly fine-tune the worksheet in the new Page 
Layout view to achieve professional-looking results. In this view, you can 
see your data in the context of printed pages. You can easily add or change 
page headers and footers, hide or display row and column headers, change 
the page orientation of printed pages, change the layout and format of 
data, use the rulers to measure the width and height of the data, and set 
margins for printing. 

Printing row and column headings or labels on every page 

If a worksheet spans more than one page, you can print row and column 
headings or labels (also called print titles) on every page to ensure that the 
data is properly labeled. 

 Column labels 

The image part with relationship ID rId40 was not found in the file.
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Figure 2-27: Column Labels 

Previewing a worksheet before you print it 

For an exact preview of how the data will be printed, you may want to 
preview the worksheet pages in Print Preview view. In this view, you can 
make any final adjustments to the pages before you print. 

Printing all or part of a worksheet 

You are finally ready to print your data. When you click Print (Microsoft 

Office Button  ), you can specify exactly what you want to print. You 
can print all of the worksheets in your workbook, print one or more 
selected worksheets, or print only a selected portion of the worksheet. 

If you plan to print a specific portion of a worksheet frequently, you can 
define it as a print area (Page Layout tab, Page Setup group). That way, 
every time that you print the worksheet, Excel prints only the data that is 
specified in the print area. 

2.8  Graphs & Charts 

Microsoft Office Excel 2007 no longer provides the chart wizard. 
Instead, you can create a basic chart by clicking the chart type that you 
want on the Microsoft Office Fluent user interface Ribbon. To create a 
professional-looking chart that displays the details that you want, you can 
modify the chart, apply predefined styles and layouts, and add eye-
catching formatting. You can also reuse a favorite chart by saving it as a 
chart template. 

If you have Office Excel 2007 installed, you can also take 
advantage of the powerful Excel charting functionality in other 2007 
Microsoft Office system programs, such as Microsoft Office PowerPoint 
2007 and Microsoft Office Word 2007. 

Charts and their elements 
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Charts are used to display series of numeric data in a graphical 
format to make it easier to understand large quantities of data and the 
relationship between different series of data. 

A chart has many elements. Some of these elements 
are displayed by default; others can be added as needed. You can change 
the display of the chart elements by moving them to other locations in the 
chart, resizing them, or by changing the format. You can also remove 
chart elements that you do not want to display. 

The chart area of the chart 

 The plot area of the chart 

 The data points of the data series that are plotted in the chart. 

 The horizontal (category) and vertical (value) axis along which the 
data is plotted in the chart 

 The legend of the chart 

 A chart and axis title that you can use in the chart 

 A data label that you can use to identify the details of a data point in a 
data series 

Figure 2-28 Graphs 

When you click anywhere in the chart area, and then hover the mouse 
pointer over one of these elements, Excel displays information about that 
element in a ScreenTip. 

Clicking anywhere in a chart also makes the Chart Tools available, adding 
the Design, Layout, and Format tabs. 
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Figure 2-29 Graphs Design 

Creating Bar Charts 

1. Select the data:  To select the data for your graph (include the
category labels and values) click on the first cell of data and then drag 
your cursor (it should be a thick cross) over the remaining data to be 
included as part of the chart.  If you are graphing more than one series, 
click on the empty cell above the category labels and slide to the right over 
the series labels (then down over the values).  If the series labels are not 
directly above the data values, you will need to retype the series labels 
above the data values (see below). 

Figure 2-30 Bar Chart Data 

2. Choose a chart type: On the Insert tab of the Charts group select
Column. Under Column, choose 2-D Clustered Column (the first option 
on the left). A simple graph is created. 
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Figure 2-31 Insert Chart 

2. Choose a layout:  You will need to add a title and axis labels. First
click on the graph to activate the Chart Tools menu and then choose the 
Design tab.  Under the Charts Layout group, select Layout 9. (Click on the 
"more" arrow to display all nine layouts. Slide over each layout until you 
locate #9.) 

Figure 2-32 Chart Design 

4. Update titles:  Click on the Chart Title and add a descriptive title
(consider who, what, where and when).  Click on each Axis Title and label 
both your x-axis (horizontal axis) and your y-axis (vertical axis).  If you 
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are graphing only one series of data, always be certain to remove the 
legend (just click on the legend and use either the delete or backspace 
button).   

5. Naming each series in the legend:  If you need to edit the names of
your series (2000 and 2004 above) you can do so by first clicking on the 
graph to activate the Chart Tools menu. Under Chart Tools choose the 
Design tab, and under the Data group, select Select Data. The series are on 
the left side of the box. To edit the name of a series, highlight it and then 
click the Edit button. When the Edit Series box appears, type your series 
name in the box labeled Series Name. 

Figure 2-33 Chart Data Source 

Figure 2-34 Edit Series 

6. Add the Source:  It is important to add a text box stating the data source
used to create the graph.  Under the Insert tab choose text box under the 
Text group.  Draw a text box on your chart and then type in "Source:" 
followed by the data source.  If no data source is listed, type "Unknown". 

2.9  Creating and using macros 

Start by turning on the macro recorder and running through the 
tasks. When you turn off the recorder, Office Excel 2007 converts every 
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click and key press into a series of commands and functions that are stored 
as a module in a workbook or in Excel 2007. The next time you need to 
perform the tasks, run the macro, and the commands and functions are 
performed automatically in the order in which they were recorded. 

Because Excel 2007 is running the commands, tasks are performed 
at the speed of a computer and without interruption. Manually, a task 
could take 10 or more seconds, but by using a macro, a range can 
be formatted in a fraction of a second. The macro not only saves you time, 
it saves you from having to remember a lot of tedious details. With a 
macro, the formatting is exactly the same every time you run it. 

Think about the tasks that you need to automate when you work 
with certain types of worksheets. For example, you could create a macro 
that quickly hides a group of monthly columns so that only the summary 
data shows. You could create another macro to show all of the details 
again. You could even create a macro to format cells so that long headings 
wrap around the cells. 

Create macros 

To create macros, you need to first enable the Developer tab in Office 
Excel 2007 and change your security for macros. Then, you can record 
and run macros when you need them. To run a macro, a user does not 
necessarily need the Developer tab. 

Enable macros 

1. If you do not see a Developer tab at the top of your Excel 2007
window, click the Microsoft Office button, and then click Excel
Options.

2. In the left navigation pane, click Popular, and then under Top
options for working with Excel, select the Show Developer tab in
the Ribbon check box.

3. Click OK.

4. Click the Developer tab, and in the code group, click Macro
Security.

Figure 2-35: Macro-Security Alert 
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You can modify the macro code in Visual Basic, but you are not required 
to do so. 

5. Select Enable all macros (not recommended; potentially dangerous
code can run), and then click OK. 

Tip: Enabling macros will not harm your computer, and neither 
will your macro. However, you should keep in mind that by enabling all 
macros to run in Excel 2007, you are not only allowing your own macros 
to run but also potentially harmful macros. By setting macro security to 
disable all macros with notification, a security warning will appear when 
you open an Excel 2007 workbook that contains a macro. To enable 
macros, click Options, and then select enable this content. See macro 
security topics in Office Excel 2007 Help for more information.  

2.10  Working with Multiple Worksheets 

Working with multiply sheets concurrently is how MS Excel 
power users create and format a complex workbook with the least amount 
of effort expended.  

Follow the steps below to make working with multiple sheet a 
piece of cake and you will be on your way to becoming a power user!  

 Hold down the CTRL key as you click each tab top selects
multiple worksheets.
To select a contiguous group of worksheets, click the first one in
the group and then hold down the Shift key and click the last one
in the group.

 To select all the worksheets in the current workbook, right-click
any worksheet tab and choose select All Sheets from the shortcut
menu.

 To quickly make any sheet active, click its index tab; to remove a
sheet from a selected group of sheets, hold down CTRL and click
its tab.

 To remove the multiple selection and resume working with a single
sheet, click any unselected sheet. If you have selected every sheet
in the workbook, right-click any worksheet tab and choose
Ungroup Sheets.  If you have selected more than one sheet, you see
the word Group in brackets in the title boar, and any data you enter
appears in the corresponding cells on each worksheet in the group.
So, if you have grouped Sheet1, Sheet2 and Sheet3, entering text in
cellA1 on Sheet1 also enters the same text in the corresponding
cells on Sheet2 and Sheet3.
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 Any choices you make such as applying a number format, affect all
the grouped worksheets identically. If you are building a workbook
with identically formatted sheets, you can use these techniques to
quickly enter category headings, etc. along the top of each sheet.

 You cannot use the Clipboard to enter data into multiple sheets
concurrently. When you paste data, it only appears in the active
sheet and not in any other sheets you have selected.

Check your progress
Q1. Explain how to Convert Text to Columns 

Q2. How to Merge Cells in excel? 

Q3. How to print row and column headings or labels on every 

       page? 

Q4.  Explain charts and their elements. 

Q5. How to creating bar charts? 

Q6. How to create macros? 

2.11 Summary
In this unit you learnt advanced features of MS- Excel like Working with 
single and multiple workbook, Working with formula & cell referencing 
Auto sum, Coping formula Absolute & relative addressing, Worksheet 
with ranges  Formatting of worksheet Previewing & Printing worksheet 
Graphs and charts, Database Creating and Using macros Multiple 
worksheets- concepts. 

 A formula is a set of mathematical instructions that can be used in
Excel to perform calculations.

 A function is a built in formula in Excel.  A function has a name
and arguments (the mathematical function) in parentheses.

 Each workbook has three buttons on the top right which can be
used to minimize, maximize and close the workbook.

 When you have multiple workbooks open, only one workbook will
be active.

 Charts are used to display series of numeric data in a graphical
format to make it easier to understand large quantities of data and
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2.12 Review Questions
Q1. How can we use multiple workbooks? 

Q2.   What is cell referencing? Why we use it? Explain with example. 

Q3.   Define Absolute & relative addressing with example. 

Q4.  What are graphs and charts? How we can used it in our excel 
sheet? 

Q5.  How can we create and use multiple worksheets? Define with 
example. 
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UNIT-III 
INTRODUCTION TO POWER POINT

Structure 

3.0  Introduction 

3.1  Presentations  

3.2  Creating Slides 

3.3  Manipulating & Enhancing Slides 

3.4  Organizational Charts 

3.5  Excel Charts 

3.6  Word Art 

3.7  Layering an Object 

3.8  Animations and Sounds 

3.9  Summary 

3.10 Review Questions 

3.0  Introduction 

This is the third unit of this block. This block define MS-
PowerPoint In this block there are eight sections. In the first section we 
defined about the presentation. Next section express how you we can 
create slides. In the Sec. 3.3 you will learn about manipulating and 
enhancing slides. In the section Sec. 3.4 you will know about how to 
create and handle organizational charts. Next section explain about excel 
charts. In Sec. 3.6 you will learn about word art. In the Sec. 3.7 we 
focused on object layering and the next section describe about the 
animations and sounds. In Sec. 3.9 and 3.10 you will find summary and review 
questions respectively. 

Objectives 

After studying this unit you should be able to: 

 Define presentation, slide creations, manipulation of slides.

 Express organizational charts, excel chats, word art, layering an
object and animation and sound.
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3.1  Presentations 

Microsoft PowerPoint, part of Microsoft Office, creates and plays 
presentations. A presentation is something a speaker makes to an 
audience, typically using a computer and LCD projector to display 
material in a lecture hall or auditorium. PowerPoint works a lot like 
Microsoft Word, and the assumption here is that you are familiar with 
Word. 

A PowerPoint presentation is made up of "slides" that is individual 
frames or screens of information. To create a presentation, create the 
slides. A PowerPoint file (*.ppt) is a collection of slides, typically for one 
and only one presentation, although files can be linked together to make 
up compound presentations. PowerPoint has functions for 

 Creating and inserting new slides.

 Editing existing slides.

 Reordering existing slides.

Slides can contain 

 Text

 Tables

 Bulleted and numbered lists

 Graphics

 Audio

 Video

 Many other types of content.

3.2  Creating Slide 

 If Office PowerPoint 2007 is already running, save and close any
open presentations, and then exit and restart PowerPoint 2007.

 Find links to information about saving presentations in the See
Also section.

 If Office PowerPoint 2007 isn't already running, start it now.

When you start PowerPoint, it opens in the view called Normal view, 
where you create and work on slides. 
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 In the Slide pane, you can work directly on individual slides. 

 Dotted borders identify placeholders, where you can type text or insert 
pictures, charts, and other objects. 

 The Slides tab shows a thumbnail version of each full size slide shown 
in the Slide pane. After you add other slides, you can click a thumbnail on 
the Slides tab to make the slide appear in the Slide pane. Or you can drag 
thumbnails to rearrange the slides in your presentation. You can also add 
or delete slides on the Slides tab. 

 In the Notes pane, you can type notes about the current slide. You can 
hand out your notes to your audience or refer to your notes in Presenter 
view when you give your presentation. 

To create a new presentation that is based on the Blank Presentation 

template, click the Microsoft Office Button , click New, click Blank 
and recent under Templates, and then double-click Blank Presentation 
under Blank and recent. 

After you open the Blank Presentation template, only a small portion of 
the Notes pane is visible. To see a larger portion of the Notes pane so that 
you have more room to type in it, do the following: 

1. Point to the top border of the Notes pane.

2. When the pointer becomes a , drag the border up to make a little
more room for your speaker notes, as shown in the following
illustration.
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Figure 3-1: Add Notes 

Notice that the slide in the Slide pane resizes automatically to fit the 
available space. 

Near the top of the screen are three buttons that you may find useful: 

 Undo , which undoes your last change. (To see a ScreenTip 
about which action will be undone, rest your pointer on the button. 
To see a menu of other recent changes that can also be undone, 
click the arrow to the right of Undo .) You can also undo a 
change by pressing CTRL+Z. 

 Redo or Repeat , which either repeats or redoes your last
change, depending on what action you just performed. (To see a
ScreenTip about which action will be repeated or redone, rest your
pointer on the button.) You can also repeat or redo a change by
pressing CTRL+Y.

 Microsoft Office PowerPoint Help , which opens the 
PowerPoint Help pane. You can also open Help by pressing F1.

Name and save your presentation 

As with any software program, it is a good idea to name and save your 
presentation right away and then to save your changes frequently while 
you work: 

1. Click the Microsoft Office Button , point to Save As, and then 
do one of the following:

 For a presentation that can be opened only in Office PowerPoint
2007, click PowerPoint Presentation.

 For a presentation that can be opened in either Office PowerPoint
2007 or earlier versions of PowerPoint, click PowerPoint 97-2003
Presentation.

 If you choose this option, you cannot use any of the features that
are new in Office PowerPoint 2007.
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2. In the Save As dialog box, in the Save in list, select the folder or
other location where you want to save your presentation.

3. In the File name box, type a name for your presentation, or do
nothing to accept the default file name, and then click save.

From now on, you can press CTRL+S or click Save near the top of 
the screen to save your presentation quickly at any time. 

3.3  Manipulating & Enhancing Slides 

Add, rearrange, and delete slides 

The single slide that is provided automatically in your presentation has 
two placeholders, one formatted for a title and the other formatted for a 
subtitle. The arrangement of placeholders on a slide is called a layout. 
Office PowerPoint 2007 also provides other types of placeholders, such as 
those for pictures and SmartArt graphics. 

When you add a slide to your presentation, you can do the following to 
choose a layout for the new slide at the same time: 

1. On the Slides tab, click just below the single slide that already
appears there.

2. On the Home tab, in the Slides group, click the arrow next to New
Slide.

Figure 3-2: New Slides 

A gallery appears, showing thumbnails of the various slide layouts that are 
available. 

 The name identifies the content that each layout is designed for. 

 Placeholders that display colour icons can contain text, but you can 
also click the icons to automatically insert objects, including SmartArt 
graphics and clip art. 
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Figure 3-3 

3. Click the layout that you want for your new slide.

The new slide now appears both on the Slides tab, where it is highlighted 
as the current slide, and in the Slide pane. Repeat this procedure for each 
new slide that you want to add. 

Apply a new layout to a slide 

To change the layout of an existing slide, do the following: 

1. On the Slides tab, click the slide that you want to apply a new
layout to.

2. On the Home tab, in the Slides group, click Layout, and then click
the new layout that you want.

Copy a slide if you want to create two slides that are similar in content and 
layout, you can save work by creating one slide that has all of the 
formatting and content that both slides will share and then making a copy 
of that slide before you add the final, individual touches to each. 

1. On the Slides tab, right-click the slide that you want to copy, and
then click Copy on the shortcut menu.

2. Still on the Slides tab, right-click where you want to add the new
copy of the slide, and then click Paste on the shortcut menu.
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You can also insert a copy of a slide from one presentation into another 
presentation. 

Delete a slide 

 On the Slides tab, right-click the slide that you want to delete, and
then click Delete Slide on the shortcut menu.

3.4  Organization chart 

If you want to illustrate the reporting relationships in your 
company or organization, you can create a SmartArt graphic that uses an 
organization chart layout, such as Organization Chart, or you can use 
Microsoft Office Visio 2007 to create an organization chart. If you have 
Office Visio 2007, you can read more about when Visio is the best way to 
create your organization chart. 

Overview of creating an organization chart 

An organization chart graphically represents the management 
structure of an organization, such as department managers and non-
management employees within a company. By using a SmartArt graphic 
in Microsoft Office Excel 2007, Microsoft Office Outlook 2007, 
Microsoft Office PowerPoint 2007, or Microsoft Office Word 2007, you 
can create an organization chart and include it in your worksheet, 
presentation, or document. To create an organization chart quickly and 
easily, you can type or paste text in your organization chart and then have 
the text automatically positioned and arranged for you. 

When you add an assistant box to an organization chart layout, 
such as Organization Chart, a bullet with a line attached indicates the 
assistant box in the Text pane. 

Figure 3-4: Organization Chart 

Although you can use other hierarchy layouts to create an 
organization chart, the assistant box and the hanging layouts are available 
only with organization chart layouts. 

To quickly add a designer-quality look and polish to your SmartArt 
graphic, you can change the colors or apply a SmartArt Style to your 
organization chart. You can also add effects, such as glows, soft edges, or 
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3-D effects. In Office PowerPoint 2007 presentations, you can animate 
your organization chart. 

Create an organization chart 

1. On the Insert tab, in the Illustrations group, click SmartArt.

Figure 3-5: Smart Art 

2. In the Choose a SmartArt Graphic gallery, click Hierarchy, click
an organization chart layout (such as Organization Chart), and then
click OK.

3. To enter your text, do one of the following:

 Click in a box in the SmartArt graphic, and then type your text.

 Click [Text] in the Text pane, and then type your text.

 Copy text from another location or program, click [Text] in the
Text pane, and then paste your text.

Figure 3-6: Text Pane 

Change the colors of your organization chart 

You can apply color combinations that are derived from the theme 
colors to the boxes in your SmartArt graphic. 

1. Click the SmartArt graphic whose color you want to change.

2. Under SmartArt Tools, on the Design tab, in the SmartArt
Styles group, click Change Colors.
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Figure 3-7 

If you don't see the SmartArt Tools or Design tabs, make sure that you've 
selected a SmartArt graphic. 

3. Click the color combination that you want.

Change the background color of a box in your organization chart 

1. Right-click the border of a box, and then click Format Shape on
the shortcut menu.

2. Click the Fill pane, and then click Solid fill.

3. Click Color , and then click the color that you want. 

4. To specify how much you can see through the background color,
move the Transparency slider, or enter a number in the box next to
the slider. You can vary the percentage of transparency from 0%
(fully opaque, the default setting) to 100% (fully transparent).

Apply a SmartArt Style to your organization chart 

A SmartArt Style is a combination of various effects, such as line 
style, bevel, or 3-D that you can apply to the boxes in your SmartArt 
graphic to create a unique and professionally designed look. 

1. Click the SmartArt graphic who’s SmartArt Style you want to
change.

2. Under SmartArt Tools, on the Design tab, in the SmartArt
Styles group, click the SmartArt Style that you want.

To see more SmartArt Styles, click the More button . 

If you don't see the SmartArt Tools or Design tabs, make sure that you've 
selected a SmartArt graphic. 

Animate your organization chart 

If you're using Microsoft PowerPoint 2007, you can animate your 
organization chart to emphasize each box, each branch, or each 
hierarchical level. 

1. Click the SmartArt graphic organization chart that you want to
animate.

2. On the Animations tab, in the Animations group, click Animate,
and then click By branch one by one.
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Figure 3-8 

NOTE    If you copy an organization chart that has an animation 
applied to it to another slide, the animation is also copied. 

Use charts and graphs in your presentation 

Office PowerPoint 2007 includes many different types of data 
charts and graphs including column charts, line graphs, pie charts, bar 
charts, area graphs, scatter graphs, stock charts, surface charts, doughnut 
charts, bubble graphs, and radar graphs. 

If Office Excel 2007 is not installed, when you create a new data 
chart in Microsoft Office PowerPoint 2007, Microsoft Graph opens. A 
chart then appears with its associated data in a table called a datasheet. 
You can enter your own data in the datasheet, import data from a text file 
to the datasheet, or paste data from another program to the datasheet. 

Overview of data charting and graphing 

You can add a data chart or graph to your presentation in one of 
two ways: 

 You can create a chart or graph in your presentation.    When you
create a new chart in PowerPoint, you edit the data for that chart in
Office Excel 2007, but the data is saved with the PowerPoint file.

 You can paste an Excel chart or graph into your presentation and
link to the data in an Office Excel 2007 file.    When you copy a
chart from a saved Office Excel 2007 file and paste it into your
presentation, the data in the chart is linked to that Excel file. If you
want to change the data in the chart, you must make your changes
to the linked worksheet in Office Excel 2007 and then refresh the
data in your PowerPoint presentation. The Excel worksheet is a
separate file and is not saved with the PowerPoint file.CCC-1.1/128



Figure 3-9 Graphs 

A chart in PowerPoint that is made up of sample data from an Excel 
worksheet 

Insert a chart or graph in your presentation 

Do the following when you want to create a new chart or graph in 
PowerPoint: 

1. In PowerPoint, click the placeholder that you want to contain the
chart.

2. On the Insert tab, in the Illustrations group, click Chart.

3. In the Insert Chart dialog box, click a chart, and then click OK.

Office Excel 2007 opens in a split window and displays sample data on a 
worksheet. 

Figure 3-10: Sample data on an Excel worksheet 

4. In Excel, to replace the sample data, click a cell on the worksheet,
and then type the data that you want.You can also replace the
sample axis labels in Column A and the legend entry name in Row
1.

5. When you are finished inputting the data in Excel, on
the File menu, click Close.
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Check your progress
Q1. How to creating a slide in power point 

Q2. How to manipulate & enhance slides 

Q3. Explain steps to create an organization chart 

3.5  Excel chart 

You create and copy the chart or graph in Office Excel 2007 and 
then paste it into your PowerPoint presentation. When you update the data 
in the linked Office Excel 2007 file, you can update the chart in 
PowerPoint by using the Refresh Data command. 

1. In Excel, select the chart by clicking its border, and then on
the Home tab, in the Clipboard group, click Cut.

2. In PowerPoint, click the placeholder on the slide or notes page that
you want to insert the chart on.

3. On the Home tab, in the Clipboard group, click the arrow
under Paste, and then click Paste.

Create another type of chart (flow chart, organization chart, timeline) 

 To create an organization chart, see the article Create an
organization chart.

 To create a flow chart, look at the template Basic flow chart
template for PowerPoint 2007.

 To create a timeline using a SmartArt graphic, see the
article Create a SmartArt graphic.

3.6 Word Art 

Figure 3-11: Word Art 
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There are many features and commands you can use 
in PowerPoint to create visually appealing slides. Two of these features 
are WordArt and shapes. WordArt allows the user to create stylized 
text with textures, shadows, outlines, and more. It can be applied to text on 
any slide. Additionally, in PowerPoint, you can insert a variety of 
shapes such as lines, arrows, callouts, stars, and basic 
shapes including rectangles and circles.  

Working with WordArt 

To Apply a WordArt Style: 

 Select the text you wish to modify. The Format tab will appear.

 Select the Format tab.

 Move your cursor over a WordArt style in the WordArt Styles
group to see a live preview of the style on the slide.

Figure 3-12: Word Art Styles 

 Click the More drop-down arrow to see all the possible WordArt styles.

Figure 3-13: Word Art Styles More 
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 Click an option to select it.

To Change the Fill Color of a WordArt Style: 

 Select the text you wish to modify.

 Click the Text Fill command in the WordArt Styles group.

Figure 3-14: Word Art Format 

 Move your cursor over a color option to see a live preview on the
slide.

 Click a color to select it. 
Or Select:

 No Fill: This option will leave the WordArt text without a fill
color.

 More Fill Colors: Opens a dialog box of color choices that you can
use as a fill color.

 Picture: Opens the Insert Picture dialog box. From here, you can
select a picture from your computer to use as the fill background.

 Gradient: Displays a sub menu of various gradient options that
changes how the fill color appears.

 Textures: Displays a sub menu of various textures that you can
apply to the WordArt text.

To Change the Text Outline of a WordArt Style: 

 Select the text you wish to modify. The Format tab will appear.

 Select the Format tab.

 Click the Text Outline command in the WordArt Styles group.

The image part with relationship ID rId40 was not found in the file.
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Figure 3-15: Word Art Format 

 Move your cursor over a color option to see a live preview on the
slide.

 Click a color to select it.

From the Text Outline menu, you can also choose to apply no outline 
color, access more colors, change the weight of the line, and change the 
line style. 

To Apply a Text Effect to a WordArt Style: 

 Select the text you wish to modify. The Format tab will appear.

 Select the Format tab.

 Click the Text Effects command. A menu of options will appear.

Select a menu option. The options are: Shadows, Reflection, Glow, Bevel, 
and Transform. This will display a sub menu. 

The image part with relationship ID rId40 was not found in the file.

CCC-1.1/133



Figure 3-16: Text Effects 

 Click an option from the sub menu to select it.

You can use WordArt to create stylized text that is eye-
catching and professional; however, with so many styles and options, you 
can also create text that is not appropriate for the presentation, difficult to 
read, or simply does not look appealing. Remember, just because you can 
do something does not mean you should! 

3.7  Layering Objects in PowerPoint 

As you add objects to your slides, you may find that one object 
overlaps on another or causes another object to disappear completely. For 
instance, you may add a Clip Art graphic to your slide and then want to 
draw a rectangle around the graphic. However, when you draw the 
rectangle, you find that the graphic has disappeared from the screen. 

PowerPoint layers objects in a stack; that is to say, the first object 
drawn or inserted is on the bottom of the stack, the next object appears on 
top of the previous object, and so on. You can change the position of an 
object in the stack by using one the Order commands. There are four order 
commands: 

 Bring to Front – moves the selected object to the very top of the
stack

 Send to Back – moves the selected object to the very back of the
stack

The image part with relationship ID rId40 was not found in the file.
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 Bring Forward – moves the selected object one position up in the
stack

 Send Backward – moves the selected object one position back in
the stack

Figure 3-17: Layering Objects commands 

In the example above, if we selected the rectangle and chose the Send to 
Back command, our text box would now be visible as the rectangle has 
now moved to the back of the layered stack. 

To Change the Layering Order of Objects 

1. Select the graphical object that you wish to move.

2. Click the Format tab under the Drawing Tools group.

3. To send an object backward or to the back of the stack, click the
Send to Back arrow on the Arrange group and choose either Send
to back or Send Backward.

4. To bring an object forward or to the front of the stack, click the
Bring to Front arrow on the Arrange group and choose either Bring
to Front or Bring Forward.

3.8  Slide Animation and Sound 

Slide animations are special effects that you can add to objects on a 
slide. 

The image part with relationship ID rId40 was not found in the file.
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Figure 3-18: Custom Animation 

1. To apply animation effects:

 Select the object you want to animate.

 Click the Animation tab on the Ribbon.

 Click Add Effect.

 Choose the effect you want on your object.

Figure 3-19: Custom Animation 

2. To preview the animation on a slide:

 Click the Preview button on the Animation tab.

Figure 3-20: Slide Show 

3. Slide Show Options:

 Preview the slide show from the beginning.

 Preview the slide show from current slide.

 Set up slide show.
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Sounds 

When you insert a sound on a slide, an icon that represents the sound 
file appears. To play the sound while you give your presentation, you can 
set the sound to start automatically when the slide is displayed, start on a 
mouse-click, start automatically but with a time delay, or play as part of an 
animation sequence. You can also play music from a CD or add narration 
to your presentation. 

You can add sounds from files on your computer, a network, or Microsoft 
Clip Organizer. You can also record your own sounds to add to a 
presentation or use music from a CD. 

You can preview a sound and also make the sound icon invisible during a 
slide show by hiding it or moving it off the slide into the grey area. 

To use a sound effect for emphasis, you will want to play the sound once, 
which is the default behaviour for sounds in Microsoft Office PowerPoint. 
To keep the sound playing until you stop it, or to play it for the duration of 
the presentation, you need to choose the stop options in the Custom 
Animation task pane or set the sound to play continuously. If you do not 
choose when you want a sound to stop, it stops the next time that you click 
the slide. 

Only .wav (waveform audio data) sound files can be embedded — all 
other media files types are linked. By default, .wav sound files that are 
greater than 100 kilobytes (KB) in size are automatically linked to your 
presentation, rather than embedded in it. You can increase the size limit 
for embedded .wav files to be a maximum size of 50,000 KB, but raising 
this limit also increases the overall size of your presentation. 

When you insert a linked sound file, PowerPoint creates a link to the 
sound file's current location. If you later move the sound file to a different 
location, PowerPoint cannot locate it when you want the file to play. It is a 
good practice to copy the sounds into the same folder as your presentation 
before you insert the sounds. PowerPoint creates a link to the sound file 
and can find the sound file as long as you keep it in the presentation 
folder, even if you move or copy the folder to another computer. Another 
way to be sure that your linked files are in the same folder as your 
presentation is to use the Package for CD feature. This feature copies all 
the files to one location (a CD or folder) with your presentation and 
automatically updates all the links for the sound files. When your 
presentation has linked files, you must copy the linked files as well as the 
presentation if you plan to give the presentation on another computer or 
send it to someone in e-mail.  

If you want the .wav sound file to be contained inside the presentation, 
you can increase the size of the embedded file to a maximum of 50,000 
KB (50 megabytes). However, raising this limit also increases the overall 
size of your presentation and may slow down its performance. 

The image part with relationship ID rId40 was not found in the file.
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Add a sound 

To prevent possible problems with links, it is a good idea to copy the 
sounds into the same folder as your presentation before you add the 
sounds to your presentation. 

1. In the pane that contains the Outline and Slides tabs, click the
Slides tab.

2. Click the slide to which you want to add a sound.

3. On the Insert tab, in the Media Clips group, click the arrow under
Sound.

Figure 3-21: Sound 

4. Do one of the following:

 Click Sound from File, locate the folder that contains the file, and
then double-click the file that you want to add.

 Click Sound from Clip Organizer, scroll to find the clip that you
want in the Clip Art task pane, and then click it to add it to the
slide.

Preview a sound 

1. On the slide, click the sound icon .

2. Under Sound Tools, on the Options tab, in the Play group, click
Preview. You can also double-click the sound icon.

Choose between Automatically or When Clicked 

When you insert a sound, you are prompted with a message asking how 
you want the sound to start: automatically (Automatically) or when you 
click the sound (When Clicked). 

The image part with relationship ID rId40 was not found in the file.
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 To automatically start the sound when you show the slide, click
automatically.

The sound plays automatically when you show the slide unless there are 
other media effects on the slide. If there are other effects, such as an 
animation, the sound plays after that effect. 

 To manually start the sound when you click it on the slide, click
When Clicked.

When you insert a sound, a play trigger effect is added. This setting is 
known as a trigger because, to play the sound, you have to click something 
specific, as opposed to just clicking the slide. 

Check your progress 
Q1. How to create another type of chart (flow chart, organization 

       chart, timeline). 

Q2. How to working with word art? 

Q3. How to use Layering Objects in PowerPoint. 

Q4. How to add and preview a sound. 

3.8 Summary
In this unit you learnt about basics of power point, creating slides, 

adding animations, adding sounds to slides, excel charts, word arts, 
organization of charts etc. 

 Microsoft PowerPoint, part of Microsoft Office, creates and plays
presentations.

 A presentation is something a speaker makes to an audience,
typically using a computer and LCD projector to display material
in a lecture hall or auditorium.

 PowerPoint works a lot like Microsoft Word, and the assumption
here is that you are familiar with Word.

 A PowerPoint presentation is made up of "slides" that is individual
frames or screens of information.

 To create a presentation, create the slides.

 A PowerPoint file (*.ppt) is a collection of slides, typically for one
and only one presentation, although files can be linked together to
make up compound presentations. CCC-1.1/139



3.9 Review Questions
Q1. What is a power point presentation? How can we create a 

presentation? Explain. 

Q2.  Write all the steps of adding sound to presentation. 

Q3. Define excel charts? Also define the use of excel chart. 

Q4. What is a word art? Write all steps to insert word art into power 
point presentation. 

Q5. Write short note on “Layering an objects” 
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UNIT-IV 

MS- POWER POINT ADVANCED 
FEATURES & DTP SOFTWARE 

Structure 

4.0  Introduction 

4.1  Inserting Animated Pictures or Accessing through Object 

4.2  Inserting Recorded Sound Effect or In-Built Sound Effect 

4.3  Other packages:  

4.4  Summary 

4.5  Review Questions 

4.0  Introduction 

This is the last unit of this block. In this unit you will find MS- 
Power point Advanced Features & DTP Software. There are three sections 
in this unit. Sec. 4.1 define about how to insert animated pictures or how 
we can accessing it through Object. In the next Sec. 4.2 you will learn 
about how to insert recorded sound effect or in-built sound effects in your 
slides. Next section explain about some other software like: DTP software, 
Brief survey of MS Publisher, PageMaker, CorelDraw, and Adobe 
Photoshop. These packages are very important in the market and you can 
learn a lot of creativity with the help of these packages. 

Objectives 
After studying this unit you should be able to: 

 Describe how to insert animated pictures, insert recorded sound effect.

 Define DTP software, MS publisher

 Express PageMaker, CorelDraw, and Adobe Photoshop.

4.1 Inserting Animated Pictures or Accessing 
through Object 

Animate the text or objects in your presentation to give them sound 
effects or visual effects, including movement. You can use animation to 
focus on important points, to control the flow of information, and to 
increase viewer interest in your presentation. 
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You can use the built-in animation effects in Microsoft Office 
PowerPoint 2007, or you can create your own custom effects. You can 
apply animation effects to individual slides, to the slide master, or to 
custom slide layouts. For more information about slide masters and 
custom layouts, see Create, customize, and apply a slide master and 
Overview of layouts. 

 For information about adding transitions between slides (including the
different types that are available) and adding sound to slide transitions,
see Add transitions between slides.

 To animate a SmartArt graphic, see Animate your SmartArt graphic.

Apply a built-in animation effect to text or an object

To apply a built-in animation effect in Office PowerPoint 2007, do
the following: 

1. Select the text or object that you want to animate.

2. On the Animations tab, in the Animations group, select the
animation effect that you want from the animate list.

Figure 4-1 Animation effects 

Create and apply a custom animation effect to text or objects 

To gain more control over how and when effects are applied, you can 
create and apply a custom animation. For example, you can make text 
grow or shrink, spin or shimmer, and you can set an animation so that you 
hear the sound of applause when a picture is revealed. You can apply more CCC-1.1/142



than one animation, so you can make a line of text fly in with or without 
sound, and then make the text fly out. You can use emphasis, entrance, or 
exit options in addition to preset or custom motion paths. 

You create custom animations in the Custom Animation task pane. The 
Custom Animation task pane shows important information about an 
animation effect, including the type of effect, the order of multiple effects 
in relation to each other, and a portion of the text of the effect. 

Icons indicate the timing of the animation effect in relation to the other 
events on the slide. Choices include the following: 

 Start on Click (mouse icon, shown here): The animation effect begins
when you click the slide.

 Start with Previous (no icon): The animation effect begins at the same
time as the previous effect in the list starts playing (that is, one click
executes two or more animation effects).

 Start after Previous (clock icon): The animation effect begins
immediately after the previous effect in the list finishes playing (that is,
no additional click is required to make the next animation effect start).

Select an item in the list to see the menu icon (down arrow), and
then click the icon to reveal the menu. 

Numbers indicate the order in which animation effects play. 
Numbers also correspond to the labels associated with animated items in 
Normal view with the Custom Animation task pane displayed. 

Icons represent the type of animation effect. In this example, it is 
an Emphasis effect. 

Animated items are noted on the slide by a non-printing numbered 
tag. This tag corresponds to the effects in the Custom Animation list, and 
the tag is displayed to the side of the text or object. The tag appears only 
in Normal view with the Custom Animation task pane displayed. CCC-1.1/143



To apply a custom animation effect in Office PowerPoint 2007, do 
the following:  

1. Select the text or object that you want to animate.

2. On the Animations tab, in the Animations group, click Custom
Animation.

3. In the Custom Animation task pane, click Add Effect, and then do
one or more of the following:

 To make the text or object enter with an effect, point to Entrance, and
then click an effect.

 To add an effect, such as a spin effect, to text or an object that is already
visible on the slide, point to Emphasis, and then click an effect.

 To add an effect that makes text or an object leave the slide at some
point, point to Exit, and then click an effect.

 To add an effect that makes text or an object move in a specified pattern,
point to Motion Paths, and then click a path.

1. To specify how the effect is applied to your text or object, right-
click the custom animation effect in the Custom Animation list,
and then click Effect Options on the shortcut menu.

2. Do one of the following:

 To specify settings for text, on the Effect, Timing, and Text Animation
tabs, click the options that you want to use to animate the text.

 To specify settings for an object, on the Effect and Timing tabs, click the
options that you want to use to animate the object.

4.2  Inserting Sounds and Movies 

A PowerPoint Presentation can include sound files to be used as 
background music or as a single-event sound clip. 

To insert a sound in a slide: 

1. On the menu panel go to Insert and choose the Sound pull-down menu.

2. From this menu you can choose to insert from a file, from the clip
organizer, play from CD, or record your own sound, (Figure 3).

3. After the sound has been selected, a message will appear. This message
will ask if you want the sound to play automatically or after a mouse
click.

4. When the sound is placed in the slide, a sound icon will appear.CCC-1.1/144



Figure 4-2 Insert Sound 

To insert a movie clip: 

1. On the menu panel go to Insert and choose the Movie pull-down menu.

2. From this menu you can choose to insert a movie from the gallery, or to
open a movie from a specific file.

3. A message will appear and ask if you want the movie to play
automatically or after a mouse click.

Check your progress
Q1. How to apply a built-in animation effect to text or an object 

Q2. How to insert a sound in a slide 

4.3  Other Packages 

4.3.1  DTP Software 

Desktop publishing is the use of the computer and specialized 
software to create documents for desktop or commercial printing. Those 
specialized programs are primarily page layout software, but can also 
include word processing, graphics software, and creative printing or home 
publishing software. 

4.3.1.1 MS-Publisher 
Microsoft Publisher is a desktop publishing application that allows 

you to create and fine-tune publications from a variety of templates or 
blank publications. 

You can create many different types of publications including 
items such as promotional flyers, company brochures, garage sale flyers, 
business cards, school newsletters, and more. 
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Publisher has many types of templates available for you to use. 
These include Quick Publications, Advertisements, Brochures, Flyers, 
Greeting Cards, and so much more. You can click on each of these 
headings to display subheadings with additional templates. 

Figure 4-3 Sample Publication 

Starting a Publication 

When you open Microsoft Office Publisher 2007, you will first see a 
screen that looks like this: 

Figure 4-4 Starting Publication CCC-1.1/146



To start your document: 

Click on the Publication Type you want from either the Publication Types 
(1) listed on the left or from the Popular Publication Types (2) listed in the 
center. After you click, you will be taken to a screen that lets you choose 
from several pre-designed templates for the publication type you want to 
work on. 

For example, the customization page for Newsletters looks like this: 

Figure 4-5 Customization Page 

a. Customization options will appear on the right side of the screen.
(Each publication type may have different customization options.) 
Examples as shown above include:  

1. Color scheme.

2. Font scheme.

3. Business information (you can upload and store your company/personal
logo and colors).

4. the page size

b. After you select your options, click on Create (5).
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 Your publication will open in a screen similar to the one shown below. 

Figure 4-6 

Figure 4-7 

4.3.1.2 Adobe PageMaker 
Introduction 

PageMaker is a desktop publishing program. It is used to create documents 
with a complex layout of text and graphics, such as brochures, pamphlets, 
newsletters, fliers, reports etc. It offers certain functionalities of a graphics 
program, and is therefore more suited to organizing pages compared to a 
word processing program (especially when including graphic images in 
the document). 

This handout walks you through creating a report containing graphic 
images in PageMaker. CCC-1.1/148



To open PageMaker in the Open Access Labs go to: 

Start  Progr ams  Applications  Graph 

How to Create a New Document 

Upon starting PageMaker you will see a screen offering you a variety of 
initial choices of templates upon which to base your publication. In our 
case, we will start with a blank presentation. After becoming familiar with 
PageMaker we can always choose one of the templates to create our 
publication. Close the templates-options screen by clicking on the Close 
button located on the top right corner of the screen. 

Go to: File  New. A dialogue box showing th
to Figure 4-15 will appear. Here we can specify the page dimensions, 
orientation, margins, number of the pages etc. Set the inside margin to “1”, 
all other margins to “.75” and the page size to “Letter”. 

Figure 4-8 Document Setup 

When done, click OK. We can return to this window by clicking on: File 
 Document Setup, and change or modify any of the settings at a later
stage. We now have a new document open in PageMaker. The top and 
bottom boundaries of the page are indicated by pink lines and the left and 
right boundaries of the page are indicated by blue lines. We must be 
careful to remain within these boundaries at all times, i.e. we must place 
our graphics and text within these margins. 

The Different Windows in PageMaker 

A number of windows are open in the default PageMaker window. Figure 
4-16 shows them with their names. We will touch upon them briefly as all 
these windows provide us with important tools. 
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Figure 4-9 Window Page maker 

1. Tools Palette: this window displays tools that are used for drawing,
entering and editing text, selecting and dragging objects on the page and
zooming in and out of the page. We have to click on a particular tool
icon to select that tool.

2. PageMaker Tools Window: this window can also appear as a shelf on the
top of the main PageMaker window as shown in Figure 4-16. It displays
additional PageMaker tools as convenient icons.

3. Control Palette: this window is used for making precise changes to text
and graphics.

4. Styles and Colors Palette: this window displays the predefined paragraph
styles and colors.

5. Plug-in Palettes, e.g. Picture Palette: this window contains the links to
readymade graphic images that can be inserted into the document.

We can minimize these windows at any time if the screen gets too
cluttered. They can be maximized selectively for a less cluttered
screen and more efficient work.

How to Work with Text 

Text can be inserted into PageMaker documents in numerous ways. One 
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created in other word -processing applications such as Word, Word-
Perfect etc. or copying and pasting text from other sources on the 
computer. For creating the caption of our report we will type it directly in 
PageMaker instead of importing it from elsewhere. 

1. Select the Text tool from the Tools Palette and click it anywhere on the
page to establish an insertion point. A blinking cursor appears and we
can now type in the caption. The typed text may appear too big or too
small for the cover page depending on the text settings. We can change
the size, face, spacing and style etc. of the font by changing the options
in the Control Palette.

2. We can also change the font by going to Type  Font. 

3. We can change the font size by going to Type  Size. 

4. We can change the font style by going to Type  Type Style. Check out
all the other options available under Type for playing around with the
look of the text and getting the desired look.

5. To change the color of the text, select the text and click on the color of
your choice in the Colors Window. We can have the text in different tints
of the chosen color, too. To do this, select the part of the text you want in
a different tint and go to the drop-down box that says Tint in the Colors
Palette. Choose a tint of, say, 40% of the original color. We will notice
the tint of the chosen text lightens considerably. In Figure 4-20, the text
has two different colors and two different tints for the blue color.

Figure 4-10 

4.3.1.3 CorelDraw 
Corel Draw is a PC-based graphic design vector drawing program. You 
can use Corel Draw to tackle a wide variety of projects - from Illustration 
and logo creation to Web graphics or multi-page marketing brochures, or 
eye-catching signs. You can also Draw shapes, work with text, add color 
and effects, Corel Draw is a very flexible vector and graphic package. 

You can do many things in Corel Draw. You can create basic shapes and 
lines to complex ones which are used to create vector illustrations, logos, CCC-1.1/151



clipart, etc. You can also import images and trace them to form vectored 
files. When a file is vectored you can also print it on a laser cutter out of 
card, wood, or plastic (note: you cannot do this with an image). 

What are vectors? 

There are two basic types of graphic files: Images and Vectors. Images are 
constructed from a series of pixels, or tiny squares. Each pixel contains a 
unique color and together they make up the image. Vector images 
however have no pixels. They are displayed or printed by using 
mathematical positioning. A vector image breaks down into a 
mathematical formula and contains messages like, draw a rectangle, this 
size and at this place on the page. A vector image looks like an illustration. 

Vector files are usually considerably smaller than a image files of the 
same image, since there is less information required to achieve the same 
results. Images however lose quality if they are scaled to a larger size. 
Basically when blown up the pixels just get bigger. With vector images 
things are different the vector contains mathematical points that map the 
shapes of the vectors. So vectors have no quality loss and no file size 
increase.  

Note: you will rarely see an image used as a logo as when they are blown 
up they lose quality, most logos are vector drawings. 

What do the tools do? 

Take a look at the screenshots below to get an overview of some of the 
basic tools. Remember if you don’t know what a tool is rollover it and a 
small tag will appear saying what the tool does! 
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Figure 4-12 

4.3.1.4 Adobe Photoshop 
This lesson is a brief introduction to Photoshop, I will not cover all the 
topics but I will cover enough of them to teach you how to edit (resize, 
crop, merge) images yourself without asking somebody else. 

Adobe Photoshop is probably the single image editing program that you 
need. It is a very comprehensive software, it can meet almost all your 
needs and solve almost all your problems that you face with the images. 
You have been hearing about Photoshop all these while, everyday more 
and more. So here is your chance to get your hands on Photoshop. If you 
don’t have the software buy one, or download the trial but fully functional 
version at Adobe.com. Let’s get started! 

Tools and Options Panel 

Open your Photoshop. If you don’t see Tools Toolbar already then go to 
Window > Tools. 

Below is the screenshot of the Tools panel. If the tool has a small triangle 
at the bottom corner it means it has more than one tools. To see these 
options just click on the tool and hold your mouse for a few seconds, and 
you will see the options on the popup window as shown below. 
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Let’s go through one tool from each group and their functions. The letters 
inside the brackets are the shortcuts for the particular tool, when you are in 
Photoshop and press V for example it would select the Move Tool. 

Move Tool (V): Is used to select and move 
images (objects) on any active layer. 

Rectangular Marquee Tool (M): It is used for 
making selection on the image (objects) on any 
active layer. 

Magic Wand Tool (W): Used for making selection 
(similar colors at once for example) 

Polygonal Lasso Tool (L): Used for making 
free selection as you go 

Slice Select Tool (K): Used for selecting slices 

Crop Tool (C): Used for cropping images 

Patch Tool (J): Used for correcting images 

Brush Tool (B): Used for drawing freehand 

History Brush Tool (Y): Used for restoring 
specified history state 

Clone Stamp Tool (S): Used for selecting a source 
and copying (drawing) it in another place 

Gradient Tool (G): Used for making 
gradient effect on images 

Eraser Tool (E): You are right, this tool is used 
for erasing  

Dodge Tool (O): Used for making images 
lighter (And Burn tool makes the opposite – 
darker) 
Horizontal Type Tool (T): Yes used for inserting 
text to image 

Path Selection Tool (A): Used for selecting the 
active path 

Custom Shape Tool (U): Used to insert pre-
specified (ready) shapes to image 
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Pen Tool (P): Used for creating vector shapes 

Eyedropper Tool (I): Used for selecting color 

Notes Tool (N): Used for inserting notes on 
the image 

Zoom Tool (Z): Yes used for zooming in or out 

Hand Tool (H): Used for dragging image 
when you are in the zoom in state 

Options Panel 

As you see below from the screenshot below, Options Panel is highlighted 
with light-red. Whenever you switch from one tool to another, Options 
Panel will change accordingly. Currently as you can see Brush Tool is 
selected in the Tools panel, and in theOptions Panel you can see the 
properties of the Brush Tool, namely : Brush Size (Type), Mode, Opacity 
and Flow. 

Just remember to look up to the Options Panel when you choose a 
particular tool, because sometimes if something is selected or unselected 
in the Options Panel, you might not be able to use that particular tool 
properly. For example Opacity of the color might be set to “Zero” in the 
Options Panel, in that case anything that you draw would not show up 
since 0 means invisible. 

Figure 4-14 

Working with Images 

Cropping 

Download this image or open any image in your Photoshop. Select the 
Crop Tool (Press ‘C’ to Select or Select it with your Mouse)and draw a 
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selection on your image as shown below. (To make a selection click and 
drag with your mouse) 

Make a selection After you made 
your selection press 

Enter 

Result 

Make a selection After you made your 
selection press Enter Result 

Figure 4-15 

Cropping images is actually that easy in Photoshop, just select the area 
you want to keep and press Enter on your keyboard, and you are done. 
You can also press on the Move Tool instead of pressing Enter on your 
keyboard, it will prompt you a window similar to the one shown below. If 
you are satisfied with your selection just press on the Crop button and 
your image will be cropped. 

Figure 4-16 

Working with Texts 

Open a new window Ctrl + N (choose a bigger dimensions for the 
window; width 400 and height 300) and press OK 

Select the Horizontal Type Tool (T) and click on the window that you just 
opened and type something. 
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Figure 4-17 

If you want to make changes to your text, highlight it and change the 
properties from Options Panel 

Figure 4-18 

After you are done making changes click on the Move Tool (V) and by 
clicking on your text position it on the top left corner of the window. 

Note: When working with Texts it’s important to click on Move Tool (V) 
after you are done typing. Many newbies make this mistake of not clicking 
on Move Tool or on any other tool than the Text Tool and are literally 
stuck in the Photoshop. 

To move your text from one place to another choose the Move Tool and 
just click on your text with your mouse and without releasing your mouse 
move the text to the desired place. 

There is another way to change the properties of the Text, in addition to 
the Options Panel we have discussed and that is by usingCharacter Panel. 
If you don’t see the Character Panel go to Windows > Character to bring 
up the Character Panel. 

Below is the Character Panel screenshot, if you change any of the 
properties in this window it will be reflected on your text. However for it 
to be effective you need to be on the correct layer, otherwise you will not 
see any changes on the text. Layers will be our next discussion. 
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Figure 4-19 

Working with Layers 

Photoshop uses “Layers” for managing multiple (separate) objects in the 
same file, to open your Layers Panel go to Window > Layers. If you have 
used other image editing programs that use the same “Layers” concept. 
Then this should be familiar to you. If you haven’t then it’s an easy 
concept to understand, just think of the Layers as a “Stack of Books” on 
the floor, and imagine yourself as looking at this stack of books from top. 

Firstly, when you look at this stack from top, you will be able to see the 
cover of the first book which is on top of all the other books without a 
problem, however when you try to see the cover of the second book that is 
below the first book, you will notice that most of it are not visible to you. 
Because it’s being blocked by the first book. And when you look at the 
third book’s cover it will be even more hidden from your eyes. So think of 
Layers in Photoshop as a Stack of Books, one layer representing one book 
or level in the stack. 

 Layer that is on top 

Figure 4-20 

As you can see from the image above, the blue circle is located on the Top 
Layer, I have named the Layer as “Circle”, and red rectangle is on second CCC-1.1/158



layer, I have named this layer as “Rectangle”. As we have discussed 
earlier, book that is on top of the stack will cover the layers below. Thus 
you see the Circle covering Rectangle. And our background is a white 
color which is visible from the sides of the circle and rectangle. 

Changing layer positions 

Here I have moved Red Rectangle to Top, as you see now Red Rectangle 
is on top and it covers the Circle. To move the particular layer just click on 
it with your mouse and while still holding your mouse move it up or 
down. Or you can click on the Layer that you want to move and use 
shortcut keys on your keyboard to move it up (Ctrl+]) and down (Ctrl=[). 

What is Active Layer? 

Active layer is the layer which you are working on, for example from the 
image below we can see that the Active Layer is the Rectangle Layer – 
active layer will always be highlighted (selected). 

Note: And if you want to move particular object you should select it’s 
respective layer first, then only you can move it. Otherwise you will end 
up moving something else. 

The “Eye” icon on the left of the layers means that the layers are currently 
visible, if you toggle them off then the object will also disappear (will 
become invisible) from our window. 

Figure 4-21 

As you can see from the screenshot above, I have deselected/removed the 
eye icon from the layer Rectangle. We still can see the rectangle in the 
Layers Panel but it is not visible on our image – we can only see the blue 
circle. 

6.0 Saving for Web (as JPG or GIF) 

After you have completed your work I believe you would want to save it 
as .jpg or .gif (or any other format that Photoshop supports) 

To save your image for web go to File > Save for Web or press 
Alt+Shift+Ctrl+S and you will see an identical window like this one 
below. 
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Figure 4-22 

From here you can change the image type to JPG, GIF, PNG and WBMP. 
You can change the quality of the image as well, the higher the quality the 
bigger the size will be. 

Check your progress
Q1. Define MS-Publisher. How to start a publication? 

Q2. How to create a new document in Adobe PageMaker 

Q3. What are vectors in Corel draw? 

Q4. How we use Images in Adobe Photoshop? 

4.4  Summary
In this unit you learnt about Inserting Animated Pictures or Accessing 
through Object, Inserting Recorded Sound Effect or In-Built Sound Effect. 
We also learnt about other packages like DTP software, Brief survey of 
MS Publisher, PageMaker, CorelDraw, and Adobe Photoshop 

 You can make text grow or shrink, spin or shimmer.

 You create custom animations in the Custom Animation task pane.

 The Custom Animation task pane shows important information about an
animation effect, including the type of effect, the order of multiple
effects in relation to each other, and a portion of the text of the effect.CCC-1.1/160



 Many types of objects can be included in PowerPoint presentations,
including Bitmap images, Flash movies, Microsoft Excel spreadsheets,
Microsoft Word documents, and a variety of media clips.

 A PowerPoint Presentation can include sound files to be used as
background music or as a single-event sound clip.

4.5 Review Questions
Q1.  Write all the steps of inserting pictures in your slide with example. 

Q2.  We can use recorded sound in the presentation. Elaborate your 
answer. 

Q3.  What are DTP packages? Why we use DTP software? List all DTP 
software. 

Q4.  What is Adobe PageMaker? Write the benefits of Adobe 
PageMaker. 

Q5.  Write a short note on- Corel Draw and Adobe Photoshop. 
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Block Introduction 
The rapid growth of Internet and the World Wide Web has made 

communication networks a part of life. Standalone computers are now a 
thing of past. Not only computers but all other digitally operable devices 
are now connected using communication networks to provide integrated 
services to the users, which is the idea behind the concept of Internet of 
Things. It is therefore, very important to learn about the fundamentals of 
computer networks, their structure, operations and applications in various 
real world scenarios. 

This block introduces you to the fundamental concepts in 
communication. The first unit discusses the basics of data communication, 
different modes of communication and communication hardware. The 
second unit is concerned with the concept of networking, the network 
models or architecture and various types of networks such as the LAN, 
WAN and MAN. The third unit is more application oriented and discusses 
various applications of networking such as the Internet, E-Mail, Electronic 
Data Interchange and a computer network developed by the government of 
India - the NICNET. This block will help you gain the basic knowledge 
about computer networks. The area of networking is ever changing and 
new developments are taking place every day. By the time, you end up 
reading this block, you will find yourself curious to learn more about what 
new changes that are taking place in the technology and how they can help 
in making your life even better with applications of computer networks. 
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UNIT-I 

FUNDAMENTALS OF DATA 
COMMUNICATION 

Structure 

1.1 Introduction 

1.2 Objectives 

1.3 Concept of Data Communication 

1.4 Data Communication Modes 

1.5 Communication Hardware 

1.6 Summary 

1.7 Review Questions 

1.1 Introduction 

Data communication deals with transmission of information 
between two ends (also known as sender and receiver) through some 
medium of communication. When there are more than two devices that 
communicate with each other, they are said to form a network. The 
information to be communicated between the devices is represented in the 
form as agreed between the sender and receiver and it is known as data. 
Further, for any successful communication, the sender and receiver must 
agree to a set of rules that must be followed while communicating; these 
are known as protocols. Thus, data communication basically involves four 
entities – data, sender, receiver, transmission medium and protocol. 

For transmitting data from one device to other, it must be 
converted into electromagnetic signals. In this unit, we shall discuss the 
two types of signals used for transmission and various modes of 
transmission of data. We shall also briefly discuss some communication 
hardware which would involve communicating devices as well as 
communication channels. 

1.2 Objective 
After learning this unit, you should be able to: 

1. Understand the basic concepts of data communication

2. Define various terminologies related to communication

3. Understand the different types of signals and their properties CCC-1.1/167



4. Understand different types of communication hardware

1.3 Concept of Data Communication 

As discussed earlier data communication involves transmission of 
information among communicating devices. The devices that 
communicate with each other are usually computers. However, for large 
networks, there may also be connecting devices in between the sending 
and receiving ends. In the following sections, we shall briefly discuss the 
fundamental characteristics of communication systems, different types of 
representation of data, the flow of data in communication and 
communication protocols. 

1.3.1 Fundamental Characteristics of Communication 
The effectiveness of a data communication system is measured by four 
fundamental characteristics: 

1. Delivery: The system must deliver the data to the correct
destination. This implies that the data must be delivered to the
intended receiver and it must be received by the intended receiver
only.

2. Accuracy: It means that the data must be received at the receiving
end exactly as it was sent by the sender. The data must not get
altered during transmission.

3. Timeliness: This is related to time bound delivery of data.
Delivery of data to the destination must not be late. This condition
is even more stringent in case of audio and video data where, the
data must be delivered in the order in which it is generated and not
with much delay.

4. Jitter: It refers to the uneven delay in the delivery of audio and
video packets. The uneven delay in receiving results into poor
quality of audio/video.

1.3.2 Representation of Data 
The data used in communication can be in the form of text, numbers, 
audio and video.  As you already know, all the data in computer is 
represented in binary form only. In other words, any type of data is 
represented as a sequence of bits. There are various techniques for 
converting each type of data into binary format. We shall briefly discuss 
the representation of each type of data: 

1. Text: The prevalent coding system to represent text today is
Unicode. Unicode uses 32-bits to represent a symbol or character.
It covers all the languages of the world. The Standard ASCII code
used in computers forms the first 127 characters of Unicode, also
referred to as Basic Latin.
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2. Numbers:  Numbers are directly converted into binary formats
using various representation schemes available for representing
numbers.

3. Images: Images are represented as a pattern of bits. First, the
image is divided into a fixed number of pixels. A pixel is a small
squared area of the image. Each pixel is then represented as a bit
pattern based on the colors in the pixel. An image could be either
colored or black and white. For black and white images, the two
colors can be represented using two bits 0 and 1 (for colors black
and white say). In practice, however more number of bits are used
where different strings of bits represent different levels of grey
scale for the image. For colored images, several methods are used.
The RGB representation uses three colors Red, Green and Blue to
generate all types of colors. Different intensities of the three colors
are represented using different bit patterns. The combination of
intensities of all the three colors represents each pixel of the image.
Another scheme used for image representation is YCM that uses
Yellow, Cyan and Magenta as the primary colors for image
representation.

4. Audio: Audio signals are generated in continuous form i.e. audio
signals are analog by nature. These signals are converted to digital
signals using some conversion scheme and used for digital
communication.

5. Video: Videos can be generated as both continuous and discrete
entities. Videos can also be converted into digital as well as analog
signals.

1.3.3 Communication Rate 
It is the speed with which data transfer takes place between the two 
communicating ends. In computer networks, the speed of transmission is 
defined in terms of bits transferred per second from one end to the other. It 
is denoted as bps (bits per second). 

1.3.4 Communication Protocols 
When two devices communicate with each other, it is not only important 
to transmit data from one device to other but the information contained in 
the data must be understood at the receiving end. This is possible when the 
communicating devices adhere to certain rules during communication. 
You can understand this as the language used for communication between 
two humans. Both must understand the language and the sentences must 
be framed according to the grammatical rules by the speaker in order for 
the information to be correctly interpreted by the listener. 

Communication protocols are the set of rules that govern the exchange of 
signals between the communicating devices. It defines the what, why and 
when of communication. A protocol has three key elements namely, 
syntax, semantics and timing. Syntax defines the structure of the data, CCC-1.1/169



semantics define the meaning of each section in the data, how it is to be 
interpreted and timing defines when the data is to be sent and at what rate. 
Usually, certain guidelines are provided to the manufacturers, vendors, 
government agencies to ensure the compatibility of different devices. 
These guidelines are also known as Standards. Standards could be de 
facto or de jure. De facto standards are those which have been adopted by 
widespread use and are not formally approved by any organization. Such 
standards are usually set by manufacturers who introduce a new product or 
technology. De jure standards on the other hand are legislated by a 
recognized standards organization. 

Some of the important standards creation committees are: 

a. International Organization for Standardization (ISO)

b. American National Standards Institute (ANSI)

c. Institute of Electrical and Electronics Engineering (IEEE)

d. Consultative Committee for International Telegraphy and
Telephony (CCITT)

Following are some of the functions that are regulated by communication 
protocols: 

a. Controlling information transfer

b. Controlling the structure and format of data

c. Error Recovery

d. Retransmission Control and

e. Interfaces Management

1.4 Communication Modes 

So far, we have discussed the basic concepts related to data 
communication. The transmission of data through a medium can take 
place according to different methods. In the following sections, we will 
discuss the different modes in which data communication can take place. 

1.4.1 Simplex, Half-Duplex and Full Duplex transmission 
Based on the direction of flow of data between two devices, the 
communication can be of three types: 

Simplex: In this type of communication, the flow of data is unidirectional. 
Here, only one of the communicating devices can send the data and the 
other can only receive. Such systems utilize the full capacity of the 
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transmission channel. Keyboard, monitor etc. are examples of devices that 
use simplex mode of transmission. 

Half-Duplex: In this mode, both the devices can both send and receive 
data but not simultaneously. If one end is transmitting the data the other 
can only receive at that time. Walkie-talkie is an example of a device 
using half-duplex transmission. It requires the devices to switch between 
send and receive modes after each transmission. This type of transmission 
is used where there is no need of simultaneous communication between 
two ends and therefore, full capacity of the channel is utilized for 
unidirectional transmission. 

Full-Duplex: In this mode, both the ends can send and receive data 
simultaneously. Telephone is a common example of this type of 
transmission. 

 

Fig. 1.1: Simplex, Half-duplex and Full duplex transmission 

1.4.2 Parallel and Serial Transmission 
The transmission of data can be done either in parallel or serially in the 
channel. 

Simplex Transmission 

Half-Duplex Transmission 

Full Duplex Transmission 

Direction of data flow 

Flow of data at time 1 

Flow of data at time 2 

Flow of data at all times 

A B 

A B 

A B 

A B 
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In Parallel Transmission, the data bits are first grouped into a set of say n 
bits and then they are sent simultaneously using n transmission lines as 
shown in Fig. 1.2. Parallel transmission increases the speed of 
communication but it also results in high cost of communication. It is 
mostly used for short distance communication. 

Serial Transmission, on the other hand uses a single channel for 
transmission. Here, the bits of data are serially transmitted using the single 
transmission channel as shown in Fig. 1.3. As you know, the 
communication within devices is parallel; therefore, serial transmission 
requires converters at both the ends. The sender uses a parallel to serial 
converter to send the data bits while the receiver uses serial to parallel 
converter for receiving the signal from channel.  

Fig. 1.2: Parallel transmission between two devices 

Fig. 1.3: Figure showing serial transmission between two devices 
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1.4.3 Synchronous, Asynchronous and Isochronous 
Transmission 

Serial transmission can be done in one of the following three ways: 

Asynchronous Transmission: In this method, the timing of the signals is 
not important. The communication is done using agreed patterns and the 
receiver can interpret the signals until those patterns are followed.  

In asynchronous transmission, the data is sent in group of bits. Each unit 
of data received at the receiver is treated independently of the others. 
Since, there is no synchronization in the data units; the receiver cannot use 
timing to predict the coming of the next group of data. Therefore, start and 
stop bits are used to let the receiver know the beginning and end of a 
group. Usually a byte of data is sent with a 0 as start bit and a trailing 1 as 
stop bit. Thus, each byte of data consists of 10 bits of which 8 bits are 
information and 2 or more bits are signals for the receiver. 

Synchronous Transmission: Here, the bit streams are combined to form 
longer data units also known as frames. Each frame may contain one or 
more bytes. The bytes of data are not separated by start and stop bits. 
Thus, there is no mechanism for the receiver for bit synchronization. 
Timing is therefore, very important in this case. It should however be 
noted that although there is no gap between the bits in a frame, there may 
be uneven gap between each data frame. 

The advantage of synchronous transmission over the asynchronous 
method is the increase in speed of transmission. Since, there are no extra 
bits transmitted in synchronous transmission, it increases the speed of 
transmission. This mode of transmission is particularly useful for high-
speed applications.  

Isochronous Transmission: For real-time applications such as streaming 
audio and video data, just synchronization is not enough. For example, TV 
images are broadcast at a fixed rate of 30 images per second and should be 
received in the same order. Suppose, each image runs over more than one 
frame then, there should not be delays between each frame. For such 
applications, isochronous transmission is used that guarantees that the data 
arrive at a fixed rate. 

1.5 Communication Hardware 

In this section we will discuss about the devices used for communication 
and also discuss various types of transmission channels and their 
properties. 

1.5.1 Communication Devices 
There are different types of devices used for communication between two 
nodes on a network. The nodes could be any device such as a PC, a 
mainframe computer, printer etc. The most common networking devices 
that you can come across for connecting a computer to a network are: CCC-1.1/173



a. Modem

b. Network Card

c. Wi-Fi devices (or Wi-Fi router)

d. Bluetooth devices

e. Infrared devices

a. Modem: the abbreviation for Modulator/ Demodulator; modem is
a device that is used to communicate through a computer over a
telephone line. It allows communication by converting the digital
signals from the computer to analog signal which is transmitted
over the telephone line and vice-versa.

b. Network Card: The Network Interface Card (NIC) allows a
computer to connect to a network using Ethernet cable and RJ-45
connector.

c. Wi-Fi devices: Wireless Fidelity devices are used for wirelessly
connecting various devices. It is based on the 802.11 standards for
wireless connection.  It is also used in the home wireless networks
to connect to the Internet.

d. Bluetooth Devices:  Bluetooth devices are used for short range
communications. It utilizes Radio frequency at 2.4 GHz and is
effective in a range of 10 meters. Bluetooth devices can provide
data transfer rates of about 1Mbps.

e. Infrared Devices: Infrared devices utilize the infrared radiations
for communication. We will discuss about infra red and its
properties in the next section.

1.5.2 Transmission Media 

A transmission channel or transmission medium can be defined as any 
medium that carries the signals from the sender to the receiver. The 
transmission medium could be wired or wireless. The wired transmission 
media are known as guided media and the wireless transmission media 
are known as unguided media. We will now discuss different types of 
guided and unguided media. 

Guided Media 

a  Twisted Pair Cable: Twisted pair cables are made up of two 
copper wires each of which are coated with a plastic for insulation. 
The two insulated wires are then twisted over each other to make 
cable. In twisted pair cables only one of the two wires carries CCC-1.1/174



signal and the other wire is used for grounding purpose. The 
receiver obtains the original signal by calculating the difference 
between the values of two wires. The two wires are twisted so as to 
reduce the effect of noise in the signal (see Fig 1.4). Practically, 
there are many variations of twisted pair cables which are used in 
Local Area Networks (LANs). 

Fig. 1.4: Twisted Pair Cable 

b. Coaxial Cable: Coaxial cable does not contain two separate wires.
It has one inner core made up of a metal such as copper which
carries the signal. This inner core is covered by an insulating
sheath which is again covered by another metallic foil which acts
both as a shield against noise and as a conductor to complete the
circuit.  The outer conductor is also covered by an insulator. This
whole system is then covered by an outer plastic cover (see Fig.
1.5). Due to its construction, the coaxial cable can carry signals of
higher frequency range as compared to twisted pair cable

Fig. 1.5: Co-axial cable1 

c. Fiber Optic Cable: Optical fiber cables are made up of glass or
plastic and are used for transmitting signals in the form of light.
Optical fibers are based on the concept of reflection of light. The
inner core which is made up of glass or plastic is surrounded by a
cladding which is made up of a less dense material (glass or
plastic). The refractive index of the outer cladding is such that
when the light passes through the inner core it gets totally
internally reflected upon striking the cladding (Fig. 1.6). Optical
fiber cables offer much bigger bandwidth as compared to coaxial
cables and twisted-pair cables. Also, the attenuation (loss in signal
strength during transmission) in fiber optic cables is almost 10 CCC-1.1/175



times lower than the twisted-pair and coaxial cables. Fiber optic 
cables are used in backbone networks and high-speed networks. 
Like twisted-pair and coaxial cables, optic fiber cables also come 
in a number of varieties. 

Fig. 1.6: Optic Fiber 

Unguided Media 

Unguided media are those which do not use a physical medium for 
transmission of signal. These are also known as wireless transmission 
media. Unguided media use electromagnetic signal for transmission. 
Wireless transmission is usually performed using radio waves, micro 
waves and infrared waves. The three types of waves are distinguished 
based on their frequency ranges. However, the general distinction between 
radio and microwaves is based on the behavior of the waves rather than 
the frequency range. The radio wave is omnidirectional for most part of its 
spectrum while micro-waves are unidirectional and use line of sight 
propagation. We will discuss the properties of these waves in detail now. 

a. Radio Wave: These are omnidirectional i.e. they can propagate in
all directions. Their frequency lies between 3KHz and 1GHz.
Because of their omnidirectional nature and the ability to
penetrate through walls, radio waves are generally used for long
distance multi-cast propagation such as TV signals and cell phone
communications. Radio wave transmission can be done in three
different ways based on the frequency of the wave used. For low
frequency range radio waves (3-300 KHz) ground propagation
is used. Here, the signal travels through the lowest portion of the
atmosphere. The distance travelled by the signal depends on
signal strength, the higher the strength the longer the distance
travelled. These are mainly used for navigation purposes. Middle
to high range frequencies (300 KHz-300 MHz) are propagated
using sky mode. In the sky mode of transmission, the travellingCCC-1.1/176



signal is reflected from the ionosphere and received by the 
receiver antenna. Sky communication is mainly used for radio, 
TV, aircraft communication etc. Very high to ultra high frequency 
radio waves (above 30 MHz) use line of sight propagation. In this 
method, the signals travel uni-directionally. The receiver antenna 
must be aligned with the sender to receive the signal. This is used 
in satellite, radar and cell phone communications. For radio 
frequencies the data transfer rate is in the range of 100 to 400 
Kbps. The frequency ranges between 30-300 MHz can be 
propagated using both line of sight and sky mode of propagation. 

b. Micro Wave: Microwaves (300MHz-300GHz) are unidirectional
and therefore always use line of sight propagation. For line of
sight communication, the sender and receiver antenna must be
kept at a large height so that they are not affected by the curvature
of earth and any other obstacle during communication. The signal
also needs to be amplified after certain distance. Very high
frequency micro-waves cannot penetrate walls. Micro-waves
however, give higher data transfer rates of about 1000 Mbps.
They are used in satellite communication, cell phones and
wireless LANs.

c. Infrared Wave: Infrared frequencies range between 300 GHz
and 400 THz. Infrared waves cannot penetrate walls and
therefore, they are used for short range communications. TV
remote control is an example of a device that uses infrared waves.
Nowadays, infrared keyboards and mouse are also being used.
Some manufacturers provide a special infrared port (IrDA) in the
computers in order to allow them to communicate with wireless
mouse and keyboard.

1.6 Summary 

In this unit, we have discussed the important concepts of data 
communication. We discussed four fundamental characteristics of an 
effective communication viz., delivery, accuracy, timeliness and jitter. We 
then discussed the representation of data in a computer. We also discussed 
communication rate that defines the speed with which data is transmitted 
through a channel. We also described the meaning of communication 
protocols and some of the agencies that set communication standards. We 
then discussed different classifications of communication modes. We also 
discussed communication hardware where we gave a brief introduction to 
different types of communication devices and discussed about various 
types of transmission channels and their properties. CCC-1.1/177



1.7 Review Questions 

1. Match the following:

a. Modem i. omnidirectional

b. Protocols ii. Speed of transmission

c. Communication Rate iii. Line of Sight

communication

d. Radio Wave iv. Signal conversion

e. Micro Wave v. Set of Rules

2. Discuss the properties of infrared waves. What are its applications
in communication?

3. Discuss the construction of any two types of guided media.

4. What do you understand by Jitter? What type of transmission
method can ensure jitter free transmission of data and why?
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UNIT-II 

COMPUTER NETWORKS 

Structure 

2.1 Introduction 

2.2 Objectives 

2.3 Network Concept and Classification 

2.4 Communication Architecture 

2.5 Local Area Networks (LAN) 

2.6 Wide Area Networks (WAN) 

2.7 Metropolitan Area Networks (MAN) 

2.8 Summary 

2.9 Review Questions 

2.1    Introduction 

Nowadays, computer networks form the backbone of most of the 
organizations. They allow computers and devices to connect to each other 
not only within the organization but also to the outside world. Computer 
networks also allow resource sharing among the remote devices and thus 
help in providing high computational power at reduced price. In this unit, 
we shall discuss different types of computer networks and their structures. 
We will also discuss about the interconnection of networks and 
interconnecting devices. 

2.2   Objectives 

After learning this unit you should be able to: 

1. Define computer networks

2. Describe LAN, WAN and MAN

3. Understand the difference between the above networks and their
characteristics

4. Describe communication architecture

5. Describe interconnecting devices for networks
CCC-1.1/179



2.3    Network Concept and Classification 

A computer network is a collection of computers and/or other 
digital devices (nodes) connected together through a communication 
channel (wired or unwired) and governed by a set of protocols. Each node 
on the network is identified by an address. An address can be understood 
as analogous to telephone numbers in a telephone network. Network 
architecture refers to the design of a computer network. It consists of both 
hardware and software, connection between the nodes and communication 
protocols. There are two common types of network architectures: 
Hierarchical Networks and Peer Networks. In Hierarchical networking, 
there is one node known as the master and rest all the nodes in the network 
are called slaves. The network is entirely controlled by the master who 
assigns addresses to the nodes in the network. Any resource that has to 
participate in the network must be known to the master beforehand. In 
case of peer networking however, all the nodes are considered equal and 
pre-defined network addressing is not required. Each node in the network 
is a peer to all other nodes. Whenever a new node joins the network, it 
introduces itself to its peers and also informs of any other resources in the 
network that it knows about. Such networks are open and share network 
information. Computer networks can be divided into two broad categories: 
Local Area Networks and Wide Area Networks. Another type of network 
that lies between these two is the Metropolitan Area Network. We shall 
discuss about all these types of networks in following sections. But before 
that we shall discuss communication architecture and also discuss the OSI 
reference model. 

2.4 Communication Architecture 

Data communication among two devices through a network is a 
complex task. At the lowest level it involves just the transfer of signal 
from one device to the other. But there are other factors that are involved 
in this process. For example, the message needs to be correctly received at 
the receiver, if there are any errors, either they should be corrected or a 
request for retransmission must be made, the message must be 
interpretable at the receiving end, for long distance communication large 
messages are usually broken into smaller ones, at the receiving end these 
smaller messages must be combined properly to regenerate the original 
message. All these tasks cannot be accomplished by just hardware as it 
would make the system highly complex and unmanageable. Therefore, the 
communication system is a combination of hardware as well as software.  

Further, in order to reduce complexity, it is important to divide 
these tasks so that separate software can handle their part with scope for CCC-1.1/180



interaction among them whenever required. This is even more important 
when information travels from one network to the other as both the 
networks might not be using same architecture. In order to simplify 
network communication, the task of communication is divided into a 
number of layers. Each layer has its own functions independent of others 
and each layer interacts with layers just above and below it. This type of 
communication architecture is known as Layered Architecture.  The 
oldest layered model was proposed by the International Organization for 
Standardization (ISO) and is known as the Open System Interconnection 
(OSI) model. Later the TCP/IP protocol suite was proposed which became 
the dominant commercial architecture of the Internet. In this section, we 
shall briefly discuss the OSI model. It should be noted here, that OSI is a 
model and not a protocol. The OSI model consists of seven layers. The 
first layer is the physical layer which is mostly hardware. The second and 
third layers are data link layer and network layer that are a combination of 
hardware and software. The next three layers are session layer, 
presentation layer and application layer that are totally software based. 
Each layer in a device interact with the layers above and below it while for 
two different devices each layer interacts with the corresponding layer on 
the other device. This is known as peer-to-peer communication. We will 
now briefly discuss the functionality of each layer. 

Physical Layer : This is the first layer of the OSI model and it is 
responsible for transmission of bits over a medium in the form of signals. 
It also defines mechanical and electrical specifications for physical 
transmission. 

Data Link Layer : This layer is responsible for hop-to-hop delivery of the 
message. It organizes bits into frames and detects errors that may occur in 
the physical layer. 

Network Layer : It moves packets from source to destination. It provides 
inter-networking services and routing across multiple networks. 

Transport Layer : This layer is responsible for reliable process-to-
process delivery of message and error recovery. Since, up to this point the 
message is already delivered to the destination system; all the 
functionalities provided by transport layer and layers above it are based on 
software only and no hardware is used. 

Session Layer : This layer manages the session in communication. It is 
responsible for establishing and terminating sessions. It provides dialog 
control and synchronization. 

Presentation Layer : It is responsible for presentation of information to 
the application program. It provides facilities such as data conversion and 
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code translation (e.g. ASCIII to EBCDIC). It also provides encryption and 
compression of data. 

Application Layer : It is responsible for providing services to the end 
user. It enables end users to access network resources. 

2.5    Local Area Network (LAN) 

A LAN is a network that typically connects devices in a single 
building, office or campus. It is usually privately owned and designed to 
allow resource sharing between personal computers and workstations. The 
resources could be hardware (e.g. printer etc.), software (e.g. application 
programs) or data. LANs are normally limited to the area of a few 
kilometers. Since, the LAN is owned by a single organization or entity; it 
has several advantages over other types of networks. Some of them are 
listed here: 

1. Transmission media is shared by all the devices on the network.

2. Device incompatibility and large speed differences among the
devices are not present.

3. High data transfer rates can be achieved

4. Congestion and flow control are not serious issues.

5. Malicious traffic can be easily controlled using gateway-level
filtering

Besides size, LANs are also distinguished based on transmission
media and topology. 

2.5.1 LAN Topology 

Network topology refers to the physical arrangement of nodes in the 
network. Different topologies can be used to construct a network. The 
most common topologies used for constructing LANs are: 

a. Star

b. Bus

c. Ring

Star Topology: In star topology, there is a single node which acts as a hub 
and all the devices in the network have a direct connection only to the hub. 
None of the nodes are directly connected to each other. Star topology is 
less expensive as only one link needs to be made per node. This also 
makes it easy to install and maintain. Also, failure of a node does not 
affect other nodes in the network. However, the star topology has one big CCC-1.1/182



disadvantage. If the hub fails, the entire system is dead. The pictorial 
representation of a star topology is given in Fig 2.1. 

   

Fig. 2.1: Star topology 

Bus Topology : The star topology is an example of point to point 
topology. Bus topology on the other hand is multipoint. In bus topology, a 
long cable is used that acts as the backbone of the network. All the devices 
are connected to the cable by drop lines and taps. Data that originates from 
a station goes to both the directions from the bus. Each station on the bus 
receives the data and matches its address field. If the destination address is 
not same as the node’s address, the data is discarded and sent back to the 
bus otherwise the data is accepted. Bus topology is efficient in terms of the 
length of wire required to connect the nodes and is also easy to install. 
Addition of nodes in the bus however causes problems. Also, if a fault 
occurs in the bus, the entire system will fail. An example of bus topology 
is shown in Fig 2.2. 

Fig. 2.2: Bus topology 

Ring Topology: In a ring topology, each node is connected only to two of 
its adjacent nodes. The structure of the network is in the form of a logical 
ring. Signal in the ring travels only in a single direction station to station 
until it reaches the destination node. A station upon receiving a signal not 
intended for it, regenerates the signal using repeaters and sends it to the 
next station and this process continues until the signal reaches its 
destination. In ring topology, fault finding is relatively easier. Generally, a 
signal keeps circulating all the time in the ring. If a station does not 
receive a signal within a specified time period, it can issue an alarm. The 
alarm can inform the network operator about an issue in the network and 
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its location. Ring topology also suffers from the same problem as the 
previous two. The failure of a station in the ring disrupts the 
communication because the signal is not regenerated. Ring topology is 
shown in Fig 2.3. 

Fig. 2.3: Ring topology 

2.5.2 LAN Software/ Operating System 
Servers: For providing storage and resource sharing a LAN uses a 
dedicated computer that controls the resources. This computer is known as 
the server. It contains both the hardware and software interface for the 
LAN. The most commonly used LAN servers are: 

a. File Server

b. Printer Server

c. Modem Server

A file server is a computer that is used to share storage space for files. 
Apart from this, it is also used for providing periodical backup and as a 
gateway for other servers within or between LANs. A printer server is 
used for sharing the printer resources and handles printing related tasks of 
all the workstations connected to the LAN. The modem server is used for 
connecting the workstations within the LAN to outside networks such as 
the Internet. 

LAN operating systems or network operating systems are the systems that 
are primarily designed to support networking tasks such as providing file 
sharing and printer access to multiple workstations connected to a LAN. 
Such operating systems provide multi-user and multi-tasking facilities. 
They also include specialized network devices such as router, switch and 
firewall. Some examples of network operating systems are: Novell 
Netware, IBM LAN Server, and Novell SIT Netware. Some multi-purpose 
operating systems such as Windows NT and OpenVMS also have 
networking capabilities integrated into the system. 
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2.6 Wide Area Network (WAN) 
A Wide Area Network (WAN) is a communication network that 

covers a large geographical area such as a country or a continent. The 
largest WAN in the world is the Internet which connects the whole world. 
A WAN is usually constructed by connecting various smaller networks 
such as LANs through routers. Although, the simplest architecture of the 
WAN could be a dial-up line that connects a personal computer in home to 
the Internet. Such type of WAN is known as a point-to-point WAN. The 
type of WAN that connects multiple smaller networks through routers to 
form a single larger network is known as the switched WAN. Point-to-
point WAN is mostly constructed using a leased-line obtained from a 
service provider such as a telephone or Cable TV network provider that 
connects a home computer to the Internet Service Provider (ISP). 

2.6.1 Switching 
For larger networks, connecting each device on the network to every other 
device or to a hub like structure (like in mesh and star topologies 
respectively) is not particularly feasible. It requires large amount of cables 
for connection which increases the cost of setup. Further, large part of the 
channel remains idle for most of the time. The possibility of using a bus 
topology is also ruled out because of large distance between devices and 
the possible existence of more number of devices than the capacity of the 
channel. The better solution in such cases is to use switching. Switches 
are devices that are capable of creating a temporary connection between 
two nodes in the network. A switched network consists of a series of 
interconnecting switches. An example of a switched network is shown in 
Fig. 2.4. 

There are three types of switching techniques that are used in networking. 
These are circuit switching, packet switching and message-switching. Out 
of these, the first two are more commonly used while the third one has 
been phased out, though it has some application in networking. 

Fig 2.4: Example of a switched network 
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Circuit Switching : In circuit-switching, switches are connected by 
physical links. Each link is divided into n channels using multiplexing. 
Any two nodes are connected using a dedicated path consisting of one or 
more links. In circuit-switching the connection must be established before 
starting communication and the resources must be reserved for the entire 
duration of communication. Here, the data flows continuously during the 
communication and there is no addressing involved. Circuit switching is 
usually done on the physical layer. A common example of circuit switched 
network is the communication over a telephone line. 

Packet Switching : In packet switching, the data is first divided into fixed 
length or variable length packets. The packets are then sent over the 
network, the packets pass through the communication channel in order to 
reach the destination. There are two types of packets switching techniques 
used: 

 Datagram

 Virtual circuits

In Datagram switching, each packet is treated independently of the others, 
even though it might be the part of the same communication. Each packet 
contains the source and the destination addresses which are used for its 
transmission to the correct destination. There is no reservation of 
resources. Whenever, a packet is received by a switch it processes it and 
routes it to the correct path. Since, there is no reservation of resources; a 
packet might face delay in transmission. A switch serves packets on a 
first-come-first-serve basis and a packet must wait until its turn to get 
transmitted to the next suitable node. Datagram switching is mostly done 
on the network layer. 

Virtual circuit switching combines both circuit switching and datagram 
switching. Like in datagram switching, virtual circuit switching uses 
packets and like circuit switching, a fixed path is defined between the 
sender and receiver before the transmission begins. However, this path is 
not physical but logical. The path remains unchanged during the entire 
duration of communication and each packet passes through the same 
logical path to reach the destination. The resources can however be 
allocated either initially or on demand. This type of switching is normally 
implemented on the data link layer. 

2.6.2 Connecting Devices 
In this section, we shall discuss about connecting devices that are used for 
connecting two or more LANs. As discussed earlier, switching helps in 
connecting multiple devices in a network. For transmitting data from the 
sender to the receiver, proper routing is needed. Routing functionality is 
provided by devices such as bridges, routers and gateways at different 
layers. 

Bridges: Bridges are used both at the physical and data link layer. At the 
physical layer they simply act as repeaters but at the data link layer they CCC-1.1/186



also provide routing facility. They can check the physical (MAC) address 
of the data frame and use it to route the data frame. They do not have 
capability to change the address of the data frame. Bridges are used to 
connect two or more LANs that share same protocol in a Wide Area 
Network. Bridges have filtering capability and can pick the data frame 
from a LAN that are intended for a device in other LAN and pass these 
data frames to the other LAN. The data frames intended for a destination 
in the same LAN are dropped. Since, all the LANs connected by the 
bridges use same protocol, processing time for data frames at the bridges 
is minimal. However, bridges cannot be used for connecting two different 
types of LANs. 

Routers: Routers are devices normally used to connect two different types 
of LANs or a LAN with a WAN over large geographical distances. 
Routers operate at the Network layer of the OSI model. Routers maintain a 
table called as the routing table which is used to make decisions about the 
route of a packet. All routers in a network participate in a routing protocol 
to determine the network topology. The information gathered in this 
manner is used to determine the best route between a sender and a 
receiver. For large networks, the routers are placed at such locations so as 
to minimize the link costs and prevent large scale network failures. The 
devices are then connected to the nearest router. 

Gateways: Gateways are also used for connecting two different types of 
LANs or WANs. Gateways are often used interchangeably with the 
routers. However, there is a subtle difference between a gateway and a 
router. Gateways operate at the application layer of the OSI model 
whereas routers operate at the network layer. Gateways can therefore 
connect two networks that use different types of network models. For 
example, a network using the OSI model can be connected with a network 
that uses the Internet model. Gateways access the data packets and convert 
them from one protocol format to another before forwarding. Gateways 
can also provide security by filtering unwanted application layer 
messages. 

2.6.3 Types of WANs 
Wide Area Networks are mainly used for long distance communication 
and for connecting remote devices. In this section, we will discuss some of 
the commonly used WANs. 

1. Public Switched Telephone Network (PSTN): It refers to
international telephone system which carries analog voice data using 
copper wires. It consists of a number of telephones connected through a 
public exchange network. It is based on the ITU-T standards that allow 
different networks across countries to interconnect with each other. Later, 
this network started to be used for data communication also. The network 
was modified and advanced time-to-time so as to achieve high speed and 
reliable data transfer. 
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2. Public Switched Data Network (PSDN): It is used for providing
data services using multiple Wide Area Networks (WANs). It provides a 
variety of switching techniques including circuit switching, packet 
switching and message switching. These networks provide high level of 
reliability and high quality of connections and can support both high and 
low data speeds. 

3. Value Added Networks (VANs): Value added services are used
for sharing received, stored and forwarded messages. Such service 
providers process, store and manipulate data sent over the network so as to 
add value to it. Initially, value added networks only provided message 
storage and forwarding facilities. But such services failed to be the 
attractive choice after the arrival of low cost services provided using 
Internet. As a result, the VAN network providers added more services to 
their value added suite in order to remain in competition. Nowadays, they 
provide services such as secure email, encryption, management and 
reporting. Electronic Data Interchange (EDI) is one of the application 
areas where VDN is used. Here, two trading partners exchange trading 
documents such as purchase orders, invoices and transportation etc. We 
shall discuss EDI in detail in the next section. 

4. Integrated Services Digital Network (ISDN):  It is the
international standard for end-to-end digital transmission of voice and 
data. It enables simultaneous transfer of digital data over standard phone 
lines that are used for both voice calls and data transfer. It is based on a 
circuit-switched telephone network that allows access to packet switched 
telephone networks. Once a widely used technology, nowadays it is 
largely replaced by DSL and cable services which provide fast speed at 
low costs and is now rarely used for Internet access. 

5. Private Networks: Private networks are built by individual offices
and institutions for special purposes. They might be connected to the 
Internet for providing wide range of services. Whatever standard 
technology is available can be used for developing such networks. 

2.7 Metropolitan Area Network (MAN) 
Another category of network that lies between a Local Area Network and 
Wide Area Network is Metropolitan Area Network (MAN). It covers an 
area of a town or a city. MAN is used to provide high-speed connectivity 
to a small number of users spread across a town or city normally to the 
Internet. An example of a MAN could be the part of the connection 
provided by a telecom company to home users through a high-speed DSL 
(Digital Subscriber Line). MANs are not very common and the most 
commonly occurring networks are LANs which are privately owned and 
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connected through routers and leased lines to the Internet that forms a very 
large WAN. 

2.8 Summary 

In this unit, we discussed the basics of computer networks. We 
first defined networks and their types namely LAN, WAN and MAN. 
Then, we discussed about the network architecture. We saw that the 
process of communication through a network is divided into various steps 
aka layers which clearly define the functions to be performed during 
various stages in communication. We also briefly discussed the OSI 
reference model which is the oldest model developed for setting a standard 
procedure for data communication. We then discussed each type of 
network in detail. We first defined LAN, then we discussed some of the 
important LAN topologies, their advantages and disadvantages, then we 
discussed about LAN software and some of the commonly used LAN 
operating systems. In the section on WAN, we defined WAN and 
introduced the concept of switching which allows temporary connection 
between two devices for transfer of data. We discussed two of the 
commonly used switching techniques viz, circuit switching and packet 
switching.  Next, we discussed the connecting devices which are used to 
connect LANs and WANs to create a larger network. The resulting 
network could be as large as the one that can connect the whole world 
(e.g. Internet). Next, we discussed some examples of WANs. In the last 
section we provided a brief introduction to MANs. 

2.9 Review Questions 

1. What do you understand by network architecture? Name the
network architecture used in the Internet.

2. Which LAN topology requires smallest length of wire to establish
connections in the network? Which topology requires the largest?

3. What do you understand by switching? Write one real world
example each of circuit switching and packet switching.

4. Write a short note on Router.
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UNIT-III 

ADVANCED CONCEPTS IN 
NETWORKING 

Structure 

3.1 Introduction 

3.2 Objectives 

3.3 Internet 

3.4 E-Mail 

3.5 Electronic Data Interchange 

3.6 NICNET 

3.7 Summary 

3.8 Review Questions 

3.1 Introduction 

In the previous units, we discussed the fundamentals of data 
communication and the basic concepts of networking. In this unit, we shall 
discuss some of the advanced concepts in networking. We shall discuss 
one of the most important applications of networking that is the Internet. 
We will also discuss the concept of an electronic mail and its 
characteristics. We will then discuss an application of networking 
developed specifically for business purposes that is the EDI. Lastly, we 
will discuss NICNET which is an application developed by the 
government of India for educational purposes. 

3.2   Objectives 

After learning this unit you should be able to: 

1. Explain about Internet and its applications

2. Describe Email

3. Define EDI

4. Define NICNET
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3.3 Internet 

Internet is the world’s largest communication network that 
connects a large number of networks across the world. It was initially 
developed by the US department of defense and at present includes 
various public, private, business, government and academic networks. The 
Internet uses TCP/IP communication protocol for transmission of data. It 
has several high bandwidth data lines that are called “backbone”. The 
major Internet hubs (ISPs) connected to the backbone provide lines for 
giving access of Internet to the common people. Some of the important 
services provided by the Internet are listed below: 

a. E-mail: It is a platform that allows users to send and receive
messages electronically. We will discuss more about email in the
next section.

b. USENET: It is a collection of messages on various subjects
submitted by the users of the service. These are posted to servers
on the Internet. It is the precursor to the Internet forums used
today. Here, posts are threaded and are categorized according to
subject categories.

c. TELNET: Abbreviation for Terminal NETwork, it is an
application program that allows users to remotely access other
devices using Internet. It facilitates remote login into another
system so that the local terminal appears to be the remote terminal.
It is a general purpose client/server application program based on
standard TCP/IP protocol for virtual terminal service proposed by
ISO.

d. FTP: It is a standard protocol for copying a file from one system to
the other. It is also provided by TCP/IP and allows transfer of file
regardless of the differences that might be present between the two
systems internally (e.g. directory structure etc.) and the type of
data contained in the file.

3.4 E-Mail 

E-mail (or electronic mail) is a software service that is used for 
sending and receiving messages electronically between individuals or a 
group of individuals. Email is one of the most common and highly used 
applications in communications and networking. An email system, 
actually involves much more than just sending and receiving messages. It 
is concerned with multimedia mail, database access, document sharing, 
scheduling etc. An E-mail system mainly consists of a server and a client. 
The email servers are computers that store and process messages which 
can be accessed by users using an email client or through a web mail 
service. The messages stored on the server can also be downloaded using 
the email client for offline use. 
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E-Mail Servers: There are three types of E-mail servers which are 
commonly used. These are briefly discussed below: 

1. SMTP Server: SMTP refers to Simple Mail Transfer Protocol.
SMTP server is responsible for delivering message to the recipient.
It is a computer program running SMTP. The e-mail messages are
first sent to the SMTP server which is responsible for delivering it
to the receiver.

2. POP Severs: These are servers that run the Post Office Protocol. It
gives users of the e-mail service access to the messages stored in
the user’s account.

3. IMAP Servers: These are servers running the Internet Message
Access Protocol. This protocol is more advanced than the POP and
allows users to access folders created by them and synchronize the
folders and messages on the server with those stored on the user’s
local machine.

E-Mail Client: E-mail clients are software that provide the users an 
interface to access their e-mail messages stored on the server. The client 
uses POP or IMAP to connect to the server and downloads/ synchronizes 
messages and displays it to users. Nowadays, web-based e-mail services 
are more common that provide access to user’s email through web 
browsers. 

3.4.1 Characteristics of Email System 
A good email system should provide ease of access and easy management 
of emails to the users along with proper management of directories at the 
server and secure and reliable services. The specific characteristics of a 
good email system are discussed in this section. 

a. Easy Management: For large e-mail systems, thousands of users
exchange messages every day. This puts huge burden on the
system administrator. A good email system should be designed in
such a way that it can handle heavy traffic. Large email systems
will also require large storage of email. Therefore, the email
system should also aim at efficient utilization of storage space.

b. Reliability: It is vital for effectiveness of any e-mail system. E-
mail systems should avoid incompatible naming conventions and
addressing so as to avoid loss of mail while crossing gateways.
Reports for tracking performance and cost should also be used.

c. Security: E-mail system should be especially efficient at providing
secure e-mail services to its users. This implies securing the
directory structure at the e-mail server. Along with this, it is also
important to allow people to access their own e-mails easily and
connect with other users. An efficient e-mail security service is
provided by X.500 that codifies directory structure and also allows
linked systems to find and query each other.
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d. Scalability: An efficient email system should allow the size of
directory to grow smoothly along with demand. It should also
provide smooth migration from or co-existence with the host.
Scalability has two underlying steps – synchronization and
propagation. Synchronization is transaction based process which is
concerned with bringing directions up to date within a system
while propagation involves sending directory updates to other
servers. A scalable email system should allow smooth working of
both these procedures as the size of the system grows.

e. E-Mail Text Editing: A good email system should also provide
the users with sufficient editing features so as to allow them to
write personalized messages with required formatting. Some such
important features include- ability to cut, copy and paste, font
choices, spell checking, automatic differentiation of text with
initial message and OLE (Object Linking and Embedding) for
graphics and sound embedding.

f. Remote Accessing: This involves several activities such as offline
message creation, bulk transfer of mail, offline directory service
etc. A good email system should also provide these facilities to the
users.

3.5 Electronic Data Interchange 

Electronic data interchange (or EDI) is the technique that allows 
electronic interchange of business documents among the trading entities. 

Understanding EDI 

Business trading involves exchange of various types of documents. Two 
most common such documents are purchase orders and invoices. Initially, 
everything used to be manual so that manual entries were maintained for 
all kinds of records associated with the business. Later, computers were 
started to be used for this purpose. Though the use of computers has 
reduced manual work, still a significant amount of manual work is 
associated with exchange of business documents. Consider for example, 
the business between two entities that exchange purchase orders and 
invoices. The normal course in this case would be that the buyer will 
generate the purchase order using her computer. Then, she will either fax 
or email this order to the supplier. The supplier upon receiving the order 
will re-enter this order into her system and print the invoice. This invoice 
will then be emailed or faxed back to the buyer. The buyer will then again 
enter the invoice details into her system for further processing. As you 
might have realized, this whole process still involves a large amount of 
manual work. It would be more useful and time-saving to have a system 
which can generate the purchase orders, invoices etc. automatically in the 
electronic form, allow automatic exchange of these documents between 
the buyer and supplier systems and can also translate these documents into 
a human-readable form whenever required. EDI is an application that is 

CCC-1.1/194



developed for doing these tasks. It allows the computer-to-computer 
exchange of business documents among the trading partners. 

3.5.1 Benefits of EDI 
EDI has several benefits over the manual system of exchanges in trading. 
Some of the benefits are given below: 

1. EDI transactions eliminate the need of paper, printing, storage,
filing and postage etc. thus it greatly reduces the cost of transaction

2. Increases efficiency as data does not need to be entered multiple
times

3. Reduces the chances of errors

4. Saves time

5. With the reduction in amount of manual work required, the
requirement of staff also reduces and hence the cost of business is
further reduced.

Components of EDI 

EDI has three main components as listed below. 

• EDI Standards

• EDI Software

• Third party providers

3.5.2 EDI Standards 
Since, EDI is concerned with exchange of information between two or 
more computers; the documents generated by it must follow a standard 
format so that any trading partner system can read it regardless of the type 
of system. For successfully conducting the trading operation, EDI 
standards are maintained both for formatting and communication. EDI 
formatting standards provide guidelines regarding the preparation of EDI 
documents while communication standards are concerned with how these 
documents will be transferred electronically from one system to the other. 
Some of the issues addressed by EDI communication standards are: 

1. Communication passwords and identification codes

2. Rate and transmission mode

3. Line protocols

4. Network availability and service level

5. Communication links

X. 400, AS2, OFTP, FTP and FTPS are some of the EDI communication 
standards.  
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3.5.3 EDI Document Types 
ANSI X 12: It is the standard for EDI documents developed by the 
Accredited Standards Committee X 12. ASC was chartered by the 
American National Standards Institute (ANSI). The ANSI X12 standards 
are used by various business organizations across the world. EDI 
standards continue to be modified in today’s time as new sets of 
transactions appear which may be candidates for standardization. 

Retail Industry Standards 

The need for retail industry standards arose when the traditional EDI 
standards developed for transportation industry seemed inadequate for 
handling specific requirements of retail industry. The Uniform 
Communication Standards (UCS) was developed for grocery segment and 
was adopted by several other retail sectors. It is a subset of the ANSI X12 
standards. 

International Standards 

Another important international standard for EDI is EDIFACT. EDIFACT 
was developed under the United Nations. EDIFACT has been adopted by 
ISO and is responsible for developing syntax rules and data dictionary for 
it. EDIFACT has become the de-facto choice for standards for businesses 
carrying international operations using EDI. 

3.5.4 EDI Software 

EDI software consists of computer programs that can automatically 
convert the unstructured files to specific format as required for EDI 
transactions. They also receive messages from outside systems and 
convert them from the standard EDI format to company specific format so 
that it can be used for internal processing in the company. Thus, the main 
tasks of EDI software are data formatting, conversion of data from 
company specific to EDI format and vice-versa and communication over 
the EDI network. EDI software are available for mainframe computers as 
well as for mini and microcomputers. EDI software require continuous 
maintenance and up gradation of environment after establishment. Smaller 
businesses generally do not possess enough IT resources to manage their 
own EDI environment. Such companies can also use hosted or software-
as-a service based EDI. 

3.6 NICNET 

The National Informatics Centre is an institution of the government of 
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district, state and national level. It operates the NIC Network (NICNET). 
It provides Management Information Services (MIS) and computerisation 
facilities to several ministries and departments associated with central and 
state governments across the country. The main aim of NIC is to use 
computer networking to enable efficient exchange of information between 
the centre, state and districts as well as among the various departments of 
the government bodies. 

3.7 Summary 

In this unit, we learnt about some of the important applications 
designed on the top of a computer network. We first discussed the 
Internet, which is the world’s largest internetwork connecting billions of 
computers across the world. We also studied about some of the platforms 
built using the Internet. In the next section, we discussed about e-mail. E-
mail is a software service used for sending and receiving messages 
electronically. We also discussed about three different types of e-mail 
servers- the SMTP server, the POP and the IMAP server. SMTP server is 
responsible for delivery of message while POP and IMAP servers are 
concerned with storage and access of email. The e-mail client on the other 
hand provides the platform for reading and writing messages and other 
services. We also discussed the important characteristics of a good e-mail 
system. Electronic Data Interchange is the facility provided for electronic 
exchange of documents among trading partners. It enables paperless 
business work and simplifies business transactions by automating the 
manual data entry and other tasks. We discussed about EDI standards, 
document types and also about EDI software. In the last section, we 
discussed NICNET which is an initiative of the NIC to connect various 
government offices and ministries using computer networks. It provides 
software solutions for governance tasks and also aims at connecting 
centre, with the state and districts in a hierarchical manner through 
computer networks. 

3.8 Review Questions 

1. Why is standardization important in EDI? Discuss any two types of
EDI document standards.

2. Write any two examples of e-mail clients.

3. What do you understand by scalability of an e-mail system? Why
is it important to consider scalability while designing an e-mail
system?
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4. Find out some of the software solutions developed by NICNET in
different sectors. Write short note on the work of NICNET based
on it.
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BLOCK INTRODUCTION 
In this block you will learn an overview of internet, Internet tools, 

Web browsers, and visiting Websites. The first unit describes you about 
the working of Internet and various services offered by it. This unit will 
explain how networks, ISPs, Domain Name Server, and server works. 
Here, you will learn about IP address, URL and hyperlink. You will be 
explained the various ways to get the Internet connection using Internet 
Service Providers.  In second unit, you will learn about an email, File 
Transfer Protocol and their working. This unit will describe you how to 
use these services. In third unit, you will learn about some popular Web 
browsers like NCSA Mosaic, Netscape Navigator, CHROME, Mozilla 
Firefox and Internet Explorer. This unit will describe you the various 
features offered by these Web browsers.  You will also learn to use 
bookmarks, RSS, plugins using Internet Explorer in this unit. After 
studying this unit, you will be able to perform some important operations 
that are frequently used with Web browsers. In last unit, you will learn to 
download files on the Internet. In this unit you will be explained about 
various types of Websites available on the World Wide Web and their 
uses.  
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UNIT-I 

INTERNET : AN OVERVIEW 

Structure

1.1 Introduction 

1.2 Objective 

1.3 What is Internet  

1.4 How to Connect a Computer to the Internet 

1.5 Hyperlinks and Uniform Resource Locator (URL) 

1.6 IP address 

1.7 Domain Name System (DNS) 

1.8 Client, Server and Port 

1.9 Services on Internet 

1.10 Summary 

1.11 Terminal Questions 

1.1  Introduction 

Today, the Internet is possible by Networks, routers, ISPs, DNS 
and powerful servers. Without these extremely important components, the 
Internet would not be possible. And without the Internet, our life would be 
very different. Now a day, the Internet has become an important part of 
our life. There are so many things that we can do with the Internet. For 
example, it can be used as the source of information, entertainment, 
education and work. To efficiently use these various services, a basic 
understanding is required. You will be surprised, when you think that all 
the information are sent in milliseconds to ever corner of the world. In this 
chapter, you will learn the underlying technology behind the working of 
Internet and fundamental concepts involved. 

1.2 Objective 

After studying this chapter, you should be able to: 

 Understand how the Internet works.

 Explain how Network, ISPs, DNS and server work.

 Understand how you get connected to Internet. CCC-1.1/203



1.3 What is Internet 

The Internet is a huge collection of computers from every corner 
of world. These computers are connected to each other by telephone lines, 
network cables, fibre-optic or through wireless signals. In general, every 
computer on the Internet are not connected with every other computer. 
Instead, individual computers in an organization are connected through a 
local area network (LAN) and one of the computers on this local area 
network is physically connected to the Internet. So, the Internet is 
publicly-accessible network that consists of many smaller networks 
(shown in Figure 1.2) including domestic network, business network, 
academic network and government networks. The connections in the 
network are made using telephone lines, cable data lines, fibre-optic, or 
even wireless signals as shown in Figure 1.1. A computer connected to the 
Internet is commonly referred as a host. Each host computer accesses 
services on Internet by sending and receiving data in digital form using 
protocols. For example, Simple Mail Transfer Protocol (SMTP)for 
electronic mail, file transfer protocol (FTP) for moving files, telnet for 
accessing information and hypertext transfer protocol (HTTP) for serving 
web pages. 

Figure 1.1: Devices like phone, laptop, desktop computer etc. can be 
connected to the Internet through ISP 
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The Advanced Research Projects Agency Network (ARPANET) was the 
first Network which is considered as a predecessor to the modern Internet. 
The ARPANET was developed by the U.S. government during the Cold 
War, in order to build a robust and reliable communication network. This 
network was built by connecting several computers that could 
communicate simultaneously and would continue to run even when a 
single node was taken out. There is a common misperception that the 
Internet is same as the World Wide Web (WWW). But, the Internet is 
different from the World Wide Web. The World Wide Web is a massive 
collection of web pages, pictures, audio, videos and other online contents 
that are accessed through web browser software. The World Wide Web 
was originally designed in 1991 by Tim Berners-Lee at CERN. One 
important feature of web pages is their use of hyperlinks. Hyperlinks 
present within the web pages allow you to quickly move from one web 
page to other web pages. So, you can jump to these web pages, even if the 
web pages are sitting on different servers located at different parts of the 
world. 

1.4 How to Connect a Computer to the Internet 

An internet Service Provider (ISP) is a company such as BSNL, ACT 
Fibernet, Airtel Broadband, Hathway, MTNL etc. that provide internet 
access to their customers by using copper, fibre optics, or even satellite 
communications. We all have some sort of devices in our home or 
business such as your phone, laptop, desktop computer etc. These devices 
can be connected to the Internet through ISP as shown in Figure 1.1. The 
ISP has dedicated computers that act as servers to serve customer's request 
to access web pages or e-mail. There are several Internet Service Providers 
(ISP) in each locality. You can get installation of Internet connection by 
paying some nominal charges which can be monthly or annually. You can 
choose any one of the available options that best fits your requirements. 
You can choose a high bandwidth broadband or leased line connection, if 
you need a high speed internet connection. If you need an internet 
connection on a single PC then you choose a low bandwidth or dialup 
connection. Some small services can be made available anywhere and 
anytime by using your mobile phones. These days, you can even find 
wireless connections in several places like Railway Stations, Universities, 
Corporate offices, etc. To access these wireless connections, your device 
should be attached with a Wi Fi card. So, there are various ways by which 
you can get connected to internet through the ISPs. These can be mainly 
classified into following categories. 
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Figure 1.2: An Internet Service Provider 

Dial-up Connection 
Dial-up Connection is the most basic type of internet connection available 
from ISPs. Dial-up connection requires your computer, Internet browser, 
modem, telephone Connection and internet account from the ISP as shown 
in Figure 1.3. Your computer acts as a “Client” or “Terminal” and the 
computer on the ISP side which provides Internet access is known as 
‘Host’. The host computer is full time connected to the internet just like a 
Leased Connection. Host computer carries all the commands from a client 
machine and forward them to Internet. When the Host computer receives 
data and information from internet, it passes back to the client computer. 
The client computer uses modem to access the “host” computer. 56K 
modems are widely available that allows user to surf the Web at 56 Kbps. 
These types of modem are supported by most ISPs. 
Cable inside your Home 

Figure 1.3: Dial-up-Connection CCC-1.1/206



Leased Connection: 

A leased connection is sometimes also known as a dedicated line. It 
provides a high speed internet access. It is secure and most expensive type 
of Internet connection. It uses a reserved circuit which is always active. A 
traditional telephone service reuses the same line for different 
conversations. A leased line connection keeps a single open circuit 
available at all times. An Internet Service provider places a special 
electronic device called router at your site and establish a dedicated link. 
A router connects a local network to the Internet and allows all members 
of the local network a complete Internet access. A leased line connection 
offers higher bandwidth than other types of Internet connections such as a 
simple dial-up connection, residential DSL and cable internet broadband 
service. The high cost of this type of connection discourages most people. 
This type of connection is mostly used by large institutions like corporate 
offices and government agencies. A major benefit of this connection is 
that it is available all time i.e. 24 hrs a day, seven days a week, (24x7).  

DSL (Digital Subscriber Line or Dedicated Service Line) Broadband 
Connection: 

DSL provides a high-speed internet connection by using the same 
telephone wire that you see in your street. DSL uses the same phone line 
but works on a frequency band that is different from the phone connection. 
A standard telephone wire at your home consists of a pair of copper wires. 
These copper wires are capable of carrying more than the phone calls. 
They offered greater bandwidth (or range of frequencies) which is much 
more than as required for voice. DSL uses this "extra capacity" to carry 
internet signals on the same wire without affecting disturbing its ability to 
carry phone conversations. This way, DSL creates a dedicated circuit that 
filters out standard phone calls and Internet signals. In a dial-up 
connection, either the phone will work or the Internet will work, but both 
will not work together. With DSL, the phone will remain active while the 
Internet is being used.  DSL broadband connection requires a DSL 
modem, a telephone line and a computer with Network Interface Card 
(NIC). DSL offers higher Internet speed than a dial up connection. It 
offers speed rate between 256 Kbps-20 Mbps, while estimated data speed 
in a dialup connection is 56 Kbps at a maximum. 

Cable Modem Connection 

Now, if you have a cable TV, you can get a high-speed internet connection 
from your cable provider (as shown in Figure 1.4). Cable modem internet 
connection provides faster Internet access than a dial-up but it is 
sometimes slower than DSL. In a cable TV system, each channel is 
usually given a 6-MHz slice of the available cable bandwidth. The coaxial 
cable used for cable TV system can carry hundreds of such signals. A 
cable company offers Internet connection using the same cable, but 
Internet information is put on a separate channel. A cable modem system 
is place at customer end that puts downstream data (data sent from the 
Internet to an individual computer) on a 6 MHz channel. On average, most CCC-1.1/207



people download more than they upload. There is a cable modem 
termination system (CMTS) at the cable provider's end that places 
upstream data (data sent from an individual to the Internet) requires even 
less of the cable's bandwidth, just 2 MHz. The Cable modem may present 
inside or outside of your computer. Sometimes, the cable modem is a part 
of the set-top cable box. 

Cable inside your Home 

Figure 1.4: Cable Modem Internet Connection 

Reasons a Page Cannot Be Displayed 
Sometimes, you cannot access a particular web page and sees a generic 
message ‘Page cannot be displayed’. The main causes for this problem can 
range from a simple typo error in the URL to a number of different 
reasons. The possible cause for this problem falls in one of the following.  

1. You have lost your Internet connection. Check your Internet
connection (or wireless signal) and try again.

2. The web page does not exist anymore or changed to another URL.
Check the web address you typed or use a search engine to find its
new web address.

3. Too many users are viewing the web page at once. Wait for a while
(sometimes a few minutes or sometimes a few hours) and try
again.

4. The server that stores the web page is down. Wait for some time
and try again.CCC-1.1/208



Check your progress 
Q.1  What is an Internet Service Provider (ISP)? 

Q.2  How does the Cable Modem Connection works? 

Q.3  What are the differences between Dial up Connection and DSL 
Broadband Connection? 

Q.4 How do you connect to Internet through Leased Connection? 

1.5 Hyperlinks and Uniform Resource Locator 
(URL) 

A hyperlink (commonly referred as a link) is a text, an icon or 
graphic in a Web page that contain link to other web page or file. The web 
pages on World Wide Web are linked to another through hyperlinks. 
Hyperlink allows you to open a web page without knowing the URL of the 
web page. When you click on a hyperlink, your browser leaves the current 
page and opens the link either in same window or in new window. A 
keyboard can also be used in place of mouse to open a hyperlink. You can 
press Tab key repeatedly to reach each links on a Web page. When you 
reached to a desired link, you can press either the Spacebar key or the 
Enter key on the keyboard to open the link. 

A Uniform Resource Locator (URL) is sometimes also called as a 
web address. It is used for accessing web resources in order to specify 
their location on a computer network. It gives addresses to web pages by 
using symbolic words. This way, it provides us a mechanism for retrieving 
any web pages or resources. An example of a URL 
is http://www.uprtou.ac.in/about_us.php, which is the URL for the 
U.P.Rajarshi Tandon Open University, Allahabad website. Each part of 
URL provides some additional information. For Example, the https URL 
for the IRCTC page shown in Figure 1.5 contains four parts. 

Figure 1.5: General Structure of URL. CCC-1.1/209
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http:// or https://:The "http" (Hyper Text Transfer Protocol), allows 
your web browser to know which protocol it will use to access a Web page 
specified in the URL. The "https" protocol is short form for "Hypertext 
Transfer Protocol Secure" which allows secure and encrypted transfer of 
information over Internet while accessing any Web page. The colon ( : ) 
and two forward slashes ( // ) separate http or https protocol from the 
remainder sections of the URL. Please note that a URL does not 
necessarily contain HTTP or HTTPS, instead it may start with other 
protocols like Telnet and FTP. 

www.irctc.co.in:"www.irctc.co.in" is the domain name for Indian 
Railways Reservation Website (IRCTC). The first portion of URL is 
"www" which stands for World Wide Web. This portion is optional 
and can be left out many times. For example, typing "http:// 
irctc.co.in" would still bring you the IRCTC web page. The last 
portion of the domain i.e. “.co.in” is a domain suffix. This portion tells 
you the type or location of the website. For example, ".com" is used 
for commercial Websites, ".org" is used for an organization, and 
".co.in" is used for India. There are many other domain suffixes 
available to identify other type of Websites. Some of the most 
Common Domain suffix are shown in Table 1.1. 

Domain suffix Application 

.net (network) Used for network Organisations 

.int (international) Strictly used by organizations that are approved 
by a treaty between two or more nations. 

.edu (education) Used for specific higher educational institutions. 

.gov (Govenment) Used for governmental entities and agencies. 

Non-Geographical Domain 

Domain suffix Country 
.in India 
.us United State 
.uk United Kingdom 
.cn China 

Geographical Domain 

Table 1.1: Common Domain Suffix. 

/eticketing/: This portion of the above URL is the directory name on the 
server that contains IRCTC web page. The webpage loginHome.jsf is 
located in /eticketing/ directory on the server. The web page can also 
reside deep inside the multiple directories, For example, the Webpage 
“TatkalBooking.html” can be found on the server in /tatkal/en/ directory. CCC-1.1/210
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loginHome.jsf: Finally, “loginHome.jsf” is a Web page on the IRCTC 
domain name. This web page’s name ends with .jsf file extension which 
indicates that this is a jsf web page. A web page may also contain other 
file extensions like .html, .php, .asp, .cgi, .xml, .jpg, and .gif. Each of these 
extensions is used for different purposes for performing different 
functions. This can be thought of different types of files on your computer 
serve different purposes. 

1.6 IP address 

We are generally more comfortable in remembering words rather 
than numbers. But, each computer on the Internet is identified with a 
unique address known as an Internet Protocol Address (or IP Address). 
Usually, an IP address looks like this: 103.252.142.19. The computing 
devices such as smart phones, personal computers and tablets use this IP 
Addresses to identify itself and communicate with other devices on the 
Internet. Any device connected to internet must have a unique IP address 
in order to access various services on the Internet. An IP address is similar 
to a house address or a telephone number that is required to uniquely 
identify or communicate with a particular person. A traditional 32 bit IP 
address is Internet Protocol version 4 (IPv4) that uses a 32-bit number to 
represent an IP address. This 32-bit number can provide roughly 232or 4 
billion unique IP addresses. An IP address is generally written in "dotted 
decimal" notation with 4 sets of numbers, each separated by dot. Each set 
represent an 8-bit number that vary from (0-255). For example, a typical 
structure of an IPv4 address is shown below. 

Today, IPV4 addresses are almost used up due to the rapid increase in the 
number of devices on the Internet. So, Internet Protocol version 6 (IPv6) is 
developed to overcome this problem of shortage of IP addresses. The IPv6 
uses 128 bits instead of 32 bits that offers virtually unlimited number of 
unique IP addresses. CCC-1.1/211



Check your progress 
Q.1  What is URL?  

Q.2  Explain different parts of the URL? 

Q.3  What's the Difference Between a Website and a URL? 

Q.4  What is an IP address? 

1.7 Domain Name System (DNS) 

It is very difficult to remember IP addresses of all those websites that we 
visit daily. We are generally more comfortable in remembering words like 
domain name rather than numbers like IP address. But the internet works 
on IP addresses. This is where DNS comes into the picture. DNS (Domain 
Name System or Service or Server) converts a domain name (or URL) into 
its IP address which the computer understands. It is an Internet service that 
translates the domain name like "www.irctc.co.in" into its IP address 
(103.252.142.19). The computers on the internet use this IP address to 
identify other computers and access various services on the internet. The 
Figure 1.6 shows how the DNS works. 

Figure 1.6: Host want to know IP address of 
https://www.irctc.co.in/eticketing/loginHome.jsf 

This is similar to dialling a phone number instead of a name of the person 
to connect to that person. Although you are good at remembering names 
of persons, but the phone services work on mobile numbers. Thanks to 
DNS, you do not need to remember all the IP addresses or maintaining an 
address book of IP addresses. You can just connect to a domain name 
server that maintains a massive database of the Internet domain names and 
their corresponding IP addresses. When you type a 
URLwww.irctc.co.in/eticketing/loginHome.jsf in your browser, it extracts 
the domain name www.irctc.co.in from the URL. Your Internet Service 
Provider then connect you to the DNS server to translate it into a machine 
friendly IP address 103.252.142.19 and then redirects you to the IRCTC CCC-1.1/212
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website. However if you already know the IP address of IRCTC website, 
you can always skip a DNS lookup by directly entering 103.252.142.19 in 
your browser. 

1.8 Clients, Servers and Port 

Clients & Servers : Internet servers have made possible the various 
services on the Internet. The machines or computers available on the 
Internet are either clients or servers. A server computer or machine 
provides services to other computers on the Internet. While, a client 
computer connects to theses servers to access services provided by them. 
A server computer is a special type of desktop computer usually equipped 
with most advanced hardware to work 24-hours a day and is more reliable 
than a desktop computer. There are a variety of servers on the Internet 
such as web servers, e-mail servers and FTP servers. A single server 
computer may provide more than one services on the Internet. For 
example, a server computer might be running a software that allows it to 
act as a Web server, while it might contains other software that allow it to 
work as an e-mail server or an FTP server. When you open 
“www.irctc.co.in” website on your computer for reservation, you are using 
a client computer and accessing the IRCTC Web server. The IRCTC’s 
server computer finds the requested web page and sends it to you.  So, a 
client’s request to access any web page is passed to the web server 
software not the e-mail server software running on the server computer. 
Your Telnet application on your computer will communicate to the Telnet 
server, your e-mail application will communicate to the e-mail server, and 
so on. 

Port : The software services like mail server, file server, web server, 
proxy server, etc., on a server machine are made available using port 
numbers. Each software service available on the server is accessed using a 
port number. For example, web server software running on a server 
computer is accessed through port 80. Similarly, a file transfer protocol 
(FTP) server software can be accessed through port 21. This way, a client 
computer connects to a specific service on a server by using its IP address 
along with the corresponding port number. After a client gets connected to 
a particular software service using its port number, it can access the 
service using a specific protocol. Protocols are simply a set of rules which 
describe how the client and server communicate to each other for a 
particular service. For example, every Web server on Internet uses 
hypertext transfer protocol (HTTP). The HTTP uses port 80, while HTTPS 
uses port 443. So when you are connecting to a web site like 
http://www.nvsp.in, you are actually connecting to http://www.nvsp.in:80 
with a colon followed by port number. This http://www.nvsp.in is an 
official website for new voter registration, voter ID status, voter ID card 
correction, etc. Since 80 is the default port for web servers, it can be left 
off. A port number is a 16-bit number which can provide 2^26 (from 0 to 
65535) distinct port. The first 1024 ports are reserved for privileged 
services. CCC-1.1/213
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1.9 Services on Internet 

Electronic Mail 
Electronic mail or simply E-mail is a faster and cheaper method of 
exchanging messages between persons over internet. You can use e-mail 
to send notes, letters, photos and other documents to one person or even 
many people at the same time. You can also look the copies of the 
messages that are sent to other persons anytime.  Normally, the post office 
post takes several days to deliver your letter at its destination. While on 
other hand, an E-mail just takes only few seconds to arrive at their 
destination. You can send Email messages anytime of the day or night and 
it will get delivered immediately. The email service is available 24x7 i.e. 
24 hrs a day, seven days a week on the internet. You do not need to worry 
about the holidays or working time of the post office. You can also send 
other multimedia files like graphics, images, etc., along with your e-mail. 
One of the main advantages of the e-mail is that it is very cheap, 
especially when you are sending messages to other persons residing in 
other states or countries. A received email can be replied or forwarded to 
other persons. You can even store it for later use. 

TELNET 
Telnet is used to access and control remote computers. You can connect 
your computer to other computers on the internet by using a Telnet 
program that is available on your computer. Once you connected, you can 
control remote computers and communicate with them by entering 
commands on your Telnet program. These commands will be executed on 
the server like you are directly entering them. The Telnet program grants 
you full control on all files and applications on remote computers similar 
to an actual user. The TELNET program only requires a keyboard because 
there is no graphical user interface as you see in modern operating 
systems. Everything is displayed on the screen as text. In Windows, the 
TELNET program is available from the command prompt. The commands 
available in Telnet program use Telnet protocol. 

FTP 
The FTP (File Transfer Protocol) is used for exchanging files online 
similar to Hypertext Transfer Protocol (HTTP). There are two computers 
involved in an FTP transfer. The first computer is FTP server and second 
computer is FTP client. The FTP server computer looks on the network for 
connection requests from FTP client computers. A FTP client computer 
can make a connection with a FTP server by using FTP client software. 
Once FTP client computer successfully connected to FTP server computer, 
the client can perform a number of file manipulation operations such as 
download files from the server, uploading files to the server and rename or 
delete files on the server. FTP is used for sharing of files in reliably and 
efficiently to remote computers on the Internet. FTP works on two 
different ports: 20 and 21. CCC-1.1/214



WWW 
In earlier days about twenty or thirty years ago, use of public libraries for 
finding information on any subjects is taken for granted. You could walk 
to a public library and open up a reference book for finding information 
you wanted. Now a day, the World Wide Web is taken for granted for 
online information. You can use any computer, almost anywhere on the 
earth and access far more powerful source of information than any public 
library. In this twenty-first century, our life is so dependent on the World 
Wide Web that it seems to be too difficult to live without it. The World 
Wide Web is a massive collection of text pages, images, audio files, 
videos, animations, etc., which can be accessed through any Internet 
enabled devices and using a web browser. An important point to note that 
is that all these information are connected together. A web page of text is 
the basic building block of the World Wide Web. A website consists of 
several web pages that are sitting on same server computer. Every web 
page contains highlighted phrases called links (or hypertext links). Using 
theses hypertext links you can move to another web page on this website 
or another website. These web Pages are viewed by a specialized tool 
called Internet browser or simply browser (like Internet Explorer and 
Mozilla Firefox.). It is a software program specifically designed to retrieve 
web pages based on the users’ request. The process of viewing 
information on Internet using browser is known as Browsing or Surfing. 

1.10 Summary 

In summary, you learned: 

1. The Internet is a huge collection of millions of computers from
every corner of world that are connected to each other by
telephone lines, network cables, fibre-optic or through wireless
signals.

2. You understand how do an Internet Service Provider (ISP)
provides internet access to their customers.

3. You learned about URL and hyperlink.

4. An IP address is necessary to uniquely identify a computer on the
Internet and communicate with other computers.

5. Domain Name System (DNS) translates the domain name like
"www.irctc.co.in" into its IP address like 103.252.142.19.

6. The machines or computers available on the Internet are either
clients or servers. The machines that provide services to other
machines are servers. And the machines that connect to those
services are clients. A server machine makes its software services
available using port numbers. Each software service available on
the server is accessed using a port number.
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7. You learned about some of the Internet services like Email, Telnet,
FTP, and WWW.

1.11 Terminal Questions 

Q.1 What is the main purpose of DNS? 

Q.2 Discuss the role of an IP address in Internet? 

Q.3 What is a Port? Explain its role in Internet. 

Q.4 Describe the various services offered by Internet.  

Q.5 Explain the role of an Internet Service Provider (ISP)? 

Q.6 What are the differences between a server and a client computer? 
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UNIT-II 

INTERNET TOOLS 

Structure

2.1 Introduction 

2.2 Objective 

2.3 Electronic Mail 

2.4 FTP 

2.5 Telnet 

2.6 Summary 

2.7 Terminal Questions 

2.1 Introduction 

Today, the various services like Email, FTP, Telnet, WWW, etc., 
have made the Internet popular. These services make the internet an 
essential part of our lives whether it is our workplaces or personal life. 
You can use these services to communicate with other people, whether 
they are sitting in next building or on other part of the world. These 
services including communication, education, e-commerce and access to 
unlimited web resources provide many benefits to us. In this chapter we 
will see some Internet protocols other than HTTP. These protocols work 
much in same way like HTTP where a client software in your computer 
makes requests to a server computer running appropriate server software.  

2.2 Objective 
After studying this chapter, you should be able to: 

 Explain about an email and how does it works.

 Understand FTP (File Transfer Protocol).

 Understand Telnet and how do you use Telnet in Windows.

2.3 Electronic Mail 

Now a days, many people use e-mail daily to send messages to 
their colleagues, friends, and family. They daily sign-in the websites and 
their check their email account for new messages. Every day, people 
install email program on their smart phone, tablet and computer. It is clear CCC-1.1/217



that the e-mail communication has replaced letter writing and telephonic 
call in many social and professional environments. Now, the email has 
become one of the extremely popular communication tools. 

What Is Email? 

An E-mail or Electronic mail is a digital message that uses your keyboard 
to write a message on the electronic devices like mobile phones, tablets 
and computers. An email has always been a simple text message sent to a 
recipient. But, the ability to add attachments to the email has made it quite 
long. Even with the attachment the email continues to be a simple text 
massage. An e-mail address is written with a user defined name followed 
by the email service provider’s domain name, both separated with @. For 
example, yourname@gmail.com. 

Advantages of an Email 

Some of the reasons that many people use email in their daily life are as 
follows: 

 Speed:  People can send email within a minute or seconds from
anywhere across the world. This adds huge benefit to many people.

 Attachments: It is quite easy to add any file like picture, PDF,
word processor document, movie, program, etc., to an email
message and send them to an individual or a group of person. You
can share your vacation pictures or spreadsheet to your co-worker
with the e-mail.

 Accessibility: An e-mail account can be thought of a large
collection of folders containing private messages along with other
important documents. You can search through any information or
documents contained within the email and so they are always
readily available.

 A Record: Email provides a record of a conversation in form of e-
mail messages. You can print emails when required. You can
utilize your email provider's large storage space to keep your
documents available online that can be accessed anytime and
anywhere.

 Free communication: The other form of communications like
long distance calling or physical mail messages require some
charges which can be expensive in some cases. But in case of
email, most email providers give you free storage and access to an
email account. You can send and receive your electronic mails,
store everything online and you do not need to pay anything.

 Security: Email services are specifically built for privacy
and security. So you can be confident that your messages and files
are only visible to intended recipients and hidden for everyone
else.
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How to send, read and reply to E-Mails: 

In order to access an email service, you need to first create an email 
account with any email service providers. You can create a new email 
account within a few minutes. You just need to sign up by providing few 
personal information about yourself, an account name and a desired 
password.  Your user ID or username will became part of your email 
address. For example, if you open Gmail and choose lastsamurai as your 
username, your email address becomes lastsamurai@gmail.com. After 
creating your email account, you can send email messages to other persons 
by following steps: 

 Open the website of your email service provider on your browser
e.g. www.gmail.com. And then login by using your user name and
password.

 Click compose button to create a new message. You will see a new
screen as shown in Figure 2.1. Similar to letters, email messages
also have two main parts: header section and body section. Header
section contains address of the recipient and subject of the
message. While the body section contains the message itself.

Figure 2.1: An Email dialog Box. 
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 Type the e-mail address of the person who is recipient of the
message in the “To:” field. If you are replying to a mail, this field
will be filled automatically. For multiple recipients, e-mail id
should be separated by commas.

 From field: This field contains your e-mail address. From field is
automatically filled with email address of the sender.

 Type a subject of your message in the “Subject:” field. This field
contains the title of the email that describes the content of the
email. This field is optional that lets the recipient to know what the
e-mail is about, without opening and reading the e-mail.

 The large text box as shown in Figure 2.1 is used to write the
contents of your message. This is the place where you type your
main content of the message. The message body often contains
your signature at the bottom, similar to a hand-written letter.

 In the “Cc” (Carbon Copy) field, enter the email address of those
to whom you would like to send a “carbon copy” of your message.
This field is also optional. This field allow you to send copies of an
email to additional people. For example, you can send an email to
Sudhir and CC to Ashok and Shaukat. This e-mail will be sent to
Sudhir, however Ashok and Shaukat will also receive a copy of
this email. The email addresses are visible to each other in their
respective fields.

 In the “Bcc:” ("blind carbon copy") field, enter the e-mail
addresses of those to whom you would like to send a “blind carbon
copy” of your message. This field is similar to CC, except the
recipients list of BCC is kept secret. When you add people in CC
field, the CC list is visible to each person in this list. For example,
if you add kanahiya@example.com and dinesh@example.com in
CC field, Kanahiya and dinesh will both know that the other have
received the email. In case of BCC, no one but the sender can see
the list of BCC recipients. For example, if you
add alok@example.com and vikash@example.com in the BCC list,
neither Alok nor Vikash will know that the other has received the
email. However, each recipient in BCC list can see everything
else, including the CC list and the content of the email. The
persons in the BCC list can see only their own email address on
the BCC list.

 Click the Attach files icon to attach file(s) like photos, audio,
video, executable files, etc., if required.

 Finally click the send button to send the message.

How E-mail Works 

Sending and receiving-mails requires an e-mail client (some kind of 
stand-alone-mail application). Many of you have already used well-known 
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Thunderbird. You can also use e-mail services from Gmail 
(https://www.gmail.com) or Yahoo (https://www.mail.yahoo.com) where 
the e-mail client is embedded in their Web pages. Once you have access to 
any of e-mail services on your computer, you can send and receive e-
mails. The e-mail client connects to an e-mail server or mail server for 
accessing the mail services. The mail server runs two different servers. 
The first one is SMTP (Simple Mail Transfer Protocol) server that 
handles all outgoing mail. The other one is either a POP3 (Post Office 
Protocol) server or an IMAP (Internet Mail Access Protocol) server that 
handles all incoming mail. The SMTP server listen requests on well-
known port number 25. While, the POP3 listens requests on port 110 and 
IMAP uses port 143. When you set up your email account, for 
example,xyz@gmail.com with Gmail, the Outlook Express communicates 
with the mail server –smtp.gmail.com. When you compose a message and 
send it your friend Dinesh with email id dineshskt@gmail.com, here is 
what happens (overall mechanism is shown in Figure 2.2): 

 Your e-mail client connects to Gmail’s SMTP server at
smtp.gmail.com using port 25.

 Now, the e-mail client communicates with Gmail’s SMTP
server to give the email address of the sender and the email
address of the recipient along with the body of the message.

 The Gmail’s SMTP server takes the "to" address
(dineshskt@yahoo.com) and breaks it into two parts: the
recipient name (dineshskt) and its domain name (Yahoo.com).
If the "to" address is another user at domain gmail.com, the
SMTP server would simply pass the message to the POP3
server of gmail.com. Since the recipient is at another domain
which is yahoo mail, Gmail SMTP’s server needs to
communicate with Yahoo mail’s SMPT server.

 To communicate with Yahoo mail’s SMPT, Gmail’s SMPT
server needs the IP address of yahoo mail’s SMPT server. So,
it communicates with Domain Name Server (DNS) and
requests, "Please give me the IP address of yahoo.com SMTP
server" The DNS replies with the one or more IP addresses of
the SMTP server(s) on which Yahoo mail operates.

 Now, Gmail’s SMTP server connects with the SMTP server at
Yahoo mail using the IP address and port 25. Gmail’s SMTP
server hand over the message body to the Yahoo’s SMTP
server. The SMTP server at yahoo mail recognizes the
username dineshskt at Yahoo mail. So it passes the message to CCC-1.1/221
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yahoo mail's POP3 server, which puts the message in 
dineshskt's mailbox. 

Figure 2.2: Overall steps involved in sending an email to Dinesh. 

Email Flaws 

Unwanted e-mails more commonly known as spam are the biggest 
problem of the e-mail. With hundreds of these junk emails, your 
occasional useful emails get lost. Fortunately, most email service 
providers provide sophisticated filters to sort out the unwanted emails 
automatically. But these filters are not effective always. However, you can 
identify and report the spam to block them from incoming in future. You 
can also identify spam correctly by following details: 

 The sender email address does not belong to someone you
recognize.

 They contain strange attachments or unfamiliar links that causes
downloading of malware, viruses, and other types of malicious
files.

 The spam mails ask to enter your personal details like bank
account numbers, debit/credit card numbers etc.

 You can also identify spam from the email service provider of the
sender used to send the message.
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Check your progress 
Q.1   How does the “Bcc:” ("blind carbon copy") differ from “cc:” 

("carbon copy") field? 

Q.2   What are the some flaws of Email? 

Q.3   What are the various things you can send through an email? 

2.4 FTP 

File Transfer Protocol (FTP) is commonly used for downloading 
and uploading files on Internet. This protocol is used to access directories, 
folders, software, data and text files on remote Computers. FTP works 
similar to Client/Server model as shown in Figure 2.3. There is a FTP 
“Client” program running on your computer that enables you to access 
remote computers. The FTP client program takes FTP commands from 
user and sends them to the remote computer. To access a remote FTP 
server, login credential in form of User Login name and password are 
required. If one does not have an account in the remote FTP server, still he 
can access to the remote FTP server using anonymous login with limited 
access. Using anonymous login, anyone can login a FTP server and can 
access public file archives. FTP works on two different TCP ports: 20 and 
21. For successful FTP transfer, both these ports must be opened on the
network. 

Figure 2.3: FTP Connection 

The basic objectives of FTP are: 

1. Reliable and efficient transfer of files between computers on the
internet.
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2. Promote sharing of computer programs, files and other data over a
network.

3. Encourage direct or indirect access to remote computers.

4. Shield a user from variations in file storage systems among hosts.

Using ftp program in Windows 

In Windows OS, you can use ftp program directly from Command 
Prompt. You just need to simply type ftp followed by the name of the 
remote computer (domain name or IP address of the FTP server) to which 
you want to connect with. For example, 

ftp ftp.cs.brown.edu 

After giving above command, the ftp client program makes a connection 
with the remote computer. Once you are connected with the remote 
computer, you will see a welcome message like shown in Figure 2.3: 

Figure 2.4: FTP connection 

Sometimes, you may be asked for your username and password associated 
with the remote machine. FTP is built on the client-server model where 
one computer acts as a client that sends instructions to other computer 
called server. Now a day, most Web browsers are built with FTP utilities 
that allow files to be transferred automatically to your computer from 
Internet URL. Your browser still uses FTP protocol, but it saves you from 
direct use of the ftp programs. You can start a FTP session in Windows 
OS by following these basic steps: 

1. Start FTP client program by typing “ftp” on command promptLine
“C>”.
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2. Now type an address of FTP server to which you want to get
connected with.

3. Type Login Name and then a password associated with that
particular login name to identify yourself on the FTP server.

4. FTP server will verify the login credentials – username/password.
After that, you can access the files on FTP server.

5. Navigate to the desired directory to access files. You can also
change the directories

Commands Description Example 

ls / dir Listing the contents of remote directory ftp> ls 

Cd Changing the remote and local directory ftp> cd dir1 

Put Uploading a file to FTP server ftp> put filename 

Get Download a file using ftp ftp> get FILENAME 

Pwd Display current directory on the remote 
system 

ftp> pwd 

Table 2.1: Basic ftp commands 

Check your progress 
Q.1  What are the basic objectives of File Transfer Protocol? 

Q.2  What are the use of ls, cd and pwd commands on FTP? 

2.5 Telnet 

You have already read about Telnet in last chapter that it is used 
to remotely control Web servers. You can communicate with server 
computers by entering commands on the Telnet program. These 
commands will be executed on the server like you are entering directly on 
the server. The Telnet program grants you direct control over all the rights 
on files and applications on the server as an actual user. To start a Telnet 
connection, you must log in to a server computer by entering a 
valid username and password. The telnet program only requires 
a keyboard because everything on the screen display as text. Please note 
that TELNET is a network protocol used to provide a command line 
interface for communicating with a device over internet. While telnet is a 
client program that supports the TELNET protocol over TCP. Now a day 
Telnet is rarely used to connect remote devices anymore. These days most 
devices can be configured and managed simply through web based 
interfaces. These are more secure and easy to use than Telnet. Since Telnet 
transfers all data in plain text without any encryption, it is considered as CCC-1.1/225



insecure. It is possible for intruder to capture your username and password 
when they are being transmitted. If you are concerned about your data 
being transmitted, you can use SSH protocol (also referred to as Secure 
Shell). 

Difference between Telnet and FTP 

Following are the main differences between FTP and Telnet. 

1. Telnet is used for issuing commands to a remote server and listen
the responses while FTP is usually used for uploading files to a
remote computer.

2. Telnet is limited to use with command line only (like Command
prompt) while FTP can be used from a variety of programs
including command line, a dedicated application, and even with
web browsers.

3. Telnet is always been unsecured and widely replaced by SSH
while FTP can be used in a secure way using FTPS and SFTP.

4. Telnet is now generally used as diagnostic tool to check working
of certain network services while FTP is a reliable and safe method
of uploading files to web servers.

TELNET Basic Commands 

TELNET protocol defines a standard representation for some functions: 

 IP - Interrupt Process 

 AO - Abort Output  

 AYT - Are You There  

 EC - Erase Character 

 EL - Erase Line  

 SYNCH -  Synchronize

 QUIT -  quit session 

How to Use TELNET in Windows 

You can use TELNET in Windows operating system. Windows OS 
provides a telnet program that uses TELNET protocol for remote 
communication with server. This telnet program can be accessed from the 
Command Prompt window where you type Telnet commands. This Telnet 
program is available in every version of Windows, but you first need to 
enable it before using it. The Telnet program can be enable in Windows 
10, Windows 8, Windows 7, and Windows Vista through following steps. 

 Open Control Panel.

 Select Programs and Features from the list of category items and
open it.CCC-1.1/226
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 Click on the Turn Windows features on or off link on the left
side of the page.

 Now you will see a window containing list of Windows Features.
Select the check box next to Telnet Client.

 Now click OK to enable Telnet.

In Windows XP and Windows 98, the Telnet program is already installed 
and ready to use.  

Executing TELNET Commands in Windows 

Telnet commands are very easy to execute. These commands can be used 
from command prompt. You just need to open command prompt and then 
type telnet followed by any Telnet command. The telnet command syntax 
is: 

telnet [host name] [port] 

Replace "[host name]" with the IP address or domain name of the server 
(for example "rainmaker.wunderground.com") and replace "[port]" with 
the port number of desired service and then press "Enter." If asked, type 
the username and password to log in the remote computer. Port number is 
not required to specify, if it is available on the default port 23. Otherwise 
you need to specify the port number also, if it is other than 23. For 
example, running the command “telnet towel.blinkenlights.nl 23” is the 
same as running “telnet towel.blinkenlights.nl”. But it is not the same 
as “telnet towel.blinkenlights.nl 666”. This would connect to that same 
server but on port number 666. 

Telnet Games & Additional Information 

You can access many useful information all in text form by using a 
command prompt and the Telnet program only. The majority of Telnet 
servers do not require any default Telnet user name and password to log 
on. You can check the weather at Weather Underground by typing 
following command: 

telnet rainmaker.wunderground.com 

You can even talk to an artificially intelligent psychotherapist 
named Eliza. You just need to type below command to connect with 
Telehack. If you are asked to choose any command, Enter eliza. 

telnet telehack.com 

The text based access to internet resources can be fun and exciting. Telnet 
can be used to access a variety of resources available on the internet. 
Below is a list of a few interesting places you can try.   

1. rainmaker.wunderground.com :: weather via telnet!

2. nyancat.dakko.us :: ANSI art animation of "poptart cat", with
support for many different terminals (cool screenshots!) CCC-1.1/227
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3. mapscii.me :: You can view the map in terminal window

4. india.colorado.edu 13 (Get the time) :: get the time

5. telnet.wmflabs.org :: telnet gateway to wikimedia content

6. telehack.com 23 :: Telehack

7. telehack.com :: Telehack - web

8. freechess.org 5000 :: freechess.org

9. towel.blinkenlights.nl 23 :: Star Wars asciimation

10. towel.blinkenlights.nl 666 :: The Bofh Excuse Server

11. mtrek.com:1701 :: mtrek (star trek themed game)

12. xmltrek.com:1701 :: xmltrek (star trek themed game)

2.6 Summary 

In Summary, you learned that: 

1. An email is a digital message that uses your keyboard to write on
the electronic devices like a phone and a computer.

2. The File Transfer Protocol is commonly used Protocol to access
directories or folders, software, data and text files on remote
Computers.

3. Telnet is used to remotely control and communicate with Web
server.

2.7 Terminal Questions 

Q.1 How Does Email works? 

Q.2 How do you open telnet program on Windows Operating system. 

Q.3 What is the use of File Transfer Protocol? 

Q.4 Write the steps involve in sending an Email. 

Q.5 Explain how you can use File Transfer Protocol in Windows.  

Q.6 How does the FTP different from Telnet? 

Q.7 Discuss some of the useful information that you can access through 
TELNET. 

Q.8 Explain how you execute TELNET Commands in Windows. 
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UNIT-III 

BROWSERS 

Structure

3.1 Introduction 

3.2 Objective 

3.3 History of Web Browser 

3.4 Popular Web Browsing Software 

3.5 Using A Web Browser (Internet Explorer 8) 

3.6 Searching words and phrases with the Search Box 

3.7 Adding Bookmarks/Favorites Folder 

3.8 Printing Web Pages 

3.9 Using RSS Feeds 

3.10 Using Plugins or Add-ons 

3.11 Using Browsing History 

3.12 Summary 

3.13Terminal Questions 

3.1 Introduction 

A web browser is a software that is used for accessing various 
resources available on the World Wide Web.  Your computer already 
comes with a preinstalled browser. Personal computers with Microsoft 
Windows come with Internet Explorer as a default browser, while Macs 
operating systems come with Safari as a default browser. If you want to 
use different browser, you can download Google Chrome, Firefox or 
Opera. All of these browsers are freely available. The main functionality 
of any Web browser is to fetch web pages and display them on users’ 
devices. The Web browsers retrieve web resources like web pages, 
images, and videos from the World Wide Web by their unique URL and 
display them on your device. When enter a URL, 
like https://en.wikipedia.org/, into your browser, it retrieves the web page 
with the Hypertext Transfer Protocol. Web pages contain several 
hyperlinks to other web pages. When you click on the hyperlink, your 
browser navigates to a new Web page and thus the process of bringing 
new Web pages begin again. 
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3.2 Objective 

After studying this chapter, you should be able to: 

 Explain what the Web browser is.
 Describe various features offered by popular Web browsers.
 Explain the various operations that you can perform with a Web

browser.

3.2 History of Web Browser 

The first web browser called Worldwide Web comes in 1990. It 
was developed by Sir Tim Berners-Lee. After one year, he developed 
another browser called Line Mode Browser in 1991 that displayed web 
pages on dumb terminals. In 1993, world's first popular browser called 
Mosaic came. This browser came with graphical interface that allowed 
even an average person to easier use and access the World Wide Web 
resources. This had brought boom to the Internet in 1990s and the Web 
grew very rapidly. Marc Andreessen, the leader of the Mosaic team soon 
opened his own company called Netscape and released Netscape 
Navigator browser in 1994. Soon after its release, the Navigator became 
the most popular browser at that time. In 1995, Microsoft introduced 
Internet Explorer that was giving a tough competition to Netscape. Soon 
after its release, Internet Explorer gained a dominant position in the 
market and attained a peak market share of Internet over 95% by 2003. 
Later, Netscape became the Mozilla Foundation and released an open 
source browser called Firefox in 2004. By 2011, Firefox had reached a 
market share of 28%. In 2008, Chrome browser was released by Google 
and got a huge success. It took away the market share of Internet Explorer 
and became the most popular browser during 2012. The market shares of 
internet for various browsers are shown in Figure 3.1. 

Figure 3.1: Usage share of web browsers according to StatCounter. CCC-1.1/230



3.4 Popular Web Browsing Software 

Basic features of web browser 

Almost all browsers offer you similar features. They allow you to open 
multiple Web pages simultaneously, either in different tabs or in different 
browser’s windows. They provide you support for the use of extensions. 
The basic features of a Web browser are following:  

 Back and forward buttons (Navigation buttons) is used to go to
the previous visited web page or forward to the recent one.

 Refresh or reload button is used to reload a current web page.
Most browsers  store local copies of visited pages to speed up
performance when it is accessed again. This sometimes prevents
you to see the most updated information. When you click
on refresh button, this will forcefully bring you the latest version
of the Web page.

 Stop button cancels web browser's communication with a server
and stops loading of page. It is very useful to stop loading of
malicious sites, if accidentally opened.

 Home button loads a predefined web page. You can set any web
page as browser's home page.

 Address bar is used to enter website’s URL to view a web page.

 Bookmark button: It is user defined button that is used to switch
to a particular website which is added to the bookmark. It is very
useful to create a bookmark button for frequently visited Websites.

Figure 3.2:  Basic control buttons in Firefox browser. 

NCSA Mosaic: 
NCSA Mosaic was the first browser to achieve popularity among the 
general public. This browser has popularized the World Wide Web. There 
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are several other browsers available that time, but Mosaic’s clean and 
easily understood user interface has opened the web to the general public. 
It was also available on Windows operating system and had simple 
installation. The original version of Mosaic was released for UNIX 
operating systems. Soon after this release, Mac version and Windows 
version were also released. This made Mosaic the first browser with cross-
platform support of several operating systems. Later, it had shifted its 
focus to other research and development activities. So, NCSA had stopped 
developing Mosaic and discontinued its support in 1997. But, you can still 
download Mosaic browser along with its documentation at NCSA’s FTP 
site-ftp://ftp.ncsa.uiuc.edu/Mosaic/. The important features that were 
offered by Mosaic are following: 

 The main feature introduced by Mosaic was the inclusion of
the image tag. This had made possible the inclusion of images with
text in Web pages. While, earlier browsers only allowed the
viewing of images as separate files.

 It offered a graphical interface (shown in Figure 3.3) with
clickable buttons to easily navigate to Web pages. It had also
provided controls to scroll the text with ease.

 Earlier browsers provided hypertext links in form of reference
numbers and users typed the corresponding URL to navigate to the
linked web page. But Mosaic had made another innovation with a
new form of hyperlink. This new form of hyperlink allowed the
users to simply click on the link to retrieve the corresponding Web
page.

 Mosaic facilitated support for sound, graphics, and video clips.
Mosaic also added other features like bookmarks and history files.

Figure 3.3:  NCSA Mosaic 3.0 for Microsoft Windows CCC-1.1/232



Netscape Navigator: 
Netscape Navigator is a discontinued web browser that was developed by 
Netscape Communications Corporation. During 1990s, it was a dominant 
web browser in term of usage share, but it got almost disappeared by 
2002. It was available for Windows, UNIX, Macintosh, Linux and OS/2 
operating systems. The GUI of Netscape Navigator is shown in Figure 3.4. 
One remarkable innovation introduced by Netscape was the display of 
texts in a web page as graphics continue to download. So, people could 
begin reading text in a web page after several seconds of entering any web 
address, while rest of the content (like graphics) of the web page continue 
to download. Earlier, web browsers did not display a page until all 
graphics within the Web page downloaded. This often caused a user to 
look a blank page for several minutes. Netscape Navigator introduced 
many new features along with some improved features: 

 It offered support for cookies that store user-specific information
and settings for giving a customized experience.

 It provided support for frames that divide a Web page into multiple
parts and each part is allowed to display its content independent of
other parts.

 It offered support for plugins to perform additional functions.
 It introduced an e-mail client called Netscape Mail and Usenet

News called Netscape News.
 It added support for LiveScript (now known as JavaScript)
 It added support for FTP uploading.
 It provided support for proxy auto-config that allows Netscape to

automatically choose an appropriate proxy server for fetching a
given URL.

Figure 3.4:  Netscape Navigator Browser Interface CCC-1.1/233
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Google Chrome: Chrome is designed to be fast, simple and secure web 
browser for the modern World Wide Web. It is compatible with all 
Operating System and devices. Chrome offers you the following features: 

Speed: Chrome is designed to be as simple as possible.  Chrome launches 
quickly from your desktop when you double-click the Chrome icon and 
runs complex web applications lightning fast. Chrome combines search 
with address bar so that you can type in both searches and web addresses 
in Chrome's address bar. The address bar has auto-complete functionality 
that gives you suggestions for searches and web addresses while typing. 

Simplicity: chrome's window is clean, simple and run smooth. In Chrome, 
you can open multiple web pages at the same time in multiple tabs all in 
either same Window or in different Windows as shown in Figure 3.5. You 
can easily drag and drop Chrome’s tab and rearrange them.  Chrome offers 
you a built-in PDF viewer to view PDF files with the chrome browser. 
You do not need to launch a separate PDF reader to view the pdf files 
available on the web. When you close Chrome, it remembers all the tabs 
opened previously. So, you can start your browsing right where you left 
off last time. 

Figure 3.5: Multiple tabs in Chrome. 

Security: Chrome has built-in malware and phishing protection to keep 
you safer on the Internet. It shows a warning message when you visit 
suspected web pages containing malware or phishing. Chrome regularly 
checks for latest updates to ensure that your version of Chrome has the 
latest security features and fixes. 

Privacy: Chrome controls your private and sensitive information while 
you do browsing. Chrome offers you Incognito mode feature where all 
browsing and download history get deleted as you close the incognito 
window. You can open normal window, as well as incognito window 
separately at the same time. 

Customisation: You can customize your Chrome in many ways. Chrome 
offers you a number of extensions from the Chrome Web Store to give 
you more productive and better browsing experiences. 
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Signing in: Chrome offers you Sign in feature by which you can access all 
your bookmarks, extensions, passwords, history, settings and preferences 
in all your devices. You can also signed in to all your favourite Google 
services as shown in Figure 3.6. 

Figure 3.6: Sign in to Chrome. 

Mozilla Firefox: 
Firefox is designed for simplicity, security and extensibility. It is available 
for Windows, Linux, MacOS and android Operating System. It offers you 
lots of extensions and themes to customize your Firefox browser as per 
your need. The main features of Firefox include: 

Smooth browsing: Firefox offers you to open multiple web pages at the 
same time with multiple tabs in either same Window or different 
Windows. You can quickly switch between these tabs as shown in Figure 
3.7. 

Figure 3.7: Multiple tabs in Firefox. CCC-1.1/235



Sync your devices:  Firefox offers you uninterrupted browsing with 
Firefox Sync feature. This feature allows you to easily access your 
bookmarks, tabs and passwords across all your devices like desktop, 
mobile and tablet. Your Firefox Account stores all your web stuff even 
your open tabs and saved reads. This allows you to resume your browsing 
where you left off last time. 

Customization Features: You can customize your Firefox with thousands 
of extensions (as shown in Figure 3.8) like LastPass, uBlock Origin, 
Evernote etc. These extensions are available on Firefox Add-on page. You 
can also change the Firefox theme as per your mood from theme 
categories. 

Figure 3.8: Firefox Add-on page. 

Private Browsing: Firefox offers you Private Browsing mode (shown in 
Figure 3.9) to protect your privacy. When you close this Private Browsing 
window, it automatically erases all of your online information like 
passwords, cookies and history. Firefox’s Private Browsing blocks ads to 
browse faster and freely. CCC-1.1/236



Figure 3.9: Private browsing with Firefox. 

Check your progress 
Q.1What are the features offered by the Netscape Navigator? 

Q.2Explain some key features offered by Google Chrome. 

Q.3What do you mean by Private Browsing? 

3.5 Using A Web Browser (Internet Explorer) 

Internet Explorer (commonly abbreviated as IE) is a web 
browser developed by Microsoft and included as default browser in 
Microsoft Windows operating systems. Earlier, Internet Explorer was one 
of the most widely used web browser. It had attained a peak usage share of 
about 95% by 2003. 

Understanding the Internet Explorer Window 

IE provides you various options for ease of your browsing. Some of 
important features are shown in Figure 3.10. CCC-1.1/237



G 

Figure 3.10: Various elements of IE. 

A
Title bar: This displays the name of 
the currently active Web page and 
program. 

F
Favourites Button: This gives you 
one-click access to your favourite 
or frequently visited Web pages. 

B Address bar: Here you type web 
addresses to visit a Web site.  D

Navigation buttons: Theses 
buttons are used for going 
backward or forward among web 
pages that you have visited already. 

C
Tabbed browsing: This Open up 
multiple Web pages in separate tabs 
for faster, more convenient 
browsing. 

E

Minimize, Maximize, and Close 
buttons: These buttons are used to 
minimize, resize, or close Internet 
Explorer. 

G Command Bar: This is used to 
customize Internet Explorer. 
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AutoComplete feature in the address bar 

When you browse the internet, you come across many web pages. It is 
difficult for individual to remember all those URL of these web pages. So, 
if you can’t remember a URL, the AutoComplete feature of IE helps you 
as shown in Figure 3.11. When types a URL in the address bar, the 
autocomplete feature (in address bar) will automatically recall and display 
sites based on your past visit. Based upon what you type, it searches into 
your History, Favorites, and RSS Feeds for correct website match. You 
can use this feature of IE using following steps: 

 Click the address bar and begin typing. Internet Explorer begins
searching through your History, Favorites, and RSS Feeds for
matches based on what you’ve typed.

 Click the result that you want to view.

Figure 3.11: AutoComplete feature in the address bar. 

Refresh a page 

Sometimes a web page loads slowly. This happens due to many reasons. 
Usually this happens when the server computer that stores the Web page is 
handling too many requests. In other word many people are trying view 
the page at the same time. Refreshing the page may solve the problem. On 
clicking on the Refresh button, the data for the Web page is automatically CCC-1.1/239



reset, and the page loads again. You can also refresh a Page by pressing 
the <F5> key. Also, refreshing the web page will bring you a recent 
version of the document. 

Browsing with Tabs 

Tabs in the IE allow you to browse multiple web pages in a 
single window. These multiple pages are displayed in tabs at the top of the 
browser window. You can switch to a particular web page by switching to 
corresponding tab. This feature is useful for users who want to view 
multiple web pages, but don't want to open multiple browser windows. 
This also leaves more room on your taskbar. In Figure 3.12, you can see 
that the IE window has two tabs open. You can easily switch between 
these Web pages. Internet Explorer starts with only one tab where you can 
open a web page. If you further want to view other web pages, you can 
open additional tabs. 

Figure 3.12: Two or more Web pages can be viewed in a single 
window using tabs. CCC-1.1/240



Some of the important features which are helpful in browsing with tabs 
are: 

 Most browsers that support Tabs such as Internet Explorer,
Chrome and Firefox allow you to open a link within a web page in
a new tab by clicking your mouse’s middle-button (mouse wheel).

 To open a new Tab, click on the new tab button just beside the
current Tab. You can also open a new tab using the keyboard
shortcut key Ctrl+T. You can also open a previously closed Tab
by pressing Ctrl+Shift+T.

 To close a Tab any time, click on the X on the top and right-hand
side of the Tab or press Ctrl+W on your keyboard.

 To view a tab, click over it. Alternatively, you can press Ctrl +
Tab to cycle through open tabs.

Changing the Home Page 

 Most of you have certain favourite websites that you want to check
each time when you open Internet Explorer. You can set these
frequently opened websites as your home page in Internet
Explorer. Now, each time when you launch IE, it opens with your
favourite websites. The home page can be a corporate website like
Google, a social website Facebook, or even your personal web site.
You can change Home Page of your IE by following steps:

 Open the web page in IE that you would like to make your home
page. You can open additional pages in multiple tabs to use
multiple pages as your home page.

 Click the Tools button ( ) at the right upper corner of the
browser’s window and then select Internet Options.

 An Internet Options dialog box (as shown in Figure 3.13) will
appear. Under Home section in General tab, you  will see several
options for setting the home page:

Use current: This button allows you to set current web page or any
additional pages currently open in tabs as your new home page(s).

Use default: When you click this button, a default home page:
www.msn.com is set.

Use blank: When you click this button, no web page will be set as
a home page.

 Click on “Use current” button. The URLs for the current web page
and additional web pages if open are listed in the box. If you are
using multiple home pages, all URLs will be listed.

 Click on Apply, and then select OK. Next time, when you open the

IE or click on the Home button ( ) in between your browsing,
your home pages will be opened automatically. CCC-1.1/241
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Figure 3.13: Home page settings in the Internet Options dialog box. 

3.6 Searching words and phrases with the Search 
Box 

When you are viewing any web page in your browser, you can 
search for any words and phrases in the web page. Web browser comes 
with a Find tool, which searches the web page for matching words or 
phrases. Search phrases that you typed in the Find tool will be displayed at 
all places in the Web page where it appears. Your browser will also 
highlight all your search phrases that appear at different places in the Web 
page. In Internet Explorer, you can use Find on Page function to find a 
specific word or phrase on a Web page as follows: 

 Press <Ctrl> + <F> on your keyboard. The Find On Page toolbar
will appear with a cursor in the Find text box as shown in Figure
3.14. Alternately, you can also open the Find On Page toolbar byCCC-1.1/242



pressing the <Alt> key and then going to the Edit menu. Click on 
Find on this Page option that appears there. 

 Type a word or phrase that you want to search within the web page
and then press <Enter>. IE searches the entire Web page to find all
matches and highlights them with yellow color. You can also see
the number of matches at the far right of the Find On Page toolbar.
If IE does not find any match, the Find On Page toolbar displays
“No Matches Found” message. You can also do more specific or
exact searches. For this, click On the Options button on the Find
On Page toolbar and select Match Whole Word Only or Match
Case.

 Click on Next or Previous button to see all the matches.
 Click on Close button at the Find On Page toolbar when you are

finished finding matches on the page.

Figure 3.14: Find On Page toolbar appears below the Web page Tab. CCC-1.1/243



3.7 Adding Bookmarks/Favorites Folder

You come across a number of useful web pages on Internet that 
you want visit them regularly. But, unfortunately you could not remember 
all the URLs. Your Browser provides “Favorites” feature that allows you 
to easily and quickly access all these web pages at later time. Favorites 
stores all your favorite web pages in a single place. It is a great way to 
save and organize frequently visited web pages. Favorites also 
called bookmarks in most browsers. IE provides you Favorites Centre to 
save these web pages and view them later. In IE, You can add web pages 
of your choice to Favorites by following steps:  

 Open the web page that you want to add to a favorite.

 Click on the Favorites button as shown in Figure 3.15. The
Favorites Center appears similar to shown in Figure 3.16.

 Click Add to Favorites button. “Add a Favorite” dialog box will
appear. Alternatively, you can press Ctrl+D on your keyboard to
open “Add a Favorite” dialog box. You can also add several Web
pages to the Favorites list at once. Just open all web pages on
different tabs and then click the Favorites button. Click “Add to
Favorites” arrow button and select “Add Current Tabs to
Favorites” option.

Figure 3.15: Favorites Button. 

 The “Add a Favorite” dialog box will appear, enter a meaningful
name there. You may stick with the default name or change it
using the Name textbox. Now, choose where you want to save the
new favorite page. You can place it in any folder or subfolder
using the "Create in" drop-down list. If you don’t choose any
folder, it will be saved in the Favorites folder.

 Finally, click Add button. The Web page is added to the Favorites
Center.

Viewing saved Web pages in Favorites 

Once a Web page is added to Favorites, you can view it from the Favorites 
Center. CCC-1.1/244



You just need to follow these steps: 

 Click on the Favorites button. The Favorites Center will appear
similar to shown in Figure 3.16. You can also open the Favorites
Center by pressing
<Ctrl> + <I>  from your keyboard.

 Now, click the Favorite tab. Find the folder where you saved the
web page and then click on the web page you would like to open.
The Web page will be displayed.

Figure 3.16: Favorites Center in the IE. 

Check your progress 
Q.1  Why do you add certain web pages to the Favorites? 
Q.2  Can you search for words and phrases within a web page? 

Explain how? 
Q.3  Explain the benefits of Browsing with Tabs. 

3.8 Printing Web Pages

During browsing, you come across several web pages containing 
useful information like articles, research papers, graphics etc.  Sometimes, 
you want to print them for later use. For example, you may want to print a 
receipt that is generated online during your online transaction. These web 
pages can be printed from your browser. But, the content of Web pages CCC-1.1/245



are arranged in a different manner than other types of printable materials 
like a standard word processing document. You may find some options 
when printing web pages in your browser that do not normally seen when 
printing from other programs. You can adjust the setup of a web page and 
can also include additional information in the headers and footers.  

Previewing and Printing Web Pages 
Before you print out any Web page, it is good to see how it will look like. 
To print a web page in IE, first click on Print Preview option. This option 
can be located under Print option of Tools button ( ).When you click on 
this option, a Print Preview window will appear and the Web page will be 
shown in Print Preview mode. After you have customized the text size, 
margins, orientation, Header and Footer, just click on Print icon next to 
Print Preview button to print the document. Any Web page can be printed 
in the desktop version of IE by following these steps: 

 Open a web page in Internet Explorer that you want to print.

 Click the Tools button ( ) at the right upper corner of the
browser.

 Click on the Print arrow button and select Print Preview.

 The web page will be shown in Preview mode. Here, you can
customize the appearance of the web page to be printed using
various options as shown in Table 3.1.

Icon Commands Description 
Print Prints the Web page. 
Portrait Orients the page vertically. 
Landscape Orients the page horizontally. 
Page Setup Opens the Page Setup dialog box. 
Turn headers 
and footers on 
and off 

Display additional information about the 
Web page at the top and bottom of the 
page. 

View Full 
Width 

Zoom the Web page to the full width of 
the print preview window. 

View Full Page Zoom out to show the full page in the print 
preview window. 

Show Multiple 
Pages 

View multiple pages on the preview 
screen 

Change Print 
Size 

Stretch or shrink the Web page to fit the 
printed page. 

First Page / Last 
Page 

Go to the first page/last page. 

Previous Page / 
Next Page 

Go to the previous page/next page. 

Adjust margin Change the page margins by dragging the 
horizontal and vertical markers. 

Table 3.1: Print Preview Commands CCC-1.1/246



 After you have specified page setup options, click on Print button
to print the document. Sometimes many Web sites already provide
print option for printing their Web pages, like receipts which is
already customized for printing.

Quick print a Web page 

You can directly print any web page without any customization. Make 
sure that your printer is turned on and ready to use and then follow these 
steps: 

 Click on Tools ( ) at the upper right-hand corner of the IE
window.

 Move your mouse pointer over Print option and click on Print
option from drop-down menu. This will open a Print dialog box as
shown in Figure 3.17. Here you can specify various print options
as shown in Table 3.2. You can also open the print dialog box
using keyboard shortcut: Press Ctrl + P.

Figure 3.17: Print dialog box. 

 Make sure that the appropriate printer is selected and then
click Apply (if you made any changes) button.

 Finally, click on Print button to print the Web page.
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Select Printer This will show a list of all printers that 
have been configured for use. Make 
sure that the printer you want to use is 
highlighted and selected here.  

Page range This allows you to specify which pages 
you want to print using several options:  
All: Prints entire pages in the 
document.  
Current page: Prints only the page 
you’re currently on.  
Selection: Prints only selected content 
in the web page.  
Pages: This would Print only those 
pages that you specify here. You can 
specify a range of pages with a hyphen 
(e.g 5-8). You can also specify separate 
single pages with a comma (e.g 3,7). 

Number of copies Specify the number of copies you want 
to print 

Table 3.2: Settings in Print Dialog Box. 

Printing background Colors and Images 
Sometimes, you do not want to include background color and images 
while printing a web page. These background color and images consume 
more inks. If you are more interested about the content than its 
background colors and images, it is better to turn off this. This option need 
to be specified from the browser itself. In IE, you can disable this option 
by following these steps: 

4 Go to file menu and click on Page Setup option. If you do not see
the File menu, press ALT. 

5 In the Page Setup dialog box as shown in Figure 3.18, unselect
the Print background Colors and Images check box. 

6 Click OK to close the Page Setup dialog box.

7 Print the Web page again.

3.9 Using RSS Feeds 

Most Websites like Facebook, Twitter, LinkedIn, news, 
government site etc. frequently update their contents for readers. You can 
add such Websites as a favorite in Internet Explorer and check their 
updated content regularly. But, Websites’ RSS feed are more convenience 
way to get the updated contents. Once you subscribes to a Website’s RSS CCC-1.1/248



feed, you can get the updates from the Website directly delivered via RSS 
feed.  So you do not need to check the Website regularly for updates.  RSS 
feed (Short for Really Simple Syndication or Rich Site Summary) 

Figure 3.18: Page Setup dialog box. 

is a revolutionize way of interacting with online contents. You may have 
seen text or image buttons ( ) on various websites for subscribing RSS 
feed. RSS feeds benefit readers as well as Websites’s owners to deliver 
their updated contents like articles, pictures, video, or audio etc. among 
their subscriber more quickly. 

What Is a Feed Reader? 

A Feed Reader is a client software or a web application, that aggregate 
content from a variety of different RSS feed providers in a single place. 
The Feed reader quickly scan headlines or full stories at a glance from 
various RSS feed providers. You don't have to keep checking individual 
website’s RSS feed for updated contents. You can read filtered 
information from a variety of websites and customize your reading 
experience from these sources with the help of RSS reader. This saves 
your time and energy in visiting each site individually. A variety of feed 
readers are freely available on the web such as Feedly, Digg Reader, CCC-1.1/249



NewsBlur, Inoreader and Feeder. You can choose any feed reader to 
subscribe RSS feeds of your favourite Websites. The Feed reader will 
automatically pull recently updated posts from various websites and you 
can read them directly in the Feed reader. You can also move to the source 
website by clicking the link that are provided there. 

Subscribe to a RSS feed 

Once you subscribed to RSS feeds in Internet Explorer, it will download 
the new contents from its website when it is published. You can subscribe 
to several feeds as per your interest and get updates according to your 
interest only. Some of the popular RSS feed are shown in Table 3.3. RSS 
feeds can be subscribed in Internet Explorer by following these steps. 

 Open the Web site to which you want to stay updated. If the Web
site offers feed service, you can find the orange RSS feed icon in
the Website.

 Click this RSS feed icon. A list of available feeds provided by the
website will appear.

 Click on the desired feed and then click Subscribe to this feed link.
Do this for each of the feed which you want to subscribe.

 A “Subscribe to this Feed” dialog box will appear. Here, you can
change the name of the feed and folder where you wish to save.

 Finally click the Subscribe button. Internet Explorer will display
you a confirmation massage that you have successfully subscribed
to this feed.

RSS feed Description 
Times of India 
(timesofindia.indiatimes.com) 

It brings the Latest News & Breaking 
News Headlines from India & around 
the World. 

The Hindu 
(www.thehindu.com) 

It brings Latest news, analysis, 
comments, in-depth coverage of 
politics, business, sport, environment, 
cinema and arts from India's national 
newspaper. 

FrontLine 
(www.frontline.in) 

It covers latest news from physics, 
chemistry, medicine, 
astronomy, science, space, 
and technology.  

Dictionary.com  Learn a new word every day! 
Wired Top Stories 
(www.wired.com) 

Wired Top Stories The latest science 
and technology news 
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View subscribed feeds 
After subscribing the RSS feeds, you can view them in same way as you 
view the favourite websites in IE. You can follow these steps to view all 
subscribed RSS feeds. 

Figure 3.19: The Feeds tab in the Favorites Center. 

 Click the Favorites button ( ) located on the Favorites Bar.

 The Favorites Center will appear similar to shown in Figure 3.16.
Click the Feeds tab in the Favorites Center. A list of subscribed
RSS feeds will appear as shown in Figure 3.19.

 Click the desired RSS feed to view for new content. A list of
headlines and/or full articles appears in the current tab.

 Click the headline if you want to view it in its Website.

3.10 Using Plugins or Add-ons 

A browser Plugins or Add-ons are small programs that extend the 
functionality of a web browser. They are sometimes also called as browser 
extensions. Plugins give additional capability to the web browser without 
affecting viewable content of a web page. With these small programs your 
browser can perform a variety of tasks, which your browser without these 
Plugins would not able to perform. The ultimate goal of these Plugins is to 
give you a better browsing experience. The browser Plugins are similar to 
a Swiss knife by using which you can perform multiple tasks. For CCC-1.1/251



example, a Google Translate Plugin translations any web page (which is 
not in your local language) to your local language. A Google Dictionary 
Plugin helps you to find meaning of any word appearing in a web page 
without opening a new tab to find its meaning. Once you installed this 
Plugin, you can simply highlight the word to look for its meaning and then 
click on the dictionary icon that appears next to the browser’s URL field. 
Today, every browser supports Plugins. Each Plugin is coded specifically 
for a particular browser. For example, Google Chrome Plugins are 
available on Google’s Chrome Web Store. Similarly, you can find Firefox 
plugins at the Mozilla Add-ons Gallery. You can install add-ons in IE 
from the Internet Explorer Gallery by following these steps. 

 Go to the IE Gallery website and click Add-Ons,

 Click the desired add-on from the list.

 Click “Add” link of desired Add-ons that are located next to each
Add-ons

 When an installation dialog box will prompt, click on Add button.

Check your progress 
Q.1 What is the purpose of using Plugins in your web browser? 

Q.2 What is RSS Feeds? 

Q.3 How do you print any web page? 

3.11 Using Browsing History 
Just imagine, yesterday you have found an interesting website on 

gift ideas. It would help you to plan for a wonderful gift for your friend’s 
anniversary. Unfortunately, you could not remember the URL of the 
website. Internet Explorer saves your browsing history for such type of 
situations. Every time when you browse web pages, your web browser 
saves a copy of every page that you have visited. Whether you use Internet 
Explorer, Chrome, Firefox, or something else, they all keep track of your 
locations and a history of pages you have seen so far. This browsing 
history is maintained just for your convenience. Unless, you don't want 
someone else to see your browsing history such as you are planning a 
secret birthday or doing some personal browsing, it makes your online 
experience easier and better. When you are typing a previously visited 
web address on address bar, the AutoComplete feature uses your browsing 
history to give you suggestions. 

View your browsing history 
A history containing details of all the Web pages that you have visited can 
be seen in any browser. In IE, a history Tab (as shown in Figure 3.20) can 
be found under the Favorites section. This Tab contains details of web CCC-1.1/252



pages for the last several weeks. You can view the History Tab in IE by 
following steps: 

1. Click the Favorites button that appears on top right corner.

2. The Favorites Center (as shown in Figure 3.16) will appear. Move
to History Tab by clicking over it. Your browsing history details
are grouped by date. You can also open your Browsing History by
pressing Ctrl + Hon your keyboard.

3. Click the “View by list” arrow to see your history in various ways
as shown in Figure: 3.20.

4. Click a particular day to see the history. The pages are organized
by dates into different folders.

5. Click the desired folder to view the Web pages and then click a
specific Web page to view it in the browser window.

Figure 3.20: The History tab under the Favorites. 
Delete browsing history 
History feature in your browser makes your online experience easy and 
convenient. If you do not have anything to hide from others, then it does 
not bother you. But most of you would not like if someone can spy your 
browser history to see what web pages you have visited. This would be the 
invasion of your privacy, if someone gets access to your computer and 
searches your history. If you are concerned about your privacy, you can CCC-1.1/253



remove Web pages from your browsing history or delete the history 
entirely. The browsing history in IE can be deleted by following these 
steps: 

1. Click on the Tools button that appears at top right corner. Then
select Safety option, and then click on the Delete browsing history
option.

2. A Delete Browsing History dialog box will appear as shown in
Figure 3.21. Here, you will see a number of options related to type
of data stored on your computer. Choose the types of data or files
you want to delete from your computer.

3. Preserve Favorites website data: This option is selected by
default. When it is selected, it will instruct IE to preserve some
stored data (like cache and cookies) from your Favorites. The rest
of the data components for all other websites will be cleared.

4. Temporary Internet files and website files: This option is also
selected by default. The selection of this option removes images,
multimedia files, and even full copies of Web pages that are stored
on your hard-disk. These are stored on your hard-disk to reduce
page load time on subsequent visits. These files as a whole are also
known as your browser's cache.

5. Cookies and website data: When a website is visited, user-
specific information and settings are stored in a text file on your
hard-drive. The website uses this text file to give you a customized
experience by retrieving the user data such as your login
credentials or session data. When this option is selected, this will
delete all these files from your hard drive.

6. History: IE maintains a list of Web page addresses that you have
visited. When this option is selected, all these records will be
deleted from your computer.

7. Download History: IE keeps track of all the files downloaded
through it. Selection of this option wipes this download history
from your hard drive.

8. Form data: IE stores a portion of the data that you enter into a
Web form. Next time,
when you fills similar kind of form, some of its entries gets auto-
populated. For
example, after typing few letters of your name in a form, your
entire name gets auto- showed. Although, this provides you a
convenience while filling forms, but it may reveal some of your
private information to others. This may cause a privacy issue or
security risk. A selection of this option deletes all form data that
are stored so far.

9. Passwords: Nowadays, many passwords are needed for various
accounts on the Web. IE helps you to avoid typing these passwords
every time you visit these websites. This can be a welcome featureCCC-1.1/254



in the web browser that store these passwords for later 
use. But sometimes you may not want your passwords to be stored 
locally, especially 
when other people use your computer. When this option is 
selected, it instructs IE to delete all saved passwords. 

10. Tracking Protection, ActiveX Filtering and Do Not Track:
ActiveX controls are small apps that are embedded in the websites
to provide you interactive contents such as videos and games and
toolbars. However, these apps might cause you trouble some time.
For example, they might collect sensitive information, install
software without your consent, or allows someone else to remotely
control your PC. The ActiveX Filtering prevents websites from
installing and using these apps. When the ActiveX Filtering is
enabled, videos, games, and other interactive content might not
work. When Tracking Protection, ActiveX Filtering and Do Not
Track option is selected, all the websites you've excluded from
ActiveX Filtering, and data used to detect tracking activity get
deleted from your browser.

11. Select the check boxes for the desired items you want to delete.

12. Finally, click the Delete button. The browsing history will be
deleted.

Figure 3.21: The Delete Browsing History dialog box. CCC-1.1/255



3.12 Summary 

In summary, you learned: 

1. Some Popular Web Browsing Software such as NCSA Mosaic,
Netscape Navigator, CHROME, Mozilla Firefox and Internet
Explorer and various features offered by them.

2. The various features available in the Internet Explorer make your
browsing experience smoother.

3. You learned that how do you search any word or phrase appearing
within a Web page.

4. Adding Bookmarks to Favourites helps you to access Web pages
quickly at later time.

5. You can print any web page containing useful information like
articles, research papers, graphics etc. for later use.

6. RSS feeds deliver the updates from the Website directly and more
quickly. You do not need to check the Website regularly for
updates.

7. Browser Plugins are small programs to extend the functionality of
a web browser.

8. Web browsers keep track of your locations and a history of Web
pages that you visited in form of Browsing History.

3.13 Terminal Questions 

Q.1 How do you access RSS feeds to which you’ve subscribed? 

Q.2 How do you access your browsing history? 

Q.3 What are the features offered by NCSA Mosaic browser? 

Q.4 What does the Refresh button in the browser do? 

Q.5 What is the homepage? How can you save more than one 
homepage in Internet Explorer? 

Q.6 Describe the various features offered by Mozilla Firefox. 

Q.7 How do you view the Favorite web pages in IE? 

Q.8 What are the various options that are available for printing any 
web page? 
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UNIT-IV 

VISITING WEBSITES 

Structure

4.1 Introduction 

4.2 Objective 

4.3 Downloading 

4.5 Types of Websites 

4.6 Summary 

4.7 Terminal Questions 

4.1 Introduction 

A Website is a collection of Web pages that contain multimedia 
elements. Some of the popular Websites are wikipedia.org, google.com, 
yahoo.com, msn.com and amazon.com. Websites are basically designed to 
serve our various purposes like education, news, Social networking and 
entertainment. A website can be a personal website such as an individual 
celebrity, an e-commerce website to run a business, a corporate website 
for a company use, a photo sharing website to share your favourite photos, 
a government website for government policies, a news website for latest 
updates around the word and many more. All these websites collectively 
form the World Wide Web (WWW). Some websites are private which are 
only accessible to limited people such as a company's employees. These 
websites are a part of an Intranet. Websites are designed generally in 
HTML (Hyper Text Mark-up Language) and can be accessed through any 
web browser. These websites can be viewed in any Internet enabled 
devices like desktop computers, laptops, tablets, and smart phones.  

4.2 Objective 

After studying this chapter, you will understand: 

 How you downloads files on internet.

 Various types of Websites and their usage.

4.3 Downloading 

When you browse the Web, you come across various type of files 
such as images, audio, documents and software. Each Website makes their 
files available to download in different ways. Downloading is a process of CCC-1.1/257
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receiving data from a server computer such as a web server, an FTP server 
and an email server. While, uploading is the process of sending data from 
your computer to a server computer. You can start downloading of a file 
by clicking on its download link. A download link is simply a URL which 
is usually shown with different coloured text with an underline. 
Sometimes you may find a download icon or button (shown in Figure 4.1) 
for downloading a file. Once you click on this download link, your web 
browser either automatically starts downloading of a file or prompt you a 
message to continue the download. 

Figure 4.1: Generic symbols for downloading 

Each browser handles downloading of files in different ways. In Internet 
Explorer Browser, you can follow few basic steps to begin a download. 

 Click the download link of desired file. A “file download dialog
box” will appear that will ask you to either open the file or save the
file.

 Open: If you choose to open the file, after the downloading
finishes, it will be opened in a default program that is assigned to
handle this type of file. For example, if it is a word file, then the
file would be opened in the Microsoft Office Word program.

 Save: If you choose to save the file, it will ask for a location on
disk. Once the file is downloaded, you can open it by double-click
on the downloaded file.

Other Ways to Download a File: Alternatively, you can also download a 
desired file by a right-click on the download link and then selecting Save 
Target As from the context menu. When it asks, specify a desired folder 
to save the file. You can also rename the file at later time, after the 
downloading finishes. 

Finding downloaded files on your PC 

Downloaded files such as pictures, documents, and other files are 
automatically saved in the Download folder by default. This folder is 
located on the Windows installation drive (usually C:\ drive). You can 
open this folder and view all the downloaded files by going to 
“C:\users\your_PC_name\downloads”. If you wish to move any 
downloaded files from here, you can move it to other places on your 
computer. The files that are downloaded using Internet Explorer can be 
viewed by selecting the Tools button, and then selecting View downloads. CCC-1.1/258



4.5 Types of Websites 

At the time of origin of Internet, websites were purely 
informational. The World Wide Web was not opened to public. It was 
mostly used by educational and research institutions including government 
agencies to share information through text based Websites. Now, the 
WWW has plenty of websites, each designed for a specific purpose. 
Through these websites, you can purchase goods and services online; 
interact with your friends; search for related web contents and many more. 
These Websites can be broadly classified as follow: 

Search Engine: There are millions of web pages that are available 
on the World Wide Web on variety of topics. These web pages are titled 
as per the desire of their authors. So, they are sitting on the server 
computers with mysterious names. Internet search engines such as Google, 
Yahoo and Bing are special websites that are designed to access other web 
pages. The search engines show web pages to you based on the relevance 
of your search queries or phrases. 

Figure 4.1: Google Search Engine Website. 

All these search engines perform the same basic tasks that include 
crawling (acquisition of data), indexing (acquired data is processed 
and placed in data centre), and retrieval (search for your query and 
return the most relevant web pages): 
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Crawling: Crawling is a process of scanning websites for collecting 
details like titles, images, keywords and other linked pages. A special 
software called crawler quickly (around thousands of pages per second) 
visits each Web page one by one. The crawler begins with popular 
websites. It follows every links within a web page and maintains a useful 
list of words.  

Indexing: When a crawler crawled a web page, the collected data is 
returned to the search engine and stored in its data center. Indexing is a 
process of efficiently organizing the collected data so that they can be 
searched quickly for displaying relevant results based on your search 
query. 

Retrieval: Here, a search engine processes your search query that you 
type and returns the most relevant web pages that match your query. Most 
search engines differ from each other in their retrieval methods. They use 
different criteria to choose web pages that best fit your expectations. This 
is why search results vary from one search engine to another search 
engine. 

Social Networking Websites: These Websites provide you a common 
platform to interact with other people or meet new people based on your 
interests. Some of the most popular social networking websites are 
Facebook, Twitter, Google Plus, LinkedIn etc. You can create your own 
online profile with your photo and some additional details about yourself. 
Profiles are the unique pages of individual people where you can add 
about yourself. When you are joining any social networking sites, you are 
asked several questions including your age, date of birth, location, interest, 
and about yourself. Most social networking websites allow you to add 
multimedia content to enhance your profile. They encourage you to add 
your photos to get better response. The profile visibility of users varies 
from website to website and depends on the user choice. Some social 
websites like Friendster and Tribe.net allows their users profile to be 
searched through search engines, regardless of the viewer account. While 
other websites like Myspace allow their users to control their profile 
visibility as public or friends only. Facebook adopts different approach. It 
only allows to view their users profile to other users of same network, 
unless the profile owner deny the permission to access his/her profile. 
Once you created your profile on these platforms, you can communicate 
with other people of your interest by voice, chat, instant message, and 
videoconferencing. A friends list contains links to each of his/her friend’s 
profile. Other user within the same network can see this friend list to view 
any profile. Most social Websites allow users to leave messages to their 
friends’ profiles inform of “comments” and “private messages”. Some CCC-1.1/260



Social websites offer beyond profiles, Friends, comments, and private 
messaging. For example, they provide their users additional capability for 
instant messaging, blogging, photo-sharing and video-sharing. 

Blogs: Usually, websites consist of a home page with many hyperlinks to 
its subpages. Each subpage contains detail information about a particular 
topic. For example a typical website like yahoo news organises their 
thousands of articles into several categories. And each article is accessed 
from categories available on the Website’s home page. A blog is a 
discussion or informational website that consists of diary style text entries 
of posts. All these organised into a single main page as shown in Figure 
4.2. These posts can be your thoughts, opinions or experiences about a 
particular subject that you want to put on the internet for other people to 
read. People only care about the main page. The entries in the page are 
organised into a reverse-chronological order i.e. from most recent blog 
entry to least recent. The blog are usually written by single user and are 
normally open to public so that the whole world can see them.  There are 
several Websites like WordPress.com or Google Blogs (formerly Blogger) 
that offer you a free platform to start a blog. 

Figure 4.2: A post from Blogger. CCC-1.1/261



File Storage and Sharing Websites: Today, the individual data increases 
fast as the technology increases. You usually store your personal data on 
storage devices like hard disks, flash drives and other kind of physical 
storage devices. But these storage devices have limited memory. There are 
various websites such as Dropbox, Amazon Drive, Google Drive, 
Microsoft and OneDrive on web that offer you file storage and sharing 
platform. Once, you subscribed with these websites, you can bring all your 
files together in a single place. Also, you can backup or recover these files, 
whenever you want. You can access and work with your files anywhere 
and anytime. Your files are synced across all your devices whether it is 
your Windows, Mac, tablet or your mobile devices (for example, as shown 
in Figure 4.3). You can also confidently share your files to other people 
and they can access these files smoothly and securely.  

Figure 4.3: You can access your files in Google Drive anywhere on 
your smart phone, tablet, or computer. 

E-commerce Website: Ecommerce websites like Flipkart, Amazon, 
Paytm, Ebay etc. provide an online platform for buying of goods and 
services. There are many ecommerce websites in every field based on 
target people. Some of them offer specific goods and services such as 
music portals, consultancy websites, finance and management websites. CCC-1.1/262



They allow you to reach global market without any limitations of 
geographical boundary. You can make global choice of goods and services 
and compare their prices from other suppliers.  These websites are like 
virtual stores which are open 24 *7. They offer reduced cost of goods and 
services, which is an important advantage.   

4.6 Summary 

In summary 

1. You learned about downloading of files.

2. You learned various types of Websites available on the World
Wide Web and their uses.

4.7 Terminal Questions 

Q.1 What are the various types of files available on Internet? 

Q.2 How can you use E-commerce Websites? 

Q.3 What is Blog? What are the main uses of a Blog? 

Q.4 Discuss the benefits of using File storage and sharing Websites. 

Q.5 How do you download files on the Internet? 

Q.6 Explain the various functions offered by Social Networking 
Websites. 

Q.7 How does a Search Engine Work? 
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